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Important Safety Instructions 
1. Follow all warnings and instructions marked on the product.
2. Unplug this product from the wall outlet before cleaning. Do not use liquid 

cleaners or aerosol cleaners. Use a damp cloth for cleaning.
3. Do not use this product near any liquids.
4. Do not place this product on an unstable surface. The product may fall, causing 

serious damage to the product.
5. Do not drop the product.
6. Do not block the slots and openings on the back or bottom side of the chassis; to 

ensure proper ventilation and reliable operation of the product and to protect it 
from overheating, these openings must not be blocked or covered. 

7. Operate this product only from the type of power indicated on the marking label. If 
you are not sure of the type of power available, consult your dealer or local power 
company.

8. Do not allow anything to rest on the power cord. Do not locate this product where 
persons will walk on the cord.

9. If an extension cord is used with this product, make sure that the total ampere 
rating of the equipment plugged into the extension cord does not exceed the 
extension cord ampere rating. Also, make sure that the total rating of all products 
plugged into the wall outlet does not exceed the fuse rating.

10.Never push objects of any kind into this product through the chassis slots as they 
may touch dangerous voltage points or short out parts that could result in a fire or 
electric shock.

11.Unplug this product from the wall outlet and refer servicing to qualified service 
personnel under the following conditions:
(a) When the power cord or plug is damaged or frayed.

(b) If liquid has been spilled on the product.

(c) If the product has been exposed to rain or water.

(d) If the product does not operate normally when the operating instructions are followed. Adjust 
only those controls that are covered by the operating instructions since improper adjustment 
may result in damage and require extensive work by a qualified technician to  the product to 
normal condition.

(e) If the product has been dropped or the chassis has been damaged.

(f) If the product exhibits a distinct change in performance, indicating a need for service.

12. In accordance with workstation regulation standards, do not place this device in 
the visual field of the user due to the glossy front of the case.

WARNING! The WD ShareSpace uses a lithium battery, type CR2032. There is 
danger of an explosion if the battery is incorrectly replaced. Replace only with 
the same or equivalent battery type recommended by the manufacturer. 
Dispose of used batteries according to the manufacturer’s instructions. 
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WD Service and Support
Should you encounter any problem, please give us an opportunity to address it 
before returning this product. Most technical support questions can be answered 
through our knowledge base or email support service at support.wdc.com. If the 
answer is not available or, if you prefer, please contact WD at the best telephone 
number shown below.

Your product includes 30 days of free telephone support during the warranty period. 
This 30-day period starts on the date of your first telephone contact with WD 
technical support. email support is free for the entire warranty period and our 
extensive knowledge base is available 24/7. To help us keep you informed of new 
features and services, remember to register your product online at
 https://www.wdc.com/register.

Accessing Online Support

Visit our product support website at support.wdc.com and choose from these topics:
• Downloads - Download drivers, software, and updates for your WD product.
• Registration - Register your WD product to get the latest updates and special 

offers.
• Warranty & RMA Services - Get Warranty, Product Replacement (RMA), RMA 

Status, and Data Recovery Information.
• Knowledge Base - Search by keyword, phrase, or answer ID. 
• Installation - Get online installation help for your WD product or software.

Contacting WD Technical Support 

When contacting WD for support, have your WD product serial number, system 
hardware, and system software versions available.
North America Asia Pacific

English 800.ASK.4WDC Australia 1 800 42 9861
(800.275.4932) China 800 820 6682/+65 62430496 

Spanish 800.832.4778 Hong Kong +800 6008 6008
India 1 800 11 9393 (MNTL)/1 800 200 5789 (Reliance)

011 26384700 (Pilot Line)

Europe (toll free)*
00800 ASK4 
WDEU

Indonesia +803 852 9439 

(00800 
27549338)

Japan 00 531 650442

Korea +82-2-2093-1007
Europe +31 880062100 Malaysia +800 6008 6008/1 800 88 1908/+65 62430496 
Middle East +31 880062100 Philippines 1 800 1441 0159

Africa
+31 880062100 Singapore +800 6008 6008/+800 608 6008/+65 

62430496 
Taiwan +800 6008 6008/+65 62430496 

* Toll free number available in the following countries: Austria, Belgium, Denmark, France, Germany, Ireland, 
Italy, Netherlands, Norway, Spain, Sweden, Switzerland, United Kingdom. 
WD SERVICE AND SUPPORT - 1
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Registering Your WD Product

Your WD product includes 30 days of free technical support during the applicable 
warranty period for your product. The 30-day period commences on the date of your 
first telephone contact with WD technical support. Register online at 
register.wdc.com.
WD SERVICE AND SUPPORT - 2

https://register.wdc.com


WD SHARESPACE
USER MANUAL
Overview
Congratulations on your purchase of WD ShareSpace™, a high-speed network 
attached storage system with a space-saving footprint. This system is equipped with 
WD drives using WD GreenPower™ technology for efficient cooling and power 
saving. The multi-level RAID support and high-speed interfaces deliver high 
performance for small offices or home users and is ideal for backing up and sharing 
files over the Internet.

This user manual provides step-by-step installation instructions and other important 
information regarding your WD product. Translated versions and updates to this user 
manual can be downloaded from http://products.wdc.com/updates. For more 
information and news about this product visit our website at www.wdc.com.

Format and Configuration

WD ShareSpace is preformatted for maximum reliability as a RAID 5 volume (for four-
drive systems) or for maximum capacity as a single large, spanned volume (for two-
drive systems). In RAID 5, one quarter of the capacity is used to store parity 
information needed to restore data in the event of a drive failure. 

In a spanned volume, the capacity is equal to the total of all drives in the volume. To 
access the maximum capacity using four drives on this device, the RAID 
configuration must be reset to either RAID 0 or Span. For more information on how to 
set up RAID, see “Manage RAID” on page 136.

WD ShareSpace File Storage

You can access and store content on WD ShareSpace via network shares. Shares 
are folders that can be used to organize and store files on your 
WD ShareSpace. Shares can be shared with everyone (public) or with selected 
users on your network (private). 

The device comes preconfigured with three shares: 

• Public—created automatically after initial setup 
• Shared Music - folder for storing music files you want to share with other users. 

• Shared Pictures - folder for storing image files you want to share with other users. 

• Shared Videos - for storing video files you want to share with other users. 

 Important: Do not change or delete these default share folders. 
Disruption of media sharing could result. These are the default folders for 
the Media Server (Twonky Media) and iTunes Service. For more information 
on how to use Twonky media, see “How to Play/Stream Video, Music & 
Photos” on page 65. For more information on how to use the iTunes 
service, see “iTunes with WD ShareSpace” on page 74.
1
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• Download—for saving files using Downloader (see “Download Manager: 
Downloader” on page 164).

• Configuration—this is a read-only share containing only a Help file and the login 
page. It is not meant for sharing or storing data and should not be modified.
OVERVIEW - 4
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Specifications

Ethernet High performance (10/100/1000) Gigabit Ethernet connection

Internal hard drives Up to four WD 3.5-inch SATA hard drives 

External USB storage file 
systems supported

NTFS, FAT/FAT32; HFS+J

Supported protocols HTTP, HTTPS, CIFS/SMB, NFS, FTP

I/O ports • Three USB 2.0 ports (one front for file backup, two rear for USB 
device expansion)

• Ethernet (RJ-45) port

Supported clients • Windows 2000®

• Windows XP®

• Windows Vista™

• Windows® 7

• Windows Server® 2003
• Windows Server 2008
(latest service packs required)

• Mac OS® X® Tiger®

• Mac OS X Leopard® 
• Mac OSX Snow Leopard™

Physical dimensions • Width: 6.30 in (160.1 mm)
• Height: 7.73 in (196.2 mm)
• Length: 7.84 in (199.18mm)
• Weight: 5.28 lb (2.4 kg)

Power specifications • Input voltage: 100V to 240V AC
• Input frequency: 50 to 60 Hz
• Power supply 19V DC, 5A

Environmental • Operating temperature: 5 to 35 °C (41 to 95 °F)
• Non-operating temperature: -20 to 65°C (-4 to 149 °F)
OVERVIEW - 5
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Kit Contents

Accessories

Visit shopwd.com (U.S. only) to view additional accessories like cables, power 
supplies, additional hard drives, and drive mounting rails for this product. Outside the 
U.S., visit support.wdc.com.

System Requirements

For optimum performance, the following system and network requirements are 
recommended. Compatibility may vary depending on user’s hardware configuration 
and operating system.

Important: For highest performance and reliability, we recommend that 
you install the latest updates and service pack (SP). For Mac OS X, go to 
the Apple menu and select Software Update. For Windows, go to the 
Start menu and select Windows Update.

Client computer
• Ethernet connection (network adapter)
• Operating system 

• Windows 2000/Windows XP/Windows Vista/Windows 7, Windows Server 2003/Windows 
Server 2008.

• Mac OS X Tiger, Leopard, Snow Leopard

• Web browser (Internet Explorer 6.0 SP1 and later on Windows platforms 
supported by this product, Safari 2.0 and later on Mac platforms supported by 
this product, Firefox 2.0 and later on supported Windows and Mac platforms)

• Adobe Flash ActiveX 9 or higher (required for WD Discovery™)

Ethernet cable Installation CD with 
application software 
and user manual

Quick Install Guide

WD ShareSpace with four 
or two drives

Drive mounting rails 
(only included with two-drive systems)

AC adapter 
and power cords
OVERVIEW - 6
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Local network
• Router/switch (Gigabit required to maximize performance)

Wide Area Network
• Broadband Internet connection required for remote access using MioNet

Pre-installation

Before unpacking and installing the system, select a suitable site for the system for 
maximum efficiency. Place the device in a site that is:

• Near a grounded power outlet
• Clean and dust free
• On a stable surface free from vibration
• Well-ventilated and away from sources of heat
• Secluded from electromagnetic fields from electrical devices such as air 

conditioners, radio, TV transmitters. 

Recording Your WD Product Information

In the following table, write the serial number and model number of your new WD 
product found on the label on the bottom of the device. Also, write the purchase date 
and other notes such as your operating system and version. This information is 
necessary for setup and technical support. 

Serial Number:

Model Number:

Purchase Date:

System and Software Notes:
OVERVIEW - 7



WD SHARESPACE
USER MANUAL
System View

Power Button

Important: The device powers on automatically upon initial connection to 
power, which may take up to three minutes. During this time, do not press 
the power button.

The power button turns the device on or off. To turn on the device, press the power 
button and hold down until the LED flashes once, and then release. The LED remains 
off (up to 30 seconds) as the device powers up. Holding the button down for four 
seconds powers off the device.

1 Power button 5 Power port

2 LED indicators 6 Reset button

3 USB backup button 7 Ethernet port

4 USB port 1 (Auto-backup) 8 USB ports 2 and 3

9 Kensington® security slot
OVERVIEW - 8



WD SHARESPACE
USER MANUAL
LED Indicators

The LED (light-emitting diode) indicators on the device provide information about the 
status of the system, its hard drives, and network connection. The LEDs on the 
system indicate the following:

Indicator 
and icon

Color State Description

Power Green Steady System is powered up (connected to the power supply and turned on) and 
ready for use.

Off System is not powered on

Flashing • System is booting
• System is restoring to factory default
• System is configuring RAID
• User volume is not available

Hard drives Green Random 
flashing

Hard drive is in use

Steady • Hard drive is ready for use
• Hard drive is installed

Amber Steady • Hard drive error

Green/
Amber

Flashing • System detects a foreign hard drive with pre-existing data

Green/
Amber

Off • Hard drive is not present
• Hard drive is not properly installed

Ethernet 
(front)

Green On Network link is detected

Off No network connection

Flashing Transmit or receive activity

System 
identification
/error

Blue On System identification is active

Off System identification is disabled

Red Flashing Critical condition

USB backup Green Steady • A USB storage device is connected to the front USB port
• RAID system is rebuilding
• Restoring configuration settings
• System initialize operation in progress

Flashing • One flash per second—system is formatting a USB drive
• One flash per second (backup)—USB device to WD ShareSpace
• Two flashes per second (backup)—WD ShareSpace to USB device

Off • System initialize operation completed

Ethernet 
(rear)

Orange Flashing • Network is connecting 
• Link activity

Green Steady Network is connected

Flashing Network connection is active
OVERVIEW - 9
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USB Backup Button

The USB backup button allows you to back up data from a USB drive to the device or 
from the device to a USB drive. The USB backup feature only works on the front USB 
port (port 1). See “USB Auto Backup Feature” on page 76 for detailed instructions. 

Ports 

Reset Button

The reset button restores machine name, network mode/IP address, and admin 
password to default factory settings without erasing shared folders and volumes. For 
more information on how to reset the system, see “Resetting the WD ShareSpace” 
on page 182.

Kensington Hardware Features

Security Slot

For drive security, the device is equipped with a security slot, which supports a 
standard Kensington security cable. For more information on the Kensington security 
slot and available products, visit www.kensington.com.

Component Icon Description

USB port 1 Connects to a USB drive. 
Note: This port has an auto-backup feature that 
makes it possible to automatically create backups of 
digital files from a USB drive to the device and vice-
versa. 

USB ports 2 and 3 Connects to a USB drive. 

Ethernet port Connects the device to a local network.

Power port Connects the device to an AC adapter and the power 
outlet.
OVERVIEW - 10
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WD ShareSpace Basic Setup
Step 1: Connect WD ShareSpace to the Network

Follow the steps below to connect the WD ShareSpace to a small 
home/office network. 

1. Connect one end of the Ethernet cable into the Ethernet port located on the back 
of the device. Connect the other end of the Ethernet cable directly into a router or 
network switch port.

2. Connect the end of the adapter into the DC power supply socket located on the 
back of the device.

3. Plug the AC adapter into a power outlet. After approximately 30 seconds, the unit 
powers up automatically as indicated by a steady green LED illuminated on the 
power button.

Important: Wait for the WD ShareSpace to finish powering up (approximately three 
minutes) before configuring the device.

To power down the device, press and hold down the power button for at least 
four seconds. 
2
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Step 2: Access WD ShareSpace on the Network

You can easily find your WD ShareSpace on the local area network (LAN). Follow the 
appropriate procedure below:

Windows

• “Using WD Discovery (Windows only)” on page 12.
• “Using Windows Network and Sharing Center” on page 14.

Mac OS X

• “Mac OS X Leopard/Snow Leopard” on page 18
• “Mac OS X Tiger” on page 20

Using WD Discovery (Windows only)

Note: The WD Discovery application on the included CD should be installed on every PC 
connected to the LAN from which you intend to access your WD ShareSpace.

1. Turn on your computer and wait for the operating system to load.

2. Insert the software-installing CD into the CD or DVD ROM drive.

Note: If AutoPlay is disabled on your computer, you must install the utilities manually. Click Start and 
then (My) Computer. Right-click the CD/DVD drive, click Open, and double-click Setup.exe.

3. Windows Vista/Windows 7: Click Run setup.exe, and then click Allow.

4. Click Accept in the Terms of Agreement screen.
WD SHARESPACE BASIC SETUP - 12
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5. If you have connected the WD ShareSpace properly as shown in the Connect 
screen on page 13, click Next.

6. The Application Installer screen opens, displaying a list of options. Click 
WD Discovery Tool. Once the WD Discovery Tool installation is complete, it 
automatically launches and the WD Discovery icon displays on your desktop.

7. The WD Discovery screen appears. Click WDShareSpace in the Network 
Drives Found list and click Configure.
WD SHARESPACE BASIC SETUP - 13
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8. The login screen appears. Continue device setup by following the instructions for 
“Setting Up the Device for the First Time” on page 89.

Using Windows Network and Sharing Center

Windows Vista and Windows 7 offer an alternative to WD Discovery for easy setup 
and mapping of the WD ShareSpace.

1. For Windows Vista/Windows 7, click Start>Computer>Network.

2. Right-click WDShareSpace in the Network and Sharing center and select 
Install from the drop-down menu. 

Note: The WDShareSpace media icon  on the desktop opens the Twonky user interface. For 

information on how to use Twonky media, see “Media Server” on page 150.

The Found New Hardware screen displays.
WD SHARESPACE BASIC SETUP - 14
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3. Click Locate and install driver software (recommended).

4. Click Yes, always search online (recommended).

Windows starts searching for the driver. Depending on your system setup, it may 
take a minute or so to locate the driver.

5. When installation is complete, a confirmation message displays. Click Close.
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A WDShareSpace icon displays next to WDShareSpace, and an Open option 
displays in the drop-down menu. 

To open the WD ShareSpace shares: 

1. Right-click WDShareSpace and select Open from the drop-down menu. 
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2. To view the contents, enter your username and password (“admin” is the default 
for both) and click OK. The Public, Configuration, and Download shares (default 
shares) display.

To create a desktop shortcut to the WD:

Right-click WDShareSpace and select Create Shortcut from the drop-down 
menu. 

To view the WD ShareSpace web page: 

Right-click WDShareSpace and select View device webpage from the drop-
down menu. The login page appears. 

Note: (See “Accessing WD ShareSpace’s Network Storage Manager” on page 92 for information 
on logging in.)
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To view the properties of the WD ShareSpace: 

1. Right-click WDShareSpace and select Properties from the drop-down menu. 

The WDShareSpace Properties screen displays. 

2. Click OK to close the screen.

Mac OS X Leopard/Snow Leopard

1. Turn on your computer and wait for the operating system to load.

2. In Finder, double-click WDShareSpace in the Shared list (if necessary, click All 
then double-click WDShareSpace).

3. On the login page, type “admin” in both the Name and Password fields and 
make sure the Remember this password in my keychain check box is 
selected. Click Connect.

The Configuration, Download, and Public folders display.

Note: Configuration is a read-only share containing only a Help file and the login page.
WD SHARESPACE BASIC SETUP - 18



WD SHARESPACE
USER MANUAL
4. Double-click the Public icon to display the subfolders: Shared Music, Shared 
Pictures, and Shared Videos.

You can now drag and drop files into the shared folders using Finder.

5. If you want to make the shared drive icon permanent on your desktop, create an 
alias. Following are two ways to do that:

Note: Before creating an alias, click Finder>Preferences and make sure Connected Servers is 
checked.

• Click the item you wish to alias (e.g., Public share icon) and hold down the 
mouse button. Hold down the Cmd and Option keys simultaneously and 
drag the item to where you want the alias to appear. Instead of moving the 
original item, this creates an alias at the new location.

• Double-click the item you want to alias (e.g., the Public share icon), and then 
click File>Make Alias.
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The shared drive icon displays on your desktop.

Mac OS X Tiger

1. Turn on your computer and wait for the operating system to load.

2. Open Finder. Click Network and then double-click the WDShareSpace icon. 

3. Type “admin” in both the Name and Password fields, and make sure the 
Remember this password in my keychain check box is selected. Click 
Connect.
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4. Make sure that Public is highlighted in the Select the volumes to mount list, 
and then click OK. 

5. Double-click the Public icon that is now on your desktop to display three shared 
subfolders. You can now drag and drop files into the shared folders using Finder. 

6. If you want to make the shared drive icon permanent on the desktop, create an 
alias. Following are two ways to create to do that:

Note: Before creating an alias, click Finder>Preferences and make sure Connected Servers is 
checked.

• Click the item you wish to alias and hold down the mouse button. Hold down 
the Cmd and Option keys simultaneously and drag the item to where you 
want the alias to appear. Instead of moving the original item, this creates an 
alias at the new location. 

• Double-click the item you want to alias (e.g., the Public share icon), and then 
click File>Make Alias. 
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The Public share icon displays on your desktop.

Congratulations!

Your WD ShareSpace is now ready for use and is accessible as a drive letter in My 
Computer (Windows) or a shared drive icon on the desktop (Mac). You can now 
drag and drop files into your WD ShareSpace and move files from your 
WD ShareSpace to any computer in your network that has been set up according to 
the instructions above.

This user manual contains information and instructions for all other basic and 
advanced WD ShareSpace device management functions, including:

• Backing up your computer (see “Backing Up Computers on a Network” on page 
23)

• Accessing WD ShareSpace from a remote computer (see “MioNet Remote 
Access” on page 55)

• Playing and streaming media (see “How to Play/Stream Video, Music & Photos” 
on page 65)

• Using iTunes service (see “iTunes with WD ShareSpace” on page 74)
• Connecting a USB drive for additional storage and file exchange (see “External 

USB Drive Sharing & Backup” on page 76.)
• Configuring the WD ShareSpace device and network settings. You can:

- Set email or window alerts
- Change the administrator password
- Perform firmware upgrades
- Restore system to factory defaults
- Configure RAID
- Manage file share preferences
- Set the backup destination folder
- Set disk quotas
- Set a share folder for users
- Add, modify, and delete users and groups, and change all user and group permissions 
(read/write, read only, no access) to shares/folders and USB storage devices (see 
“Network Storage Manager: Basics” on page 87 and “Network Storage Manager: 
Advanced Mode” on page 108).
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Backing Up Computers on a Network

WD Anywhere Backup Overview

WD Anywhere Backup software is a quick, easy, and secure way to back up all the 
computers in your network. Your WD ShareSpace Installation CD comes with five 
licenses for WD Anywhere Backup—each one enabling you to activate a single PC 
or Mac for continuous backup. Select the files you want to back up, and then set the 
WD ShareSpace and forget it; every time you save a change it’s automatically 
backed up.

Important Installation Notes
• Install on each computer: You must use the Installation CD to install WD 

Anywhere Backup on each computer in your network.

• Connect to the LAN and power on first: You must have your WD 
ShareSpace connected to your local area network and powered on before you 
install WD Anywhere Backup software. This will ensure that the WD Anywhere 
Backup recognizes your WD ShareSpace and will install as the full software 
version instead of the 30 Day trial version.

• Windows laptop users: When you are travelling, your laptop files will not be 
backed up. If you want to have your files automatically backed up upon 
reconnection with your home network, you must set your password and username 
on your laptop and your WD ShareSpace to be the same. Otherwise, on a 
Windows system, you will have to log in to your WD ShareSpace every time you 
reconnect to your home network before WD Anywhere Backup will begin to back 
up your files.

Windows

1. Turn on your computer and wait for the operating system to load.

2. Insert the software CD into the CD-ROM drive.

Note: If AutoPlay is disabled on your computer, you must install the utilities manually. Click Start and 
then Computer (Windows Vista/Windows 7) or My Computer (Windows 2000/XP). Right-click 
the CD/DVD drive, click Open, and double-click Setup.exe.

3. Windows Vista/Windows 7: Click Run setup.exe and then click Allow.

4. Click Accept in the Terms of Agreement screen.

5. If you have connected the device properly as shown in the Connect screen on 
page 13, click Next.

6. Click WD Anywhere Backup. 

Note: It may take a minute or two for the next screen to display.
3
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7. Select your preferred language from the list and click OK.

8. Close all other open applications, and then click Next to continue.

9. If you accept the terms of the agreement, click I Agree to continue.
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After WD Anywhere Backup has finished installing, click Finish to begin using 
WD Anywhere Backup. 

The WD Anywhere Backup Configuration screen appears. 

Note: The WD Anywhere Backup icon now appears on your desktop, and WD Anywhere Backup 
is listed in Program Files. 

10.Continue with “One-Click Backup” on page 28 or “Creating a Customized 
Backup Plan” on page 32.
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Mac OS X

1. Turn on your computer and wait for the operating system to load.

2. Double-click the WD ShareSpace icon on the desktop.

3. Double-click WD_Anywhere_Backup.dmg.

4. On the WD Anywhere Backup screen, click the WD Anywhere Backup icon. 

5. On the verification dialog box, click Continue. 
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6. On the Welcome screen of the Install WD Anywhere Backup wizard, click 
Continue.

7. On the Software License Agreement screen, click Continue.

8. To accept the software license agreement, click Agree.

9. Click Install.

10.Enter your Mac user name and password.
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11.When a screen verifying successful installation appears, click Close.

12.  Now you can begin backing up your data.

Configuring WD Anywhere Backup

After starting WD Anywhere Backup as described previously, you can back up your 
data using several methods. 

One-Click Backup

WD Anywhere Backup allows you to back up all your important data, such as 
documents, photos, music and videos, on your computer’s hard drive with the click of 
a button. This feature backs up your data to the WD ShareSpace so you can restore 
your data in the event that your computer’s hard drive crashes.

The first time you install WD Anywhere Backup, the WD Anywhere Backup 
Configuration screen appears. 
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Note: The screen below only appears when you have WD ShareSpace attached to your computer’s 
local area network. 

 

This screen offers two options:

Automatic Backup: The main option is to have the WD ShareSpace automatically 
and continuously back up your files, providing assurance that your files can always be 
restored.

• What it backs up: One-click backup backs up documents, photos, and media 
files on the primary drive of your computer. 

• What it does not back up: One-click backup does not include files on the A: 
drive, application or programs such as MS Word or Adobe Acrobat, temporary 
and log files, virtual hard disk files, or files in the system folders. 

Customized Backup: The other option is to customize your backup to back up 
other drives or only selected types of files, for example, only photos or videos. 

To start an automatic and complete backup of your computer’s hard drive:

1. Click Back Up All of My Files.

2. A message explains that initial backup will use moderate resources on your 
computer. To pause the backup, click Pause until System Idle. To keep the 
backup running in the background, click Continue. 

Backs up All files

Link to Customize Backup

s 
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Note: If you do not want these messages to display in the future, select Do not show this 
message in the future.

3. A registration screen appears. If desired, enter the optional registration 
information. Click Continue.
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The WD Anywhere Backup screen displays the progress of the backup and 
percentage of CPU used (bottom right of screen). 

When the backup has finished, a backup complete message appears.

To create another backup, click Create and continue with step 3 in “Creating a 
Customized Backup Plan” on page 32. If not creating another backup, close the 
screen. The WD Anywhere Backup icon appears in the system tray.

To customize a backup plan:

1. Click the Customize My Backup link at the bottom right of the WD Anywhere 
Backup Configuration screen. The Welcome to the WD Anywhere Backup 
Wizard screen appears. 

2. Continue with step 3 in “Creating a Customized Backup Plan” on page 32.
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Creating a Customized Backup Plan

Creating and customizing a backup plan gives the advanced user complete control 
over which files are backed up.

1. If WD Anywhere Backup is not already running, click the WD Anywhere Backup 
icon on the desktop.

2. Click Create. (If the screen shows no backup plans, none has been created.)

3. The welcome screen for customizing your backup appears. Click Next.
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4. Click Network Places and locate your WD ShareSpace on your local area 
network. Click Next.

The Select Items to Back Up screen displays.

You have two options:

To select specific items, see “Selecting your own backup items” on page 36.

To select all items, continue to the next procedure.
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Selecting all items from SmartPicks

1. Click the All Items from SmartPicks button. The SmartPicks screen displays, 
listing common file types that you can back up. 

2. Select each file type you want to back up. You can also click Select None to 
clear all selections, or click Select All to select all of the items. 

3. To add more items, click the Add Backup Items button. The Local Folders tab 
displays. Select additional folders and click Select.
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4. To exclude more items from your plan:
(a) Click the Show Advanced Options button.

(b) Click the Add Exclusion button.

(c) Select items to exclude from the backup plan, or click the Select Folder to Exclude and 
select any folders from the plan. Click the Select button.

5. On the Items Selected for Backup screen, click Next. 

6. Continue with “Completing the Backup Plan” on page 37.
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Selecting your own backup items

1. Click the My Own Backup Items button. The SmartPicks screen appears, 
listing default file locations you can back up. 

2. You have two options:
(a) On the SmartPicks tab, select each item you want to back up. You can also click Select 

None to clear all selections, or click Select All to select all of the items. When finished, click 
Next. 

(b) On the Local Folders tab, select each folder you want to back up and click Select.
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3. On the Items Selected for Backup screen, you can add more items or use 
advanced items as described in “Selecting all items from SmartPicks” on page 
34.

4. On the Items Selected for Backup screen, click Next. 

5. Continue with Completing the Backup Plan below.

Completing the Backup Plan

1. Name your backup plan and click Next. You can create additional backup plans 
by repeating the steps above. 
BACKING UP COMPUTERS ON A NETWORK - 37



WD SHARESPACE
USER MANUAL
2. A confirmation screen appears. Click Done.

3. A message explains that initial backup will use moderate resources on your 
computer. To pause the backup, click the Pause until System Idle link. 

4. To keep the backup running in the background, click Continue.

The WD Anywhere Backup screen displays the progress of the backup.
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When the backup finishes, the Backup Complete screen appears.

Alternatively, close the screen, click the WD Anywhere Backup icon, and select 
Show backup status.

As files are backed up, a small notification window appears.
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Restoring a Backup Plan

You can restore the files in your backup plan to a specified location in the event that 
you accidentally delete a file, want to compare file versions, or have lost all data due 
to a hard drive crash on your computer.

1. Click View and Restore. 

2. Click a backup plan in the Select a Plan list, or to search for a backup plan, 
enter the name in the Search by File Name field and click Search. 

3. Click the box next to the folders or files you want to restore.

4. From the Restore Files to list, select a location for your restored files and click 
the Restore button. 
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Reactivating a Backup Plan

You may reactivate an old backup plan if you want to continue backing up the files 
specified in that plan.

1. On the menu bar, click Actions>Reactivate Backup Plan.

2. The Reactivate wizard appears. Click Next.

3. Browse to select the location of the backup folder and click Next.

4. If you have more than one backup plan, select the one you want to reactivate and 
click OK.

5. Select the No, just reactivate the backup plan and start backing up option 
and click the Next button. Your backup plan will be reactivated, and your 
computer will back up files onto your selected backup destination.
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Important: If you select the Yes option, all the files in your backup up plan 
will be restored onto your computer. This will overwrite the files on your 
computer with the files from your backup plan. See “Restoring a Backup 
Plan” on page 40.

Editing a Backup Plan

Icons

Click the icons to add or remove files to and from backup plans, keep multiple 
revisions of files on hand for recall, remove entire plans, and view the backup log. 

Selecting a Backup Plan

If you have more than one backup plan, select the one you want by clicking in its box. 
A blue border surrounds the selected plan.

Change Selected Files

Change Selected Settings

 

Remove Backup Plan

 
 

Show Backup Log
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Changing Selected Files

1. On the WD Anywhere Backup screen, click the Change Selected Files icon. (See 
“Icons” on page 42.) The WD Anywhere Backup Configuration screen appears.

Note: To deselect all listed files, click the Select None link. To select all the listed files, click the 
Select All link.

2. Do one of the following:
• To add files, click the Add Backup Items button.
• To remove files, select the files and click the Remove Selected Items button.
• To exclude files from the backup, click the Show Advanced Options button. 

Depending on your selections, subsequent screens may display. 

3. When you finish selecting items to add or remove, click the Select (or OK, 
depending on the screen) button. 

4. When returned to the WD Anywhere Backup Configuration screen, click the 
Done button. 

Changing Backup Plan Settings

You can change the number of versions of the same files WD Anywhere Backup 
should keep. For example, you may want to keep yesterday’s version as well as 
today’s version. 
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1. Click the Change Selected Settings icon. (See “Icons” on page 42.) Select the 
Keep up to check box and enter the maximum number of earlier versions of your 
files to back up.

2. Click OK.

Removing a Backup Plan

You can delete a backup plan on the WD Anywhere Backup screen. Your backed up 
files remain at their destination until you delete them manually.

1. Click the Remove Backup Plan icon. (See “Icons” on page 42.)

2. In response to the confirmation message, click OK.

Showing the Backup and Error Logs

WD Anywhere keeps a log of all actions and backup errors.

1. Select the backup plan, and click the Show Backup Log icon. (See “Icons” on 
page 42.) The Backup Log appears.
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2. To view the error log, click the Error Log tab.

3. To see an explanation of an error in the list displayed in the lower part of the 
screen, click the error.

4. To clear selected errors, select their check boxes and click the Clear Selected 
Errors button.

5. To clear all errors, click the Clear All Errors button.

6. To prevent the Error Log from displaying transient errors, click the Do not notify 
me about transient errors check box. This selection affects all backup plans.

7. To see which files have been backed up, click the click here to launch the WD 
Anywhere Restore application link. (For information on restoring, see 
“Restoring a Backup Plan” on page 40.)
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Using Time Machine™

The Apple® Time Machine™ is a built-in feature on Mac OS X Leopard and Snow 
Leopard computers that can back up everything on your computer: music, photos, 
documents, applications, emails, and system files. The WD ShareSpace drive 
(firmware versions later than 2.1.92) can store these backups, so that if your hard 
drive or operating system should crash, or you lose a file, you can easily restore it to 
your computer.

Setting up Time Machine

To set up Time Machine to back up files on your WD ShareSpace drive:

1. Use one of the following methods to open Time Machine.
•  Click the Time Machine icon in the Dock. 

•  Click the Apple menu>System Preferences and select Time Machine.
•  Click Go>Applications and select Time Machine.

2. If this is your first time creating a backup, the following screen displays:

Click the Set Up Time Machine button to display the Time Machine 
Preferences screen. 
4
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3. Click the Choose Backup Disk button and select the WD ShareSpace drive 
where you want the backups stored.

4. Click the Use for Backup button. A screen prompts you for your user name and 
password. Enter wd_backup as the user name and backup as the password 
(not case-sensitive). 

5. Click the Connect button. The Preferences screen returns. 

6. To start automatic backups, move the slider to ON.
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7. To add a Time Machine drop-down menu to the menu bar at the top of the 
screen, select the Show the Time Machine status in the menu bar check 
box. This menu enables you to start a backup, enter Time Machine to restore files, 
or open the Time Machine Preferences screen. 

Time Machine begins backing up your files, but the first backup may take some 
time. Subsequent backups are faster because Time Machine only backs up new 
or changed items. A status bar displays the progress of the backup.

Time Machine backs up your computer every hour and keeps the following 
backup sets:

• Every hour for 24 hours

• Every day for the past month

• Weekly until the WD ShareSpace drive is full.

If a backup is interrupted, for example, if the computer goes into sleep mode or 
the WD ShareSpace drive is disconnected, it will resume automatically once the 
computer is available.

To see information such as available capacity and the date and time of the oldest, 
latest, and next backup, select Open Time Machine Preferences on the Time 
Machine drop-down menu:
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Starting a Backup

To start a backup at any time, select Back Up Now on the drop-down menu.

Restoring Backed-up Items

You may sometimes want to restore files and other items backed up on the WD 
ShareSpace drive. For example, you may have lost a file, or you want to see files from 
a week ago. You can restore individual items, multiple items, folders, or if your system 
crashes, your entire hard drive.

To restore backed-up items to your hard drive:

1. Open the window on your computer where you want the item restored. For 
example, if you are restoring a document, open the Documents folder. (If you are 
restoring an item on your desktop, you do not need to open a window.)

2. Click the Time Machine icon in the Dock or select Enter Time Machine from 
the drop-down menu. 

All of your backups display in a cascade, with the most recent backup in the front. 
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3. Click the arrows or the time line on the right of the screen to browse through all 
the backups Time Machine has created.

4. Select the item you want to restore, and click the Restore button to display the 
following options:

5. Click the button for the desired option: 

Keep Original - Does not restore the item from the backup drive

Keep Both - The original item will remain and the backed-up item will be added 
to the selected location on your computer.

Replace - The backed-up item replaces the original item.

Time line

Restore
button

Cancel
button

Backups

Scrolling arrows
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Deleting the Entire Backup

Time Machine enables you to delete your entire backup on the WD ShareSpace 
drive. However, you cannot delete folders and files individually.

Note: In Finder, you will see a folder that corresponds to your backup drive and includes the word 
“backup”. This is a protected folder that is automatically created and where all of your backups 
reside. It serves no purpose for users other than to store Time Machine backups. In fact, if you try to 
connect to it, you will get a “Connection Failed” message.

To delete your entire backup:

1. In Finder, select the WD ShareSpace drive and click the Connect As button.

2. Enter wd_backup as the user name and backup as the password (not case-
sensitive) and click Connect.
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The following screen displays.

3. Select the backup folder and then drag the *.sparsebundle file to the Trash icon.

Changing Your Password

You can change your default password for your WD ShareSpace to access Time 
Machine.

To change your password: 

1. Log in to the WD ShareSpace web user interface. (See “Accessing WD 
ShareSpace’s Network Storage Manager” on page 92.)

2. Enter your username and password and click Login (default username and 
password are “admin”).
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3. Click the Users button in Basic mode.

4. Click the icon to the right of the user name (WD_Backup). 

5. When the Users page appears, enter your new password in the New and 
Confirm password fields and click Submit.
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6. A confirmation message displays.
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MioNet Remote Access

MioNet Overview

Remotely access your photos, music, documents, and videos from anywhere, anytime 
using MioNet secure remote access services from WD. MioNet makes remote file 
access and sharing seamless, simple and very secure. Just follow the steps to 
register your WD ShareSpace into your secure MioNet account. Then you can 
access your content from any web browser in the world with your unique username 
and password. 

MioNet also enables you to share a folder of pictures on your WD ShareSpace with 
friends (no upload required) or a folder of documents with your business colleagues. 
Invitees can only view the content you choose to share with them.

Remote Access Setup

WD ShareSpace comes with MioNet enabled by default. The Remote Access 
button enables you to control the MioNet service on the storage device. If MioNet is 
not already set up through the web, follow the instructions below.

Windows

1. Turn on your computer and wait for the operating system to load.

2. Insert the WD ShareSpace software CD into the CD-ROM drive.

Note: If AutoPlay is disabled on your computer, you must install the utilities manually. Click Start and 
then Computer (Windows Vista/Windows 7) or My Computer (Windows 2000/XP). Right-click 
the CD/DVD drive, click Open, and double-click Setup.exe.

3. Windows Vista/Windows 7: Click Run setup.exe and then Allow.

4. Click Accept in the Terms of Agreement screen.

5. If you have connected the device properly as shown in the Connect screen on 
page 13, click Next.
5
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6. Click the MioNet New Account button if you are a new MioNet user; click 
MioNet - Existing Account if you are an existing user.

The MioNet registration screen appears.

7. Complete the registration form and click Submit to create an account.
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8. When MioNet finds the WD ShareSpace you are registering, enter a name for the 
device and click OK. 

9. A confirmation message appears. Click OK.

MioNet displays a list of the public folders stored on your WD ShareSpace and 
includes a private folder that was created with the MioNet username. 

Upon login, MioNet searches for any unregistered WD ShareSpace units and 
gives any it finds a default name of WD Storage. MioNet names are independent 
of names assigned using WD ShareSpace’s Network Storage Manager.
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Using MioNet Web (after registration)
1. From any browser, go to www.mionet.com/web and enter your username and 

password. The Quick Start tab appears, displaying icons representing activities 
you can perform. 

Note: In this User Manual, we discuss the most basic options. For more advanced options, see the 
MioNet Help or MioNet User Guide (available when you click the Online Help icon).
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Accessing WD ShareSpace Folders and Files Remotely 

Important: Local access to WD Storage using MioNet Web is not 
available. Use Window’s Explorer or Apple Finder.

1. Click the My Resources tab to display your WD ShareSpace folders.

Your WD ShareSpace folders display in the My Resources tab of MioNet.

2. Select a folder to see a list of all the sub-folders and files. You can now use your 
browser to access your entire collection of music, photos, movies, and 
documents. 

3. Double-click any file to open it locally. You may be able to drag and drop files from 
your WD ShareSpace to the remote computer and vice versa.

Sharing Files with Others

Sharing Photos

You can easily share a folder of photos on your WD ShareSpace with others. It is a 
simple three-step process. First you choose the folder you wish to share, then who 
you want to share with, and finally what permissions they have to access the folder.

1. Click the Share Photos icon.
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2. Choose any folder or the plus sign to choose a sub folder to share with someone 
else and click the Next button.

The page for choosing people to share with appears.

3. To share photos with MioNet users you have shared with in the past:
(a) Select the user(s) and click the Next button. 

(b) Continue with step 6.

4. To add a new user to share with: 
(a) Click the Invite new person button.

(b) Enter the user’s email address and click the Continue button. 

(c) Continue with step 6.

5. To find another MioNet user you have never shared with before:
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(a) Click the Find MioNet user button.

(b) Enter the user name or email address of the user and click the Find button.

(c) When MioNet finds the user, click the Share with this person button.

(d) Continue with step 6.

6. From the list of users, select the user(s) you want to share with and click the Next 
button.

Note: You can press the Ctrl key in Windows or the Command key on the Mac to select multiple 
users.
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(e) Select the permission level and click the Next button. If you want users to only view the 
photos, select read permission. If you want to enable users to add photos (or modify or 
delete photos) to your folder, give them the read/write permission.

The person you invite receives an email with a link to click. MioNet automatically 
opens up in the user’s web browser and provides instant secure access to the 
folder of photos on your computer.

Transferring Files to Others

MioNet enables you to transfer files to others to whom you have granted access, and 
to have them transfer files to you.

Note: MioNet transfers are not as fast as LAN transfers.

1. Click the Transfer Files to Others icon to open a dialog window showing your WD 
ShareSpace folders.

2. Click the + to navigate through your directory to highlight the folder you wish to 
transfer files from and click Next.
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The following page appears.

3. To transfer files back and forth with MioNet users you have shared with in the 
past:
(a) Select the user(s) and click the Next button. 

(b) Continue with step 6.

4. To add a new user to transfer files to and from: 
(a) Click the Invite new person button.

(b) Enter the user’s email address and click the Continue button. 

(c) Continue with step 6.

5. To find a MioNet user you have never shared with before:
(a) Click the Find MioNet user button.

(b) Enter the user name or email address of the user and click the Find button.
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(c) When MioNet finds the user, click the Share with this person button.

(d) Continue with step 6.

6. From the list of users, select the user(s) you want to transfer files to and from. 
Click the Next button.

Note: You can press the Ctrl key in Windows or the Command key on the Mac to select multiple 
users.

7. Select the permission level and click the Next button. If you want users to only 
transfer the files to themselves, give them the read permission. If you want to 
enable them to transfer files to you (or modify or delete your files), give them the 
read/write permission.

MioNet automatically opens up in the user’s web browser and provides instant 
secure access to the folders or files on your computer. They can then double-
click the file to open it and save it to their local PC.
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How to Play/Stream Video, Music & Photos

Media Servers Overview

WD ShareSpace is designed to serve as your home's central media hub. It enables 
you to stream photos, music, and videos to your home entertainment center and/or 
other PCs on your home network. 

The Twonky™ Media server application searches for the media in the three shared 
folders (Videos, Photos, and Music) stored on the WD ShareSpace connected to 
your home network. The server is pre-set, so you can just transfer your multimedia 
content to the respective shared folders on your WD ShareSpace, and you are ready 
to stream and view content on your home entertainment center, game consoles (for 
example, Xbox 360™, PlayStation®3, or DLNA®1.5 Digital Media Adapters, such as 
WD TV™ Live HD Media Player). 

Media Types Supported

Note: Some devices may not support playback of all these files. Please refer to your device’s user 
manual to see which formats are supported.

Shared Music Shared Videos Shared Pictures

Audio files Video files Image Files

3GP
AAC
AC3
AIF
ASF
FLAC
LPCM
M4A
M4B
MP1
MP2
MP3
MP4
MPA
OGG
WAV
WMA

3GP
AVI
DivX
DVR-MS
FLV
M1V
M4V 
MKV
MOV
MP1
MP4
MPE 
MTS
MPV
MPG
MPEG2
SPTS
VDR
VOB
WMV
Xvid

BMP
GIF
JPEG
PNG
TIF
TIFF
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Media Storage

You can access and store media content on WD ShareSpace via network shares. 
Shares are folders that can be used to organize and store files on your 
WD ShareSpace. Shares can be shared with everyone (public) or with selected 
users on your network (private). 

The device comes pre-configured with the Public network share, which contains the 
following folders for media storage: 

• Shared Music - folder for storing music files you want to share with other users 
• Shared Pictures - folder for storing image files you want to share with other users 
• Shared Videos - for storing video files you want to share with other users 

Important: Do not change or delete these default share folders. 
Disruption of file sharing could result. These are the default folders for the 
Media Server (Twonky Media) and iTunes Server. For more information on 
how to use Twonky media, see “Media Server” on page 150. For more 
information on how to use iTunes service, see “iTunes” on page 150.

How and Where to Add Media Content to the Shared Folders

1. Open the Internet Explorer.

2. Copy your music files to the Shared Music folder, which is under the Public folder 
on WD ShareSpace.

3. Follow the same process to place your videos and pictures into their respective 
Shared Pictures and Shared Video folders.
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Important: Make sure to sort and add your media content to the 
corresponding shared folders. (e.g., music files must go into the Shared 
Music folders). If you do not do this, your content will not display correctly 
through your digital media adapter.

Media Devices

Now that you have copied your files to their corresponding folders, you can use a 
variety of media devices to stream media. The following types are discussed in this 
section:

• WD TV HD Live Media Player page 67.
• Windows Media Player 11 (works with Windows Vista/Windows 7) on page 69.
• Windows Media Player 12 (comes with Windows 7) on page 69.
• Xbox 360 on page 71.
• PlayStation 3 on page 72.
• Digital Picture Frames on page 72.
• Network Music Player on page 73.
• Digital Media Adapters on page 73.
• DLNA Devices on page 73.

Note: Windows XP can use Twonky Media PC MediaBrowser on third party DLNA client 
applications (see “Media Server” on page 150).

WD TV Live HD Media Player

You can connect the WD TV Live HD Media Player to your LAN network for access 
to media content stored in network drives such as the WD ShareSpace. Following 
are general steps for using the WD TV Live to access files on a WD ShareSpace. 

Note: Please refer to your WD TV Live HD Media Player user guide for more specific instructions on 
connecting to the WD ShareSpace and accessing and playing your media content.

1. Connect a WD ShareSpace to your LAN and power on the device.

2. Make sure the WD TV Live is connected to your TV and powered on.

3. Connect the WD TV Live to the LAN.

4. Navigate to Settings>Network setting>Network setup to choose the 
connection type.

5. Use the  navigation buttons to select Wired and press Enter.

Note: You can choose Wireless if you use a wireless adapter compatible with the 
WD TV Live. For a list of compatible adapters, please go to support.wdc.com and search the 
Knowledge Base for answer 3805.
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6. Select Automatic as the setup configuration option for DHCP or Manual for a 
static IP. 

7. A confirmation screen displays your WD TV Live’s network information if 
connection to the LAN is successful. Press Enter.

8. Navigate to the Home screen, and select the icon for media content you wish to 
access. It can be Music , Video , or Photo .

9. Press  /  to select Network Shares  or Media servers  and press 
Enter.

10.Press  /  to select the WD ShareSpace and press Enter. 
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11.Supported content for the selected media type displays. 

12.Select the content you wish to access, and then press Enter to start media 
playback.

Windows Media Player 11/12 (Windows Vista/Windows 7)

Note: Please go to the Microsoft Media Player support site for more information on using and 
updating your media player.

To stream media using Windows Media Player 11 or 12 Library:

1. Click Control Panel>Network and Sharing Center.

2. Click Customize.
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3. Click Private, and then click Next. 

4. Launch Windows Media Player (Start>All Programs>Windows Media 
Player).

5. Click Library>Media Sharing. 
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6. Click Find media that others are sharing, and then click OK. 

7. Select a media type (Music, Pictures, or Video) and click PVConnect on 
WDShareSpace. 

8. Double-click the media file you want to play.

Xbox 360 

Note: Please go to the Microsoft Xbox 360 support site for more information on using and updating 
your XBox 360.

1. Ensure that your Xbox 360 and WD ShareSpace are powered on and connected 
to your local area network.

2. From the main Xbox user interface, scroll to the My Xbox screen

3. Use the Xbox 360 controller and scroll to the right until you see Video, Music and 
Picture Library options.

4. Select any one of these three options by pressing the A button on your controller. 
The Select Source screen displays.

5. Select the WD ShareSpace option based on the device name you created 
previously and press the A button. You see the media content stored on your WD 
ShareSpace unit.
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PlayStation 3

Note: Please go to the Sony PlayStation support site for more information on using and updating 
your PlayStation.

1. Ensure that your PlayStation 3 and WD ShareSpace are powered on and 
connected to your local area network. You will see the main user interface with a 
series of options displayed horizontally across your TV screen.

2. Using the directional buttons (left and right) on the PlayStation controller, 
navigate to Music, Photo or Video depending on which type of media you want to 
play, and press the X button.

3. Using the directional buttons (up and down), scroll and select WDShareSpace 
(or the new device name that you created previously) by pressing the X button. 
You will now see a list of folders (Music, Photo and Video) to the right of the 
WDShareSpace icon.

4. Make sure that you select the folder that corresponds to the option you selected 
back in Step 2. For example, if you select Photo from the main user interface 
screen, open the corresponding Photo folder to the right of the WDShareSpace 
icon, otherwise your content will not display properly.

Digital Picture Frames

The following are general steps for setting up digital photo frames:

1. Ensure that your WD ShareSpace is connected to your home’s local network and 
is powered on.

2. Follow the user instructions provided with your wireless digital photo frame to 
proceed through any initial setup or installation of drivers.

3. Using the navigation feature on your wireless digital photo frame, scan and detect 
the WD ShareSpace on your network.

4. Depending on the brand of photo frame you have, you may need to access 
Settings/Network Setup screen in the user interface to establish connection so 
that your photo frame can link to your WD ShareSpace. Please refer to the user 
guide for your Digital Media Adapter (DMA) or specific instructions.

5. Once you have a connection between your wireless photo frame and the WD 
ShareSpace, access the Media screen on your photo frame that will provide you 
the option to view your pictures.

Note: Please refer to your wireless photo frame user guide for supported picture file formats and 
instructions on accessing and viewing your pictures.
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Network Music Player

The following are general steps for using a network music player to access 
WD ShareSpace:

1. Connect WD ShareSpace to your local area network and power on the device.

2. Connect and configure your network music player on your home’s wired or 
wireless network switch or router.

3. Turn on your network music player.

4. If connected properly, you will find the device name of your WD ShareSpace.

5. Navigate through the network music player’s user interface to locate and play 
music stored on your WD ShareSpace.

Note: Please refer to your network music player user guide for specific instructions on connecting to 
a network attached storage system and how to access and play your media content.

Digital Media Adapters

The following are general steps for using a Digital Media Adapter (DMA) to access 
WD ShareSpace:

1. Connect WD ShareSpace to your local area network and power on the device.

2. Make sure that your DMA device is connected to your TV and powered on. The 
main screen of your DMA device appears.

3. Depending on the DMA device, you may need to access the Settings/Network 
Setup screen in the user interface to establish a connection between your DMA 
and WD ShareSpace. Please refer to your DMA’s user guide for specific 
instructions.

4. Once you have a connection established between your DMA and WD 
ShareSpace, access the Media screen on your DMA to view your pictures or 
stream music and video content from the WD ShareSpace.

Note: Please refer to your DMA’s user guide for specific instructions on connecting to the WD 
ShareSpace and how to access and play your media content.

DLNA® Devices

See specific Digital Living Network Alliance (DLNA) media device user manuals for 
instructions on connecting a DLNA device to your local area network so you can 
access content on WD ShareSpace. Go to www.dlna.org for a list of DLNA-certified 
devices and for further information.
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iTunes with WD ShareSpace

iTunes Media Server Overview

With the iTunes Media Server, you or anyone connected to the WD ShareSpace can 
play music files stored on the system using iTunes. This service creates a virtual 
music library on the device and treats it as an iTunes repository, making it possible for 
music files to stream from the WD ShareSpace to Windows or Mac computers 
running iTunes. 

Media Types Supported

The iTunes server supports the following file types:

• *.mp3
• *.wav
• *.aac

Note: The iTunes server service requires the presence of the ‘/Public/Shared Music’ share folder. Do 
not rename or delete Shared Music if you want to use the iTunes server. You must recreate or 
rename the ‘/Public/Shared Music’ folder if it has been deleted or given another name.

Storing Content

You can drag and drop audio files to WD ShareSpace’s ‘/Public/Shared Music’ 
default folder.

Streaming Audio in iTunes

The iTunes Media Server is enabled by default in the WD ShareSpace’s Network 
Storage Manager utility. See “To enable or disable the iTunes Media Server:” on page 
151 for more information.

1. Launch iTunes on your computer.

2. Click WDShareSpace under the Shared section of the left pane. If you have 
copied music to the /Public/Shared Music folder and it is in a format supported 
by iTunes, it should be listed in the right pane.
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3. Double-click an audio file to play.

The audio file is streamed in iTunes, and audio files from the WD ShareSpace are 
displayed under the Shared list.
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External USB Drive Sharing & Backup

Sharing Data on a USB Drive 

You can share data on your USB drive with other users connected to the WD 
ShareSpace. When a USB storage device with the FAT, FAT32, HFS+J, or NTFS file 
system is connected to the network storage device, the USB device will be displayed 
as a USB share.

To share data on a USB drive:

1. Connect a USB drive to any of the three USB ports. The front port is USB1 and 
the two rear ports are USB2 and USB3 from top to bottom.

Note: The WD ShareSpace supports external USB storage; USB optical drives (CD/DVD combo or 
DVD dual/multi drive) are not supported. The USB ports currently support attached drives with 
FAT32, NTFS, EXT3, or HFS+J file systems. Proprietary devices (e.g., cameras) are not currently 
supported. 

2. Open the WDShareSpace folder to access data on the USB drive. 
Double-click the USB share. The USB share name will appear as 
usb1-1share1, usb2-1share1, or usb3-1share1, depending on the actual USB 
port that the USB drive is connected to. 

USB Auto Backup Feature 

The WD ShareSpace’s auto backup feature allows you to back up data in either 
direction—from a USB drive to the WD ShareSpace or from the WD ShareSpace to 
a USB drive. You have to select your destination and source as described in “USB to 
WD ShareSpace Backup” on page 144.

Important: When backing up data, always connect the USB drive directly 
to USB port 1 located on the front panel. Do not use a USB hub. Ensure 
that the destination drive has enough free space to store the amount of 
data being transferred.
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To back up FROM a USB drive:

1. Connect a USB drive to the USB port (Port 1) located on the front panel, and 
wait for a few seconds for the USB backup LED  on the front of the unit to light 
steadily (this could take up to 30 seconds). 

2. Press and hold the USB backup button only until the USB backup LED  turns 
off (about 2 seconds). While the backup is in progress, the USB LED will flash 
once per second. When the backup is complete, the LED will remain on steadily. 

Note: The first backup will copy the entire first partition of the USB drive. Subsequent backups will 
copy only new and updated files.

The system will back up data from the USB drive to the “Public” default share 
folder on the WD ShareSpace. The share folder will be automatically named after 
the USB drive plugged into Port 1. 

Example: usb_Western_Digital_External_HDD-200806201424
EXTERNAL USB DRIVE SHARING & BACKUP - 77



WD SHARESPACE
USER MANUAL
To back up to a USB drive:

1. Prior to performing the backup operation, make sure to choose a source and 
destination in the WD ShareSpace’s Network Storage Manager utility. See “To 
set a source share name for WD ShareSpace to USB drive backup:” on page 
145 for more information.

2. Connect a USB drive to the USB port (Port 1) located on the front panel of the 
WD ShareSpace, and wait for the USB backup LED  to turn on (about 30 
seconds). 

3. Press and hold the USB backup button until the USB backup LED on the front of 
the unit begins to flash (about 3 seconds). The USB LED will flash twice per 
second while the backup is in progress and will light steadily when the backup is 
complete. 

The system will back up data from the pre-selected source share folder on the 
WD ShareSpace to the USB drive first partition. 

Note: If the USB drive does not have enough free space to back up the selected portion of the WD 
ShareSpace, an error will display when the USB drive is full. The error will appear as a flashing red 
LED on the front of the ShareSpace, as well as a text message at the top of the WD ShareSpace’s 
Network Storage Manager web page.
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Using WD Discovery (Windows Only) 

WD Discovery Overview

WD Discovery is a proprietary utility that aids in connecting to the WD network 
drives. The easy-to-use software enables you to quickly locate and set up the 
WD ShareSpace from any Windows computer on your network. With WD Discovery, 
you can easily map network drives, browse shared folders, and create a desktop 
shortcut for quick access to your WD ShareSpace.

WD Discovery provides the following options:

Mapping a Network Drive

To access and store data on WD ShareSpace after setting up the device, you must 
first map a network drive to one or more of the default shares. Install the WD 
Discovery application on each Windows computer in your network to easily map a 
network drive, browse network shares, or create a desktop shortcut.

To map a network drive:

Note: Follow the steps below only if you have not already installed WD Discovery.

1. Turn on your computer and wait for the operating system to load.

2. If WD Discovery is not running:

For Windows 2000/XP, click Start>All Programs>WD Discovery 
Software>WD Discovery or double-click the WD Discovery icon on your 
desktop. 

Configure your WD ShareSpace device using the 
WD ShareSpace’s Network Storage Manager interface. See 
“Configuring WD ShareSpace” on page 87.

Automatically map a network drive so you can easily share and 
store data on your WD ShareSpace. See “Mapping a Network 
Drive” on page 79.

Easily browse network shares without having to manually enter 
network paths. See “Browse Network Shares” on page 82.

Create a desktop shortcut that points to a networked 
WD ShareSpace. See “Desktop Shortcut Creation” on page 83.

Determine which WD ShareSpace in the network is currently 
being accessed by WD Discovery. See “Turning Identify LED On 
or Off” on page 84.
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For Windows Vista, click Start>Programs>WD Discovery Software>WD 
Discovery or double-click the WD Discovery icon on your desktop.

For Windows 7, click the Windows icon  and then All Programs>WD 
Discovery Software>WD Discovery or double-click the WD Discovery icon 
on your desktop.

WD network drives are listed in the Network Drives Found list.

3. Click the device you want to map in the Network Drives Found list and click 
Map Network Drive in the Things to Do list.

4. In the authentication screen, enter your User Name and Password. The default 
for both is “admin.”

A message appears asking whether you want to map the drive automatically. 
Continue with “Automatic Drive Mapping” or “Manual Drive Mapping” on 
page 81. 
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Automatic Drive Mapping

1. After completing step 4 on the previous page, click Yes.

All share folders available on the device will be mapped as network drives 
automatically. Available drive letters are assigned backwards from Z. 

When mapping completes, the share folders appear as network drives in the 
WD Discovery screen. 

2. Click Back to return to the main screen.

Manual Drive Mapping

1. After completing step 4 on the previous page, click No. All share folders on the 
device are listed on the screen. Select a folder name, and then select a drive 
letter. 

2. Click Yes to complete drive letter assignment.

3. Click My Computer (Computer on Windows Vista/Windows 7). The network 
drives display. You can now drag and drop files into the network drive folders 
using My Computer or Windows Explorer.
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Browse Network Shares

To access data on a share using WD Discovery:

Use WD Discovery to easily browse network shares without having to manually enter 
network paths.

1. Ensure that the device is powered on and connected to the network. 

2. Launch WD Discovery from the Start menu or the desktop.

3. Click WDShareSpace in the Network Drives Found list and click Browse 
Network Shares in the Things To Do list. 

4. After successful login, the share folders on the device are listed. Click a share to 
view and access share files in Windows Explorer. 
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5. Copy your music files into the Shared Music folder, your video files into the 
Shared Videos folder, and your photos and pictures into the Shared Pictures 
folder. 

Desktop Shortcut Creation

WD Discovery can create a desktop shortcut that points to a networked 
WD ShareSpace. Follow these steps to create a desktop shortcut:

1. Ensure that the device is powered on and connected to the network. 

2. Launch WD Discovery from the Start menu or the desktop.

3. Click WDShareSpace in the Network Drives Found list, and then click 
Create Desktop Shortcut in the Things To Do list. 
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4. A dialog appears informing you that the desktop shortcut has been created 
successfully. Click OK.

Turning Identify LED On or Off

Users with multiple WD ShareSpace devices can use the blue Identify LED feature to 
find out which WD ShareSpace in the network is currently being accessed by 
WD Discovery. WD Discovery allows you to turn on or turn off Identify LED on a 
networked WD ShareSpace. 

Note: This feature is only available on a WD ShareSpace network drive.

To turn on the Identify LED on a networked WD ShareSpace: 

1. Ensure that the device is powered on and connected to the network. 

2. For Windows 2000/XP, click Start>All Programs>WD Discovery 
Software>WD Discovery, or double-click the WD Discovery icon on your 
desktop. 

For Vista, click Start>Programs>WD Discovery Software>WD Discovery, 
or double-click the WD Discovery icon on your desktop.

For Windows 7, click the Windows icon  and then All Programs>WD 
Discovery Software>WD Discovery or double-click the WD Discovery icon 
on your desktop.

3. Click WDShareSpace in the Network Drives Found list and click Turn On 
Identify LED in the Things To Do list. 
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4. The Identify LED on the target device is turned on. The LED icon appears to the 
left of the device name in WD Discovery. 

To turn off the Identify LED on a remote networked WD ShareSpace device: 

1. Ensure that the device is powered on and connected to the network. 

2. Click Start>Programs>WD Discovery.

3. Click WDShareSpace in the Network Drives Found list and click Turn Off 
Identify LED in the Things To Do list.

The Identify LED on the target device is turned off. The LED icon to the left of the 
device name in WD Discovery is also turned off. 

Automatically Updating WD Discovery

When you open WD Discovery, the WD Discovery Auto Update Progress screen 
may appear, notifying you that an update to WD Discovery is available.
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To download the update:

1. On the WD Discovery Auto Update Progress screen, click Yes.

A message indicates that the download may take several minutes.

When the update is complete, a confirmation message appears:

2. To launch WD Discovery, click Yes.
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Network Storage Manager: Basics
WD ShareSpace’s Network Storage Manager is a powerful and convenient user 
interface for managing and configuring your WD ShareSpace.

Note: Accessing and setting up the WD ShareSpace’s Network Storage Manager is not required to 
begin using your WD ShareSpace right away.

This chapter explains how to configure the WD ShareSpace, access WD 
ShareSpace’s Network Storage Manager, and enter basic settings. For instructions 
on configuring advanced settings, see “Network Storage Manager: Advanced Mode” 
on page 108.

Configuring WD ShareSpace

Follow the instructions below to configure your WD ShareSpace for Windows or 
Mac.

Windows

To configure your WD ShareSpace for Windows:

Note: Follow steps 1-6 below only if you have not already installed WD Discovery Tool as instructed 
on page 12. Otherwise, launch WD Discovery Tool using the desktop icon and continue with step 7.

1. Turn on your computer and wait for the operating system to load.

2. Insert the WD ShareSpace software CD into the CD-ROM drive.

Note: If AutoPlay is disabled on your computer, you must install the utilities manually. Click Start and 
then My Computer/Computer), or right-click the CD/DVD drive, click Open, and double-click 
Setup.exe.

3. Windows Vista/Windows 7: Click Run setup.exe, and then click Allow.

4. Click Accept in the Terms of Agreement screen.

5. If you have connected the device properly as shown in the Connect screen on 
page 13, click Next.

6. The Application Installer screen opens, displaying a list of options. Click WD 
Discovery Tool.
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7. The WD Discovery screen appears. Click WDShareSpace in the Network 
Drives Found list and click Configure.

8. The login screen appears. Continue device setup by following the instructions for 
“Setting Up the Device for the First Time” on page 89.

Mac OS X

To configure the WD ShareSpace for Mac OS X:

1. Turn on your computer and wait for the operating system to load.

2. Open the Safari web browser.

3. Click the Bookmarks link in the upper left corner of the screen.

4. Click Bonjour, and then double-click WDShareSpace.

5. The login screen appears. 

Note: The Mac OS X Leopard may not be able to get past the login screen. Please go to 
www.wdc.com and search the knowledge base for answer ID 3280, which has instructions on 
correcting the problem.

6. Continue device setup by following the instructions for “Setting Up the Device for 
the First Time” on page 89.
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Setting Up the Device for the First Time

Follow the steps below to continue setting up the device for all operating systems. 

Note: You only have to perform the setup the first time you log in to WD ShareSpace’s Network 
Storage Manager.

1. Enter “admin” in both the Administrator Name and Password fields. 

2. Select a language from the Language list and click Login.

3. Click Next. 
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4. Read the license agreement, and then click I Agree. 

5. In the Initial Setup screen, do the following:
(a) Enter a name in the Device Name field (up to 15 characters, including alphanumeric and 

dash ‘-’).

Note: The device name is used to identify the storage device connected to the network and appears 
in My Network Places. To connect more than one storage device to the same network, you must 
specify a unique device name for each storage device. 

WARNING! Renaming WD ShareSpace forces all the network computers 
to remap their shared network resources. Change the device name only 
when necessary.

(b) Enter a brief description of the device in the Device Description field. The maximum length 
of the description is 42 alphanumeric characters. 

(c) Select a time zone from the Time Zone list. 

(d) If necessary, adjust the date and time manually using the Date & Time lists. 

Click Next.
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6. Enter a new admin password in the New Admin Password field. The maximum 
length of the password is 16, including alphabetic, numeric, underscore, space, 
and most special characters except double-quote ("). The first and last characters 
cannot be a space. The password is case sensitive.

7. Retype the new password in the Confirm Password field. Click Next.

Note: If you forget your admin password, you must reset the device to its default configuration using 
the reset button. See “Reset Button” on page 10 for instructions.

8. Accept the default DHCP (Dynamic Host Configuration Protocol) client settings. 
If you are not using DHCP, click Static and manually assign the IP address. Click 
Next. 
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OR

9. The Summary screen appears. Click Finish. 

Note: If you are using Windows, you may notice a warning notice bar display during the final 
initialization of your WD ShareSpace. The bar warns that the Internet Explorer has blocked an Active 
X controller message. This warning disappears on its own, or you can click the X button to the right 
of the bar. This warning does not affect setting up your drive.

Accessing WD ShareSpace’s Network Storage Manager

Once you have configured your WD ShareSpace and set up WD ShareSpace’s 
Network Storage Manager, you can manage and further configure your unit by 
entering the web-based user interface. 

Important: You must configure WD ShareSpace before using 
WD ShareSpace’s Network Storage Manager. Follow the instructions 
under “Configuring WD ShareSpace” on page 87.

Note: Accessing and setting up the WD ShareSpace’s Network Storage Manager are not required 
to begin using your WD ShareSpace.
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Windows 

1. Ensure that the device is powered on and connected to the network. 

2. If WD Discovery is not running, launch it from the Start menu or the desktop.

3. Click WDShareSpace in the Network Drives Found list and point to and click 
Configure in the Things To Do list.

4. The login page appears. Type in the administrator name and password (the 
default password is “admin” unless it has already been changed by the 
administrator). In the Tool list, click WD ShareSpace’s Network Storage 
Manager. In the Language list, click the language for your region. Click Login. 

Mac OS X

1. Turn on your computer and wait for the operating system to load.

2. Open the Safari web browser.

3. Click the Bookmarks link in the upper left corner of the screen.

4. Click Bonjour, and then double-click WDShareSpace.

5. The login page appears. Type in the administrator name and password. In the 
Tool list, click WD ShareSpace’s Network Storage Manager. In the 
Language list, click the language for your region. Click Login.
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WD ShareSpace’s Network Storage Manager Features

The web-based management utility includes the following features:

• LAN access—the device supports local area network access of the web-based 
user interface, enabling management from anywhere in the network. 

• Secured access—the device can be accessed and configured by the 
web-based, password protected user interface over SSL (Secure Socket Layer).

• Email notification—In the event of warnings or errors related to temperatures, 
hard drive, network, or USB connection, administrators are automatically alerted 
by email.

• Multiple access levels—users can be assigned different rights. The device 
supports two levels: full access and read only.

• Update via web—firmware updates can be downloaded and installed on the 
device from a computer on the LAN. 

• Disk management—the web-based user interface enables administrators to 
monitor internal hard drives and USB drives connected to the device.

• USB storage support—enables reliable data backup from a USB storage 
device to the device.

• RAID management—enables RAID configuring of the hard drives. 
• Support for Windows and Mac systems—enables users on different 

platforms to share files using CIFS (Common Internet File System), NFS 
(Network File System), or FTP (File Transfer Protocol) protocols.

• iTunes streaming support—alows users to stream photos, music, and videos 
to supported digital media adapters. 

• Twonky Media server—provides fast, convenient navigation and searching of 
all your media files in the Twonky user interface.

• Remote shutdown or reboot—enables administrators to power off or reboot 
the device from any computer on the LAN.

• System log—an efficient instrument in analyzing and solving technical issues. 
• UPS-ready—a UPS (uninterruptable power supply) device can be connected to 

one of the USB ports to provide secondary power in the event of a power failure. 
Go to support.wdc.com and search the knowledge base for answer ID 2559 for a 
list of compatible UPS devices.

• Upgradable firmware—enables you to keep your system up to date. For more 
information, see “Update (Firmware)” on page 114.
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User Interface Overview

The web-based user interface is designed to logically access and manage the 
features of the device. Upon logging in, the web user interface defaults to Basic 
Mode. Basic Mode provides access to the most common device configuration 
options. 

The Advanced Mode page includes six tabs and each tab is subdivided into several 
icons providing advanced task management functions. The toolbar located on the 
upper right enables you to switch between Advanced Mode and Basic Mode any 
time. 

Note: See “Network Storage Manager: Advanced Mode” on page 108 for instructions on using 
Advanced Mode.
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Toolbar

The toolbar located on the upper right of the WD ShareSpace’s Network Storage 
Manager user interface includes the following commands.

Basic Mode

The Basic Mode provides access to the most common configuration options. 

Click any of the buttons to display the available configuration options. The table 
below describes the options. 

Function Description

Advanced Allows you to switch the user interface from basic to Advanced Mode. 

Basic Allows you to switch the user interface from advanced to Basic Mode. 

Help Displays online help. 

Logout Exits the utility.

Category Description

Device Name Enter a device name and description. For more details, see “Device Name” on page 97.

Date & Time Set the system date and time manually or set the NTP server to allow date and time to be 
updated automatically. For more details, see “Date & Time” on page 98.

Network Configure the network connection. For more details, see “Network” on page 99.

Users Create and delete user accounts and change the user password. For more details, see 
“Users” on page 99.

Folder Shares Access configuration details relating to how shares are made available through this storage 
device. This icon also displays a list of mounted volumes and their available shares. When a 
USB drive is connected to the device, the USB drive displays as USB share. For more details, 
see “Folder Shares” on page 102.

System Status Displays general information about the storage device, such as device name, firmware version, 
current date/time, system uptime, IP address, volume usage, and volume RAID type. For more 
details, see “System Status” on page 104.
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Device Name 

Use this option to enter or change a device name and/or a description of the device. 
The device name is the name by which your WD ShareSpace is identified on the 
LAN. 

1. Click the Device Name button in Basic Mode home page.

2. Enter or change the text in the Device Name and/or Device Description fields.

3. Click Submit. 

Remote Access Enables or disables the MioNet software. Computers running MioNet can remotely access 
and share files on the storage device over the Internet. For more details, see “Remote Access” 
on page 105.

Shutdown/
Reboot

Performs device shutdown or reboot from any computer on the local area network (LAN). For 
more details, see “Shutdown/Reboot” on page 107.

Category Description
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Date & Time 

The date and time are synchronized automatically to the NTP (network time protocol) 
server by default. You have the option to set the date and time manually or allow the 
NTP to access the Internet to automatically set the time. 

Note: Time displays in 24-hour format only.

1. Click the Date & Time button on the Basic Mode home page.

2. Deselect Enable to set the time manually.

3. To synchronize the date and time automatically, click Enable.

4. Click Submit. 
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Network 

The device’s network mode is set to DHCP Client by default, which is appropriate 
for most environments. By selecting Static IP, you can manually set the IP address, 
netmask, gateway, and DNS (Domain Name Service) server IP address.   

To configure the network settings:

1. Click the Network button on the Basic Mode home page.

2. In the Network Mode drop-down menu, select a network mode. Selecting DHCP 
Client as a network mode causes the device to obtain an IP address 
automatically from the local DHCP server. Selecting Static IP as a network 
mode requires you to enter IP information such as IP address, Default Gateway, 
and DNS Servers. 

3. Click Submit. 

Users 

This button enables the administrator to control access to data on the
WD ShareSpace across the network by creating user accounts with specific 
permissions. The administrator can also edit and delete user accounts. 
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Users Page Icons

Icon Description

Denotes a user private share.

There is no private share with this user name. 

There is a private share with this user name. 

Click this icon to change the user password. 

Click this icon to delete a user. 

Click this icon to add a user. 
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To create a new user account:

1. Click the Users button on the Basic Mode home page.

2. Click the Add icon . 

3. Enter the user name in the User Name field.

4. Enter the user’s full name in the Full Name field. 

5. Enter the password in the Password field.

Note: The maximum length of the password is 16 characters, including alphabetic, numeric, 
underscore, space, and most special characters except double-quote ("). The first and last 
characters cannot be a space. The password is NOT case sensitive.

6. Re-enter the password in the Confirm Password field. 

7. Create a private user share at the same time by clicking Yes next to Create User 
Private Share. The new user is granted full access to the private share. The 
private share name is the same as the user name.

8. Click Submit. 

To change a user password:

1. Click the Users button on the Basic Mode home page.

2. Click the Change Password icon  next to the appropriate user account. 

3. Make the necessary changes, and then click Submit. 

To delete an existing user account:

1. Click the Users button on the Basic Mode home page.

2. Select the user account you want to delete, and then click the Delete icon .

3. Click OK.

For more user configuration options using the WD ShareSpace’s Network Storage 
Manager Advanced Mode, see “Users” on page 153.
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Folder Shares 

Shares are folders that can be used to organize and store files on your 
WD ShareSpace network storage system. Shares can be shared with everyone 
(public) or with selected users on your network (private). 

The device comes preconfigured with three shares: 

• Public—created automatically at the factory 
• Shared Music - folder for storing music files you want to share with other users. 

• Shared Pictures - folder for storing image files you want to share with other users. 

• Shared Videos - for storing video files you want to share with other users. 

Important: Do not change or delete these default share folders. 
Disruption of file sharing could result. These are the default folders for the 
Media Server (Twonky Media) and iTunes Service. For more information on 
how to use Twonky media, see “Media Server” on page 150. For more 
information on how to use the iTunes service, see “iTunes” on page 150.

• Download—for saving files using Downloader (see “Download Manager: 
Downloader” on page 164).

• Configuration—this is a read-only share containing only a Help file and the login 
page. It is not meant for sharing or storing data and should not be modified.

The administrator can create private shares accessible only by user name and 
password when setting up a user account (see page 101), or by setting permissions 
on an existing share (see “Folder Share Permissions” on page 156).

You must first access WD ShareSpace’s Network Storage Manager to create a 
share. 
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The Folder Shares button provides access to a list of available shares.

Folder Shares Page Icons 

To create a share:

1. Click Folder Shares on the Basic mode home page.

2. Click the Add icon . 

3. Enter a share name in the Share field. The share name can contain up to 32 
characters, including alphabetic, numeric, or underscore characters.

4. Enter a brief description in the Description field.

Icon Description

Denotes a user private share.

This is a publicly accessible share. 

This is a private share.

Click this icon to delete a share. 

Click this icon to add a share. 
NETWORK STORAGE MANAGER: BASICS - 103



WD SHARESPACE
USER MANUAL
5. Click Submit. 

To delete existing shares:

WARNING! Deleting a share erases all data on the share. All files and 
folders on the share will be lost.

1. Select the share to delete. 

2. Click the Delete icon .

3. Click OK.

System Status 

The System Status button displays general information about the system: device 
name, firmware version, current date/time, system uptime, IP address, volume usage, 
and volume RAID type. Click the System Status button on the Basic mode home 
page to access system information.
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Remote Access 

WD ShareSpace comes with MioNet enabled by default. The Remote Access 
button on the Network tab home page enables you to control the MioNet service on 
the storage device. If MioNet is not already set up through the web, follow the 
instructions in “MioNet Remote Access” on page 55. 

MioNet Icons
• Start/Stop MioNet - Shows Stop MioNet if MioNet is running; shows Start Mionet 

if MioNet is stopped.
• Restart MioNet - Reboots MioNet.
• Reset MioNet - Resets the MioNet account information on the WD ShareSpace. 

If the WD ShareSpace is registered to a MioNet account, that registration is 
erased so that the unit is now unregistered. This status is displayed in the upper 
right corner of the page. Any shares created by MioNet or MioNet users remain, 
and no data is lost. Access to these shares over the LAN requires the use of the 
MioNet username and password.

MioNet Service Status Messages

• MioNet service connection status
• Started - MioNet service is started

• Stopped - MioNet service is stopped and will start on system restart. 

• Disabled - MioNet service is disabled and will not start on system restart.

• MioNet registration status 
• Unregistered - Not currently registered to a MioNet account

• Registered - Already registered to a MioNet account

Note: A mouse-over of the registration status shows the MioNet account name if the device is 
registered. To register with MioNet, go to: www.mionet.com/WDShareSpace.
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To register with MioNet:

1. Click the Create MioNet account link in the note at the bottom of the page. The 
MioNet web registration page displays.

2. Enter the registration information required and click Submit.

To log in to an existing MioNet account:

1. Click the MioNet login link at the bottom of the page.

2. Enter your MioNet username and password and click Go.
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Shutdown/Reboot 

The Shutdown/Reboot button allows you to perform a system reboot or shutdown.

To shut down the WD ShareSpace:

1. Click Shutdown/Reboot on the Basic mode home page.

2. On the Shutdown/Reboot page, click Shutdown. 

3. Click OK.

To reboot the WD ShareSpace:

1. Click the Shutdown/Reboot button on the Basic Mode home page.

2. On the Shutdown/Reboot page, click Reboot. 

3. Click OK. 
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Network Storage Manager: Advanced Mode
Advanced Mode provides access to additional options not available in Basic Mode. 
When in Basic Mode, click Advanced Mode on the toolbar to view WD 
ShareSpace’s Network Storage Manager in Advanced Mode.      

The Advanced Mode page include six tabs, each having several icons providing more 
management options for maximum flexibility and security of the device. The table 
below describes the tab options available in Advanced Mode. 

Tab Description

System The System tab allows you to configure the general system settings, set email or window 
alerts, change the administrator password, perform firmware upgrades, perform system 
configuration file backups, restore system to factory defaults, activate or deactivate the 
system LEDs, generate an SSL certificate, enable power saving, and perform device 
shutdown or reboot. For more details, see “System Tab” on page 109.

Network The Network tab has access to all network configuration options, such as setting DHCP / 
Static mode, changing the IP address, netmask, gateway, DNS server IP address, configuring 
jumbo frames, and configuring membership in a domain or workgroup. For more details 
“Network Tab” on page 124. 

Storage The Storage tab provides a list of all supported drives it locates on the system. It also allows 
you to configure the RAID capability of the hard drives, manage file share preferences, set the 
backup destination folder, set disk quotas, and set a share folder for users. For more details, 
see “Storage Tab” on page 131.

Media The Media tab allows you to enable or disable the streaming option in iTunes or to access the 
Twonky Media server. For more details, see “Media Tab” on page 149.

Users The Users tab allows you to add, modify, and delete users and groups, and change all user 
and group permissions (read/write, read only, no access) to shares/folders and USB storage 
devices. For more details, see “Users Tab” on page 152. 

Status The Status tab displays general information about the system such as device name, firmware 
version, current date/time, machine up-time, memory and swap activity, and load averages. 
This tab also allows viewing of logs from the system, Common Internet File System (CIFS), or 
File Transfer Protocol (FTP). For more details, “Status Tab” on page 160.
10
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System Tab

The System tab in Advanced Mode enables you to set the system date and time, set 
up alerts, change the admin password, perform software or firmware upgrades, 
create a backup copy of the system files, restore the system to factory defaults, 
generate and set up an SSL certificate, or perform system reboot or shutdown. 

The System tab provides access to the following configuration options: 

• General Setup 
• Alerts Setup
• Admin Password
• Update
• Restore Configuration 
• Advanced
• UPS
• Shutdown/Reboot

General Setup 

The General Setup button on the System tab home page allows you to perform 
basic configuration of device. You can provide a name and brief description for the 
device, select a compatible web access protocol, and set the time zone. You can set 
the date and time manually or enable automatic time synchronization by NTP 
(Network Time Protocol) Service. You can also manually specify the IP address of the 
NTP servers to which you want to synchronize. 
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To configure system general setup settings:

1. Assign a device name for this storage device in the Device Name field. The 
device name can contain up to 15 characters, including alphabetic, numeric, and 
hyphens only.

2. Enter a brief description for this storage device in the Device Description field. 
The maximum length of the description must not be more than 256 alphanumeric 
characters.

3. For Web Access Protocol, select either of the following web access protocols:
• Hypertext Transfer Protocol (HTTP) is a communications protocol for the transfer of 

information on the intranet and the World Wide Web.

• Hypertext Transfer Protocol over Secure Socket Layer or HTTPS is a URL scheme 
used to indicate a secure HTTP connection. HTTPS is syntactically identical to the http:// 
scheme normally used for accessing resources using HTTP. All traffic between the managing 
computer and the WD ShareSpace is encrypted. HTTPS provides a more secure means of 
configuring your device, but it may affect the responsiveness of the user interface.

4. To set the date and time manually, deselect Enable next to NTP Service. 

5. Select a time zone from the Time Zone list. 

6. Adjust the date and time manually in the Date & Time lists. 

7. Click Submit.
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Alerts Setup 

Using the Alerts Setup button on the System tab home page, you can configure 
emails or popup messages that provide alerts for system conditions such as over 
temperature; hard drive, volume, network, and USB status; and user and group 
events. These alerts help the system administrator(s) manage and detect events or 
errors. 

Note: Email alerts may not work with some ISPs using strong spam filtering. For further information, 
go to support.wdc.com and search the knowledge base for answer ID 2570.
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To set up automatic email notifications:

1. On the Alerts Setup page on the System tab, click Enable next to Email 
Notification. The page displays additional fields.

2. In the SMTP Server field, enter the name or IP address of the SMTP server used 
for email. (Check with your Internet Service Provider (ISP) for the SMTP server 
settings, which may include the SMTP port, and ask whether to enable TLS/SSL 
or SMTP authentication.)

3. In the Email Return Path field, enter a valid return email address recognized by 
your ISP. For example, if your SMTP server is "smtp.myisp.net", then you should 
enter a valid return email path address of the form "myname@myisp.net". 

4. In the Email Recipients field, enter the email address where you want to send 
an email message when an event occurs. Up to five email addresses can be used 
at a time. 

5. Click Send Test Mail to send a test alert and confirm your settings are correct. 
A test message will be sent to each entered email address.

6. Click Submit.
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To configure alerts to send pop-up messages when an event occurs:

Note: Pop-up notification only works with Windows XP. 

For a list of events, see “System Events” on page 187.

1. On the Alerts Setup page on the System tab home page, click Enable next to 
Pop-Up Notification. 

2. Enter the name of the computer in the Notified Devices field. When an event 
occurs, a pop-up message will appear on the computer. Up to five computer 
names can be added to the alert list.

Note: To find the name of your computer, click Start and right-click Computer or My Computer, 
click Properties, and then click the Computer Name tab (Windows XP).

3. Click Send Test Pop-up to send a test alert and confirm that the settings are 
correct.

Note: Make sure the Messenger Service is activated on the computers to which you want to send 
the pop-up message when an event occurs. To enable Messenger Service, go to Start>Control 
Panel>Administrative Tools>Services>Messenger. You can test the Messenger Service by 
clicking Send Test Pop-up. Make sure printer and file sharing is selected as an exception if the 
Windows Firewall is enabled in Windows 2000/XP.

4. Click Submit. 
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Admin Password 

The Admin Password button on the System tab home page allows you to change 
the administrator’s password. 

To change the administrator's password:

1. Click the Admin Password button on the System tab home page.

2. In the Old Password field, enter the old password.

3. In the New Password field, enter the new password. The maximum length of the 
password is 16, including alphabetic, numeric, underscore, space, and most 
special characters except double-quote ("). The first and last characters cannot 
be a space. The password is case sensitive.

4. In the Confirm Password field, re-enter the new password.

5. Click Submit.

Update (Firmware) 

The Update button on the System tab home page provides information about the 
current firmware version and allows you to perform a firmware update either 
automatically or manually.

Automated

The Automated tab on the Update page provides information about the current 
firmware version and connects to the WD website for automatic downloading of the 
latest firmware. 

1. Click the Update button on the System tab home page.
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2. Click Check For New Firmware. 

3. Click Download if new firmware is available. 

When the download is finished, the following page displays:

4. Click Upgrade. Wait for the update process to complete. 
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WARNING! Do not interrupt a firmware upgrade in progress; doing so 
may cause the device to malfunction or render it unusable.

After your firmware has been updated, the device will reboot. The user interface 
redirects to the System Status page after the update has completed.

Manual

The Manual option allows you to install the firmware manually.   

1. Before attempting a manual update, check support.wdc.com for firmware 
availability.

2. If a new firmware file is available, obtain it from WD Technical Support at 
support.wdc.com.

3. Save the file to a Desktop location on your computer. 

4. Click the Manual tab on the Update page.

5. Under Firmware Update, click the Browse button and locate the firmware file 
you saved.

6. Click Submit.

7. After your firmware has been updated, the device will reboot. The web user 
interface redirects to the System Status page after the update is completed.
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A page with a progress bar and a warning displays.

WARNING! Do not interrupt a firmware upgrade in progress; doing so 
may cause the device to malfunction or render it unable to boot.

After your firmware has been updated, the device reboots. The web user interface 
redirects to the System Information page after the update is completed.

Note: If the IP address of your unit has changed, you will need to use WD Discovery Tool to discover 
it again.
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Configuration 

The Configuration button on the System tab home page enables you to save or 
restore system configuration settings or revert to factory default settings.

To back up the current system configuration settings:

1. On the Configuration page, click Save Current Configuration. 

2. Click Save.

3. Specify a file name and location for saving the file. 

4. Click Save. 
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To restore saved configuration settings:

1. On the Configuration page, click Browse. 

2. Select the previously saved system configuration file. 

3. Click Open.

WARNING! Before you restore configuration settings, bear in mind that 
all current system configurations and user data are lost when you do a 
Full Restore. When you do a General Restore, all current system 
configurations are lost, but your data is not deleted.

4. Click General Restore or Full Restore. 

General Restore restores all features to previously saved settings. The data 
volume and shares settings are not changed. 

Full Restore restores all features, including the data volume and shares, to 
previously saved settings. All data files are erased from the drive.

5. Click OK. 

To restore the device to factory defaults:

Important: Save the current configuration prior to restoring the factory 
default settings. 

Performing a factory default reset will erase all settings in the WD ShareSpace. 
System configuration will reset the device to default factory settings. All 
information and data will be lost. The LAN settings (including port settings) are 
not changed. After the reset, the administrator login/password will be changed to 
“admin/admin.”

1. On the Configuration page, click Restore Factory Default. 

2. Click OK. 

During the system restore process, the system will turn off the power LED and 
blink the backup LED. Wait until the system restore process is completed. 

Note: You cannot access the configuration web pages if you forget the administrator password, IP 
address setting, or device name. Use the reset button to restore these settings (including IP setting, 
device name, and administrator password) to factory default configuration. To use this function, 
press and hold the reset button on the back of the device (next to power interface) for at least 10 
seconds. The system reboots automatically and you can then use the default settings to access the 
device. 
NETWORK STORAGE MANAGER: ADVANCED MODE - 119



WD SHARESPACE
USER MANUAL
Advanced 

The Advanced button on the System tab home page enables you to configure the 
system for root access, SSL certificate/key, power saving, and LED control. You can 
also set the extend Span mode and enable HDD standby mode. 

To open the Advanced page: 

1. Click the Advanced button on the System tab home page.

To enable SSH access:

Secure Shell (SSH) is a network protocol that uses encryption and authentication 
keys to enable two devices on the network to exchange data securely. Enabling SSH 
access allows login to a console window using SSH for diagnostic use. The default 
root user password is displayed for the user.

1. On the Advanced page, select the Enable check box under Root Access. 

2. Click Submit.
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To turn on the system identification LED:

System Identification identifies the location of the device. If you have multiple devices 
installed, you can use this function to turn on the identification LED and know which 
device you are configuring.

1. Click ON to enable the system identification LED.

To generate an SSL certificate and key pair automatically: 

1. On the Advanced page on the System tab home page, click the highlighted word 
“HERE” in the Auto Generate field of the SSL certificate/key. The SSL 
Certificate/Key Generation screen appears. 

2. Enter the identification information you want to include in the certificate/key pair.

3. Click Submit. 

To generate an SSL certificate and key pair manually:

1. Using your preferred method, generate an RSA private key and paste it in the 
appropriate fields of the Advanced page.

2. Click Submit.

To select extend disk mode: 

1. On the Advanced page, select Auto Extend or Manual (Extend Disk) Mode:

Auto Extend only applies when RAID type is Span and fewer than four drivers are 
installed. It will extend an existing Span automatically when you add a new drive 
and reboot the system. Manual allows you to choose when to add the new drive 
after boot up.

2. Click Submit.
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To disable HDD standby (enabled by default):

If the HDD Standby function is enabled, the hard drives go into standby mode to save 
power after a fixed period of no activity. This period varies from 125 seconds to 375 
seconds.

1. On the Advanced page, clear the Enable check box next to HDD Standby. 

2. Click Submit. 

Note: The Power Save feature allows drives to spin down when not in use. The fan will continue to 
operate. 

UPS 

A UPS (uninterruptable power supply) device can be connected to one of the USB 
ports to shut down the ShareSpace in the event of a power failure. You must connect 
the UPS device to the WD ShareSpace before setting up the UPS service.

Note: Go to support.wdc.com and search the knowledge base for answer ID 2559 for a list of 
compatible UPS devices.

UPS Setup

The UPS Setup button on the System tab home page enables you to modify UPS 
settings. 

To enable the UPS service:

1. Click the UPS Setup button on the System tab home page.

2. On the UPS page, click the UPS Setup tab.

3. Select the Enable check box for UPS Service. 

4. Enter the timeout value. 

5. Click Submit. 

Note: During a power failure, the system will shut down after Timeout seconds have expired, the 
remaining battery percentage reaches 15% or less, or the remaining battery runtime drops to or 
below 5 minutes. A value of '0' disables the Timeout timer..
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UPS Status

1. Click the UPS Setup button on the System tab home page.

2. On the UPS page, click the UPS Status tab to view information about the 
connected UPS device, including model, battery level and runtime, timeout, and 
status. 

Shutdown/Reboot 

The Shutdown/Reboot button on the System tab home page allows you to reboot 
or shut down the system.

To shut down the WD ShareSpace:

1. Click the Shutdown/Reboot button on the System tab home page.

2. On the Shutdown/Reboot page, click Shutdown. 

3. Click OK.
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To reboot the WD ShareSpace:

1. Click the Shutdown/Reboot button on the System tab home page.

2. On the Shutdown/Reboot page, click Reboot. 

3. Click OK. 

Network Tab 

The Network tab provides access to the following configuration options:

• LAN
• Services
• Workgroup
• Remote Access

LAN 

The LAN button on the Network tab home page allows access to all network 
configuration options including setting the connection method, changing the IP 
address, netmask, gateway, and DNS (Domain Name Service) server IP address, as 
well as changing the MTU size to enable jumbo frames.
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To configure the network settings:

1. In the Network Mode drop-down menu, select a network mode. Selecting DHCP 
Client as a network mode will cause this storage device to obtain an IP address 
automatically from the local DHCP server. Selecting Static IP as a network mode 
requires you to assign IP information such as IP address, Default Gateway, and 
DNS Servers. 

2. If your network link speed is 1000 Mbps, the MTU field will be available. Enter the 
MTU (Maximum Transmission Unit) value for the jumbo frame. The default MTU 
setting is 1500 bytes. Any value larger than this is considered a jumbo frame. The 
network card on the client computer must support jumbo frames.

Note: For the MTU size larger than 1500, the client machine and the network switch must also 
support the same MTU size. The common MTU size for jumbo frame is '9004'. The rule for 
calculating valid MTU is (MTU size - 1500) mod 8 = 0 ('xxx mod 8' means the value 'xxx' can be 
divided by 8). 
The range of valid IP addresses for each class: 
- Class A: 1.0.0.1 to 126.255.255.254 
- Class B: 128.1.0.1 to 191.255.255.254 
- Class C: 192.0.1.1 to 223.255.254.254 

3. Click Submit. 

Services 

The Services button on the Network tab home page allows you to set protocols for 
sharing files and folders on the device. The protocols include:

• Universal Plug and Play (UPnP) is a set of computer network protocols that 
simplifies the implementation of networks in the home by allowing devices to 
connect seamlessly.

• File Transfer Protocol (FTP) is a network protocol used to transfer data from 
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one computer to another through a network. FTP is a popular choice for 
exchanging files independent of the operating systems involved.

• Network File System (NFS) is a network file system protocol that allows a user 
on a client computer to access files over a network as easily as if the network 
devices were attached to its local disks. Generally used on UNIX systems.

• Web Access
• Hypertext Transfer Protocol (HTTP) is a communications protocol for the transfer 

of information on the intranet and the World Wide Web.

• Hypertext Transfer Protocol over Secure Socket Layer or HTTPS is a 
URL scheme used to indicate a secure HTTP connection. It is syntactically identical to the 
http:// scheme normally used for accessing resources using HTTP.
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To enable UPnP NAT Traversal for Web Access & FTP:

1. Click Enable in UPnP for Web Access & FTP.

2. Click Submit. 

The UPnP NAT Traversal combines with the UPnP feature and NAT feature. 
Universal Plug and Play (UPnP) is an architecture for pervasive peer-to-peer 
network connectivity of PCs and intelligent devices. The Network Address 
Translation (NAT) is used in gateway devices that form the boundary between the 
public Internet and the private LAN. As IP packets from the private LAN traverse 
the gateway, NAT translates a private IP address and port number to a public IP 
address and port number, tracking those translations to keep individual sessions 
intact. 

To enable other network services:

1. Click Enable beside the desired network service. 

2. If you selected FTP as your network service, click Yes to enable or click No to 
disable anonymous login, and then click Submit. 

3. If you selected NFSas your network service, the IP allowed field appears. You 
will be prompted to enter the IP filters that are allowed for NFS service. Click Add 
to add a new IP filter, and then click Submit. 

Note: In IP Allowed field of NFS service, '*' means allow all IP addresses. If you intend to allow 
specified IP addresses or range, please modify '*' in the IP Allowed field. 
Mount point for NFS share is /nfs/SHARENAME, Ex. /nfs/Public. 

4. You can specify particular port numbers for HTTP, HTTPS, and FTP services 
respectively. Instead of selecting the Default radio button, you can specify the 
port number between 8000 and 10000 for each service. 

To access data via FTP:

You can access data in a shared folder on WD ShareSpace with a widely used FTP 
client software program. An FTP client software program must be installed on the 
computer you are using to access the device, and FTP service must be enabled on 
the WD ShareSpace (see “To enable other network services:” on page 127 and “To 
modify properties of the share:” on page 141 for details).

1. Open an FTP client software program.

2. Enter ftp://username@IP address as the host name 
(e.g., ftp://admin@172.25.102.67) or just the device’s IP address depending on 
the FTP client software program you are using.

Note: Click System Status in either the basic or Advanced Mode to view the device's IP address.

3. Enter the WD ShareSpace user name and corresponding password.

4. Click Connect or OK.

You can now upload files to or download files from WD ShareSpace across the LAN. 
It is possible to upload files to or download files from WD ShareSpace across the 
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Internet (WAN), but this requires custom router configuration and is recommended 
only for advanced users.

Workgroup 

The Workgroup button on the Network tab home page allows you to set up the 
network storage device as a workgroup or a domain member. The default setting is 
Workgroup. 

Domains are controlled from a central location (domain controller) and require central 
authentication before you can join them. Workgroups, in contrast, are much simpler 
to control. As long as you know the workgroup name, you can add any computer to a 
workgroup.

If your network uses a domain (has Windows Server 2003 or Windows Server 2008 
domain controller), you may want to connect this device as a domain member. When 
configured as a domain member, the device will ask the Active Directory Service 
(ADS) to authenticate users. Therefore, as a domain member, the device provides 
user-level security. 

ADS enables the administrator to manage users’ permissions in a central location 
and to propagate these permissions to multiple devices. For example, any device that 
has a domain on ADS inherits the user list and associated permissions.

When joining a domain, the device must be authorized by the domain's administrator. 
You must enter the fully qualified Domain Name, Domain Controller IP Address, 
Domain Administrator Name, and Domain Administrator Password for the 
authorization. 

To set up a workgroup name:

1. Click the Workgroup button on the Network tab home page.

1. Click Workgroup as the Mode option. 

2. Enter a name for your workgroup in the Workgroup Name field. 

3. Click Submit. 
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To join a domain (Windows Server 2003 or Windows Server 2008): 

1. Click Domain Member. 

2. Enter the fully qualified domain name in the Domain Name field. 

3. Enter the domain controller IP address in Domain Controller IP Address field. 

4. Enter the domain administrator name in the Administrator field. 

5. Enter the domain administrator password in the Administrator Password field. 

Note: The local user and domain user share the same access control rights if the user name of the 
local and domain users are the same (FTP service excluded).

6. Click Submit. 

When the process is complete, a confirmation message appears.

If changes are made at the Active Directory server to either users or groups or 
both, you can manually update the list on the WD ShareSpace. (See “Folder 
Share Permissions” on page 156.)

Note: You can enable ADS to automatically update the WD ShareSpace. Contact WD Tech 
Support for more information on this procedure. 
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Remote Access 

WD ShareSpace comes with MioNet enabled by default. The Remote Access 
button on the Network tab home page allows you to control the MioNet service on 
the storage device. If MioNet is not already installed on the client computer, follow 
the instructions under “MioNet Remote Access” on page 55. 

MioNet Icons

• Start/Stop MioNet - Shows Stop MioNet if MioNet is running; shows Start 
MioNet if MioNet is stopped.

• Restart MioNet - Stops MioNet if it is running and starts it again.
• Reset MioNet - Resets all MioNet account information on the ShareSpace. If the 

ShareSpace is registered to a MioNet account, that registration is erased so that 
the unit is now unregistered. This status displays in the upper right corner of the 
page. Any shares created by MioNet or MioNet users remain, and no data is lost. 
Access to these shares over the LAN requires the use of the MioNet username 
and password.

MioNet Service Status Messages

• MioNet service connection status
• Started - MioNet service is started

• Stopped - MioNet service is stopped and will start on system restart. 

• Disabled - MioNet service is disabled and will not start on system restart.
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MioNet Registration Status 

• Unregistered - Not currently registered to a MioNet account

• Registered - Already registered to a MioNet account

Note: A mouse-over of the registration status shows the MioNet account name if the device is 
registered. To register with MioNet, go to: www.mionet.com/WDShareSpace.

To register a new Web account with MioNet:

1. Click the Create MioNet account link in the note at the bottom of the page. The 
MioNet registration page displays.

2. Enter the registration information required and click Submit.

To log in to an existing MioNet account:

1. Click the MioNet login link at the bottom of the page.

2. Enter your MioNet username and password and click Go. 

Storage Tab

The Storage tab provides all necessary options required for individual storage disk 
configuration and maintenance. This tab also includes an option to change the 
system’s RAID configuration, set a share name, and format and safely remove the 
USB drives connected to the system. 

The Storage tab provides the following configuration options:

• Disk Manager
• Volumes & RAID Management
• Folder Shares
• USB Shares
• Quota 
• Downloads
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Disk Manager 

The Disk Manager button on the Storage tab home page displays the installed 
hard drives in the device. This page also displays detailed information about each 
drive, such as disk size, description, and status. 

Drive status messages include the following:

• Good—Indicates the hard drive is accessible and functioning normally. 
• Failed—Indicates a fatal error has occurred on the hard drive(s). See “Replacing 

a Drive” on page 177 for drive replacement instructions. 
• Foreign—Indicates the device has detected a hard drive that was used on 

another computer. 

To clean up a disk:

If the hard drive is foreign or used, the Clean Disk  icon appears on the right side 
of the Disk Management table. Clean Disk erases the previous partition to allow 
creation of a new volume. 

To safely remove a disk:

If the hard drive is not part of an existing volume, the Safely Remove Disk  icon 
appears on the right side of the Disk Management table and allows you to safely 
remove the drive. 
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Volumes and RAID Management 

The Volumes and RAID Management button on the Storage tab home page 
displays two tabs—Manage Volume and Manage RAID. 

Manage Volume

The Manage Volume tab lists all the volumes available on the device and provides 
detailed information about each volume such as description, RAID type, usage, size, 
and volume status. 

Note: If the volume RAID type is Span and there are new disks in the system, the Extend icon 
appears on the side of the Manage Volume table. 
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Volume status messages include the following:

• Good—Indicates the volume is accessible and hard drive is functioning normally. 
• Failed—Indicates a volume cannot be started automatically, the disk may be 

damaged or the file system may be corrupt. 
• Resyncing—Occurs when creating a mirror or when a mirrored volume is being 

resynchronized. 
• Formatting—Indicates volume is being formatted.
• Degraded—Missing one drive in a RAID configuration.
• Recovering—The failed drive has been replaced and data is being restored to a 

working drive in a RAID 1, RAID 5, or RAID 10 configuration.

To display more detailed information, click an underlined status.

To modify the volume:

1. Click the Manage Volume tab.

2. Click the Modify  icon next to the volume you want to modify. The Volume & 
Raid Management page appears.
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3. Select a RAID level.

4. Click Submit. 

To delete a volume:

1. Click the Delete  icon.

2. Click OK. 

Note: Only ExtendVolume can be deleted.

Manage Volume Options

The table below shows available volumes for systems containing one to four drives.

Number of Drives Available RAID options

1 Drive span

2 Drives span, stripe, mirror

3 Drives span, stripe, RAID 5

4 Drives- 1 Volume span, stripe, RAID 5, 2 mirrors, RAID 10

4 Drives - 2 Mirror Mode span, stripe, mirror
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If you add or remove drives, the new number of drives will determine which options 
are available. For example, with two drives, you can choose span, stripe, or mirror. If 
you add two more drives (for a total of four drives), you can then choose span, stripe, 
RAID 5, RAID 10, or 2 mirrors. On the other hand, if you have two drives and remove 
a drive, you're left with a single drive and will only have the span option.

Extend Span: This option is only available when adding a drive to an existing RAID 
array that is configured as span. It can be done automatically or manually (see page 
121).

Manage RAID

Configure RAID on the hard drives using the Manage RAID tab on the Volume 
Management page. The default RAID configuration is Span for two disks and Raid 5 
for four disks.

WARNING! Changing the RAID configuration causes all volumes and 
data to be lost.
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RAID (Redundant Array of Independent Drives) refers to an array of multiple 
independent hard drives that provide high performance and reliability. RAID function 
depends on the number of drives present and the RAID level selected. 

The WD ShareSpace supports the following RAID levels: 

• RAID 0 (Striped) — provides data striping (spreading out blocks of each file 
across multiple hard drives) but no redundancy. This improves performance but 
does not deliver fault tolerance. If one drive fails then all data in the array is lost. 

• RAID 1 (Mirrored) — provides disk mirroring. Mirroring creates an exact copy 
(or mirror) of a set of data on two drives, which increases reliability compared to a 
single drive. If either drive fails, the other continues to function as a single drive 
until the failed drive is replaced.

• Two Mirror — Two Mirror mode is available when four drives are installed in the 
WD ShareSpace. In this mode, two independent RAID 1 volumes are created.

• Span (Spanned) — combines drives into a linear fashion to create one large 
logical volume. Unlike RAID 0, which “stripes” all data bitwise to all drives, the 
volume is linear across both drives. A spanned drive is literally like a single bigger 
drive, in that files written to the volume earlier go to the “beginning” of the volume, 
on the first physical drive. As the volume fills, files written later are written toward 
the “end” of the volume, on the second drive. Like RAID 0, no data redundancy is 
provided. If one of the drives fails, all data is lost. 

• RAID 5 — requires a minimum of 3 drives to implement. Similar to RAID 0 but 
adds fault tolerance by including parity information with the data. Parity is 
generated on Writes, recorded in a distributed location, and checked on Read. In 
this mode, failure of a single drive does not cause loss of data.

• RAID 10 — requires a minimum of four drives to implement. Provides data 
striping on top of disk mirroring. 
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To configure the Manage RAID tab:

Warning! Be sure to back up all data before configuring RAID. All data 
stored in the hard drive is lost when changing the RAID configuration. 

1. Click the Manage RAID tab on the Volumes & Raid Management page. 

2. Select a RAID configuration 

DataVolume is the default volume. 

If the volume RAID type is JBOD, and there are new disks in the system, the 
Extend icon appears on the side of the Volume Management table. 

3. Click Submit. 
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Manage RAID Options

Any existing mode can be changed to any other available mode using the Manage 
RAID option. The following table shows the available RAID modes for a 
WD ShareSpace with one or more drives.

If you add or remove drives, the new number of drives will determine which options 
are available. For example, with two drives, you can choose span, stripe, or mirror. If 
you add two more drives (for a total of four drives), you can then choose span, stripe, 
RAID 5, RAID 10, or 2 mirrors. On the other hand, if you have two drives and remove 
a drive, you're left with a single drive and will only have the span option.

Folder Shares 

Shares are folders that can be used to organize and store files on your 
WD ShareSpace. They can be shared with everyone (public) or with selected users 
on your network (private). 

The device comes preconfigured with three shares: 

• Public—created automatically after initial setup 
• Shared Music - folder for storing music files you want to share with other users. 

• Shared Pictures - folder for storing image files you want to share with other users. 

• Shared Videos - for storing video files you want to share with other users. 

Important: Do not change or delete these default share folders. 
Disruption of file sharing could result. These are the default folders for the 
Media Server (Twonky Media) and iTunes Service. For more information on 
how to use Twonky media, see “Media Server” on page 150. For more 
information on how to use the iTunes service, see “iTunes” on page 150.

• Download—for saving files using Downloader (see “Download Manager: 
Downloader” on page 164).

• Configuration—this is a read-only share containing only a Help file and the login 
page. It is not meant for sharing or storing data and should not be modified.

When setting up a user account, the administrator can create private shares 
accessible only by user name and password (see “To create a new user account:” on 
page 101), or by setting permissions on an existing share (see “Folder Share 
Permissions” on page 156).

Number of Drives Available RAID options

1 Drive span

2 Drives span, stripe, mirror

3 Drives span, stripe, RAID 5

4 Drives span, stripe, RAID 5, 2 mirrors, RAID 10
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The Folder Shares button on the Storage tab home page provides access to a list of 
available shares. 

USB share naming corresponds to the following configuration: 
usb-<port number>share<partition number>

To create a share:

1. Click the Add icon  to display the following:

2. Enter a share name in the Share field. The share name can contain up to 32 
characters, including alphabetic, numeric, or underscore.

3. Enter a brief description in the Description field.
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4. Click a file sharing protocol next to Services. The WD ShareSpace supports the 
following file sharing services (protocols):
• CIFS (Common Internet File System) - Allows access to share files via the CIFS 

protocol. The access control for CIFS is set as share-based. This means that a user must 
enter a valid account and password for accessing the share, and users can only access the 
shares to which they have been granted access rights (Read Only or Full Access). CIFS is 
the recommended file sharing protocol for Windows platform, and allows users to access 
shares through My Network Places. Mac OS X or later also supports the CIFS protocol. 

• File Transfer Protocol (FTP) is a network protocol used to transfer data from one 
computer to another through a network, such as the Internet, using an FTP client program. 
FTP is a popular choice for exchanging files independent of the operating systems involved.

• Network File System (NFS) is a network file system protocol that allows a user on a client 
computer to access files over a network as easily as if the network devices were attached to 
its local disks.

• Apple Filing Protocol (AFP) - the network protocol for sharing files and file services in an 
AppleTalk network.

5. Select a logical volume you want to share from the Volume list. 

6. (Optional) Click Setup access control after creating this share to set 
access control for the new share. For more information, see “To edit the access 
rights of users or groups:” on page 156.

7. Click Submit. 

To modify properties of the share:

Note: Properties for the Public and Download shares cannot be modified, and these shares cannot 
be deleted.

1. On the Folder Shares list, select the share you want to modify, and then click 
the Modify icon . 

2. Edit the share name if desired. The share name can contain up to 32 characters, 
including alphabetic, numeric, or underscore characters.

3. Enter a brief description, if desired.

4. Select a file sharing protocol. 

5. Click Submit. 
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To delete existing shares:

1. On the Folder Shares list, select the share to delete. 

2. Click the Delete icon .

3. Click OK.

USB Shares 

The USB Shares button provides three tabs—USB Disk, USB to WD ShareSpace 
Backup, and WD ShareSpace to USB Backup. Use these tabs to format a USB 
drive, remove a USB drive, and perform backup operations from a USB drive to the 
WD ShareSpace and vice-versa. When a USB storage device with the FAT, FAT32, 
HFS+J, or NTFS file system is connected to the network storage device, the USB 
device displays as a USB share.

USB Disk

Use the USB Disk button on the Storage tab home page to format or safely 
disconnect a USB drive or to configure auto backup. (See “USB Auto Backup 
Feature” on page 76.)
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To format a USB drive:

1. Connect a USB drive to the device.

Note: The WD ShareSpace supports USB flash disk and external USB drives; USB optical drives 
(CD/DVD combo or DVD dual/multi drive) are not supported.

2. On the USB Disk page, click the Format icon  to the right of the USB. A 
dialog box warns that all data will be erased.

WARNING! Formatting hard drives erases all the disk contents, 
including partition tables, logical volumes, and all shared folders, 
subfolders, and files. Perform this procedure only when it is safe to 
proceed. When formatting a USB drive, only one partition is created, 
and the partition is formatted as FAT32. With FAT32, only 4 GB can be 
copied for each file. If you try to transfer files that are larger than 4 GB, 
you may encounter a Copy Termination error.

3. Click OK. The USB LED blinks while the drive is being formatted.

4. Once the LED stops blinking, remove the USB drive from the WD ShareSpace. 

To safely remove a USB drive:

Note: Whenever a USB device is disconnected without first being ejected or dismounted, there is a 
risk of data loss or damage to the USB drive. With the safe remove disk option you can safely 
remove any USB drive attached to the device.

1. On the USB Disks page, click the Safely Remove Disk icon  to the right of the 
USB device name. 

2. Click OK.
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USB to WD ShareSpace Backup

Use the USB to ShareSpace Backup tab to set a destination share for a different 
USB drive backup. 

To set a destination share name for the USB drive to WD ShareSpace backup:

1. On the USB Shares page, click the USB to WD ShareSpace Backup tab. 

2. Select a share to be used as a destination share from the Destination Share 
list.

3. Click Submit. 

Note: If no destination is selected, backup to the WD ShareSpace is disabled.
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WD ShareSpace to USB Backup

Use the WD ShareSpace to USB Backup tab to set a source share for this 
backup method. 

To set a source share name for WD ShareSpace to USB drive backup:

1. On the USB Shares page, click the WD ShareSpace to USB Backup tab. 

2. Select a share to be used as source share from the Source Share list. 

3. Click Submit. 

Note: If no source is selected, backup from the WD ShareSpace is disabled.

Quota 

The Quota button on the Storage tab home page allows administrators to enable or 
disable quota control for the device and set grace time and quota limits for each user. 

Quota is used to limit the maximum storage capacity for each user. The accumulated 
files or folders stored in a volume for the specified user cannot exceed the quota 
setting. Once the user data exceeds the quota, a 7-day (by default) grace period 
commences. The user still can store up to 100 MB of additional data on the volume 
within the grace period. When the grace period expires, the user cannot store 
additional data on the volume until deleting the amount of data required to reduce the 
total capacity used to below quota setting.
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Manage Quota

The Manage Quota tab in the Quota Management page provides the quota 
information for each volume and allows administrators to modify the quota settings. 

Note: Use the Manage Quota tab to enable quota globally, and use the DataVolume User 
Quota tab to enable quota per person.   

To configure disk quota:

1. Select the volume you want to modify, and then click the Modify icon . 

2. Click Enable next to Quota Service to enable disk quota service. 

3. Specify the grace period after which no additional drive space is provided. 

4. Click Submit. 
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DataVolume User Quota (or ExtendVolume User Quota)

The DataVolume User Quota (ExtendVolume User Quota) tab provides user quota 
information details and allows administrators to modify the user quota setting if two or 
more volumes are available.

To modify the user quota setting:

1. Select the volume you want to modify, and then click the Modify  icon. 

2. Click Enable next to Quota Service to enable disk quota service. 

3. Specify the quota size for the user. 

4. Click Submit. 
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Downloads 

The Downloads button on the Storage tab home page provides two tabs—Setup 
Destination Share and Change Password. These tabs provide configuration 
options for selecting the Downloads target share and changing the Downloader login 
password. This login provides non-administrator users with a method to download 
files directly to the WD ShareSpace. For more information on how to use the 
Downloader utility, refer to “Download Manager: Downloader” on page 164.

Set up Destination Share

Use the Setup Destination Share tab to choose the target share for the 
Downloader utility. For more information on how to use the Downloader utility, refer to 
“Download Manager: Downloader” on page 164.

To set the destination share name for the Downloader:

1. On the Downloads page, click the Setup Destination Share tab. 

2. Select the folder to share with others from the Destination Share list. 

3. Click Submit. 

Note: If no destination is selected, the download utility is disabled. For instructions on using the 
download utility, see “Downloader Features” on page 165.

Change Password

The Change Password tab allows you to change the Downloader’s password. 

To change the Downloader’s password:

Note: The default password is “downloader.” The user name is always “downloader.”

1. On the Downloads page, click the Change Password tab. 

2. Enter a password in the Change Password field. The maximum length of the 
password is 16, including alphabetic, numeric, underscore, space, and most 
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special characters except double-quote (“). The first and last characters cannot 
be a space. The password is case sensitive.

3. Re-enter the password in the Confirm Password field. 

4. Click Submit. 

Media Tab

The Media tab provides the Media Server and iTunes buttons. 

Note: The Media Server and iTunes® servers only work on the LAN.
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Media Server 

Note: It is not mandatory to access the Twonky Media server to search for or play media files as long 
as the file is in its respective media folder (videos, photos, or music).

The Twonky Media 5.1 server application searches for the media in the three shared 
folders (Videos, Photos, and Music) stored on the WD ShareSpace connected to 
your home network. The server is pre-set, so you can just transfer your multimedia 
content to the respective shared folders on your WD ShareSpace (described on the 
next page), and you are ready to stream and view content on your home 
entertainment center, game consoles (for example, Xbox 360, PlayStation 3, or DLNA 
1.5 Digital Media Adapters, such as WD TV™ Live HD Media Player) and other PCs 
on your home network. Visit www.twonkymedia.com for further information.

The first three items on the Twonky menu (PC MediaBrowser, Mobile MediaBrowser 
320*240, and Mobile MediaBrowser 240*320) allow you to browse through your 
shared multimedia files using your web browser or mobile device. If you would like to 
change the TwonkyMedia settings, click on the last item, TwonkyMedia Settings. For 
further information, visit www.twonkymedia.com.

 iTunes

Enable the iTunes Server and customize the service settings using the iTunes 
button. The iTunes Server allows iPod and iTunes users to share and play music on 
the WD ShareSpace. 

Note: iTunes service is enabled by default.

When the iTunes Server is enabled in the WD ShareSpace’s Network Storage 
Manager, you or anyone connected to the WD ShareSpace can use iTunes to play 
music files stored on it. The iTune Server creates a virtual music library on the device 
and treats it as an iTunes repository, making it possible for music files to stream from 
the WD ShareSpace to Windows or Mac computers running iTunes. 
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The iTunes Server Service supports only the following file types:

• *.mp3
• *.wav
• *.aac

Note: The iTunes server service requires the presence of the /Public/Shared Music share folder. Do 
not rename or delete Shared Music if you want to use the iTunes server. You must recreate or 
rename the /Public/Shared Music share if it has been deleted or given another name.

To enable or disable the iTunes Media Server:

1. On the iTunes Server, click Enable next to iTunes Service. Or, deselect the 
option to disable it. 

2. Specify how often iTunes will scan the device for new music files. 

3. Click Submit. 

To customize media library update frequency:

1. Select an option in the Check for new music every list. 

2. Click Submit.

To stream audio in iTunes:

1. Make sure that the iTunes Server is enabled in the WD ShareSpace’s Network 
Storage Manager.

2. Click WDShareSpace under the Shared section of the left pane. If you have 
copied music to the /Public/Shared Music folder and it is in a format supported 
by iTunes, it should be listed in the right pane.

3. Double-click an audio file. 
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The audio file is streamed in iTunes and audio files from the WD ShareSpace are 
displayed under Shared.

Note: Both the Media Server and the iTunes server only work on the LAN.

Users Tab

The Users tab provides access to the following configuration options:

• Users
• Groups
• Folder Share Permissions
• USB Share Permissions
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Users 

The Users button on the Users tab home page allows administrators to create, edit, 
and delete user accounts from Access Control list management. 

To create a new user account:

With this feature, you can create user accounts on the WD ShareSpace and further 
customize these accounts with privilege levels. 

1. On the Users page on the Users tab, click the Add icon . 

2. Click Grant Administration Rights to provide the user with administrative 
rights. Administration rights allow the user to configure the device.

Note: The password can contain up to 16 characters, including alphabetic, numeric, underscore, 
space, and most special characters except double-quote ("). The first and last characters cannot be 
a space. The password is case sensitive.

3. Enter the user name in the User Name field.

4. Enter the user’s full name in the Full Name field. 

5. Enter the password in the Password field.

6. Re-enter the password in the Confirm Password field. 

7. If desired, select a previously created Group for the user to join from the Group 
List. 

8. Click the >> button to add the selected user to the group. 

9. You may create a private user share at the same time by clicking Yes next to 
Create User Private Share. The new user is granted Full Access to the private 
share. The private share name is the same as the user name. Nobody else has 
access to this private share unless it is specifically granted by the administrator.

10.Select a volume that you want the user to access. 
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11.Select one or more file sharing protocols to access private shares. 

12.Click Submit. 

To modify a user account:

1. On the Users page on the Users tab, select the user account to modify, and then 
click the Modify icon . 

2. Make the desired changes, and then click Submit. 

To delete an existing user account:

1. On the Users page on the Users tab, click the Delete icon  next to the user 
account you want to delete.

2. Click OK.
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Groups 

The Groups button on the Users tab home page enables the administrator to create, 
edit, and delete a group from Access Control list management. 

To create a group:

1. On the Groups page on the Users tab, click the Add icon . 

2. Assign a new group name. 

3. Enter a description of the new group.

4. Select users from the User List field to add to the User Joined field. 

5. Click the >> button. 

6. Click Submit. 

To modify a group:

1. On the Groups page on the Users tab, select the group you want to modify, and 
then click the Modify icon . 

2. Make the desired changes, and then click Submit. 
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To delete a group:

1. On the Groups page on the Users tab, select the group you want to delete, and 
then click the Delete icon .

2. Click OK.

Folder Share Permissions 

The Folder Shares Permissions button on the Users tab home page enables you 
to set the access control for each user or group in the Access list. 

• Public Access 

• Full Access  

• Read Only  

• Deny Access  

• Not Assigned 

When there is a conflict in the access rights of the user and group, the WD 
ShareSpace uses the following rules to handle the conflict:

• Deny Access will have the highest priority. 
• Full Access + Read Only = Full Access. 

If the access control is assigned to users or groups, the full access, read only, and no 
access icons appear on the Share Access page. You can move your mouse over the 
icon to view the user or group list. 

To edit the access rights of users or groups:

1. Select a user or group on the Folder Shares Permissions page, and then click the 
Edit icon .

2. Click Enable next to Public Access to allow everyone to access to the share. 

3. Select an access option. 
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4. In the Unassigned Users list, select the users to whom you want to grant full 
access, read only permission, or no access to the share. 

5. Click the >> button.

6. In the Unassigned Groups list, select the local groups to which you want to 
grant full access, read only permission, or no access to the share. 

7. Click the >> button.

8. Click Submit.

Note: Public shares can be accessed using the administrator name and password as well as a guest 
name and password. The guest name and password are both “guest.” 
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USB Share Permissions 

The USB Shares button on the Users tab home page allows you to set access 
control for the two USB ports on the back of the device. 

The types of access control that you can assign to a user or group include: 

• Public Access 

• Full Access  

• Read Only  

• Deny Access  

• Unassigned  

When there is a conflict in the access rights of the user and group, the device uses 
the following rules to handle the conflict: 

• Deny Access will have the highest priority. 
• Full Access + Read Only = Full Access. 

If access control is assigned to users or groups, the full access, read only, and no 
access icons appear on the USB Share Permissions page. You can move your 
mouse over the icon to view the user or group list.

To edit the access rights of users or groups:

1. Select the share you want to modify by clicking the Edit  icon next to that 
share.

2. Click Enable next to Public Access to allow everyone to access the share. 

3. Select an access option. 

4. In the Not Assigned Users list, select the users to whom you want to grant full 
access, read only permission, or no access to the share. 

5. Click the >> button.
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6. In the Not Assigned Groups list, select the local groups to which you want to 
grant full access, read only permission, or no access to the share. 

7. Click the >> button.

8. Click Submit.
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Status Tab

The Status tab provides access to the following configuration options. 

• System Status
• System Logs

System Status 

The System Status button on the Status tab home page displays general 
information about the system: device name, version, current date/time, system 
uptime, IP address, volume usage, and volume RAID type if RAID is functioning 
properly. If RAID is not healthy, the RAID/Volume Usage field displays “failed.” 
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System Logs 

The System Logs button on the Status tab home page provides access to four 
tabs that display the events recorded by the system. You can view information such 
as file and services requested on the device and requests between the device and 
client computers. You can also change the order and number of the log entries 
shown on log pages. 

System

The System tab displays system logs on the device.

The System Logs record events that occur in the system. You can obtain information 
from the following conditions or errors that may occur in the system components and 
hardware or software components. 

• System shutdown
• System reboot
• Factory default restore failed
• System temperature warning
• Disk SMART failure
• Volume failed or does not exist
• Volume space is full or close to 100%
• Unsafe removal of a USB mass storage device
• Resync volume failed
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The following types of events are logged:

• Critical—An event such as fan failed, system temperature has exceeded the 
threshold level, Disk SMART failed, volume space is full or close to 100%, extend 
volume failed, or resync volume failed. When a critical event occurs the power/
system status LED lights up and the system record events in the System Log. 

• Warning—An event that is not necessarily significant, but may indicate a 
possible future problem. An email or pop-up message alert notifies the user of the 
problem in the system. 

• Information—An event that describes the successful operation of an 
application, driver, or service. 

CIFS

The CIFS (Common Internet File System) tab displays logs of file and services 
requested on the device for connections that use this protocol. 
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FTP

The FTP (File Transfer Protocol) tab displays logs of the requests and records 
transferred between the device and client computers for connections that use this 
protocol. 

Settings 

The Settings tab assigns the order and number of log entries that appear on the 
Logs page. 

To configure the log settings:

1. On the Settings tab, click Show log entries in reverse order to display the 
most recent entries at the top.

2. Enter the number of entries you want to appear on the System, CIFS, and FTP 
logs.
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Download Manager: Downloader

Downloader has two powerful tools for managing downloads directly to the unit: 
HTTP/FTP and CTorrent. These tools are great for when you want to download very 
large or multiple large files from the Internet and do not want to sit and wait for the 
download to complete. All you have to do is identify the file/torrent you want to 
download from the Internet and set it in the Download function on your WD 
ShareSpace. Then you can walk away and let these tools do the rest. All the files/
torrents that you want to download are saved directly to your WD ShareSpace, and 
you do not even need to have your computer on.

With a user-friendly interface, the Downloader supports multiple simultaneous 
downloads with various functions to manage downloads. Use Downloader to 
download files to the default share folder in the WD ShareSpace. If you choose not 
to use the default share folder, see “To set the destination share name for the 
Downloader:” on page 148.

Accessing Downloader

You can access Downloader by entering the system’s web-based user interface. See 
“Accessing WD ShareSpace’s Network Storage Manager” on page 92 for 
instructions. 

1. In the Tool list, click Downloader.

2. Enter “downloader” in both the Administrator Name and Password fields and 
click Login.

Note: You can change the password, but the administrator name is always “downloader.”

3. Select a language. (“English” is the default.)

4. Click Login.
11
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Downloader Features

Downloader includes the following features:

• Download faster with instantaneous “start”
• Download multiple files from the Internet simultaneously
• Automatically store files to a user-defined destination folder in 

WD ShareSpace
• Automatically store your partially downloaded files in the database to resume 

downloading at any time
• Set download speed to reduce bandwidth consumption 
• Schedule and queue downloads
• Resume downloading a partial download

User Interface Overview

The Downloader user interface includes two tabs—HTTP/FTP  and 
CTorrent. 

 HTTP/FTP Tab

 Clicking the HTTP/FTP tab reveals two buttons: Tasks and Settings. 

Tasks 

The Tasks button on the HTTP/FTP tab includes a table that displays the file 
transfer processes. The status of the file download is displayed using icons located 
on the File Name column and immediately below Submit. The status includes 
detailed information about the meaning of each status icon. 
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The command icons located on the right-side of the tasks table allow you to add 
download entries, stop file downloads, or delete download tasks.

Command Icons

The Tasks page includes the following commands:

To create a download task:

1. On the Tasks page, click the Add  icon.

2. Enter the full web address from which you want to download the file in the URL 
field. 

3. If a user name and password are required to download the file, click User name 
and password are required, and then enter the user name and password. 

4. If you want to enter a new name for the file, enter a new name in the Save As 
field. 

Icon Command Description

Add Creates a download task. 

Start Starts a specific download task. 

Stop Ends the download task. 

Delete Deletes download task from the table. 

Help Displays the online guide. 

Logout Exits the Downloader utility.
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5. Click Automatically to start downloading immediately after the request.

6. Click Submit. The task displays at the bottom of the list.

Note: The Scheduled Status field above the table on the right indicates whether the download 
was scheduled. See “Settings” on page 168 for information about scheduling tasks. 

To stop and resume a download task:

1. Select a task in the Tasks table. 

2. Click the Stop  icon to stop the download task. 

3. Click the Start  icon to resume the download task.

To delete a download task:

1. Select a task in the Tasks table. 

2. Click the Delete  icon to delete the download task.

3. Click OK, and then click OK again. 

4. Click Submit. 
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To change the order of the download queue:

1. Use the arrow buttons to change the order of download tasks or to make a task 
conditional on a previous task. 

2. Select a task in the Tasks table, and then click Move Up  or Move Down . 

3. Click Submit.

Settings 

The Settings button on the HTTP/FTP tab enables you to set the download speed 
and create and schedule several download queues. 

To customize the Downloader settings:

1. On the HTTP/FTP tab, click the Settings button to display the following page
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2. Select a number to specify the maximum number of simultaneously running 
downloads in the Max. Running No. field. 

3. Specify the integer value to limit the downloaded speed if you do not want to 
consume the entire available bandwidth in the Download Speed field. 

4. Set up the proxy in the Proxy field to download files if your network environment 
does not allow making direct connections to an external network. 

5. Click Enable next to Schedule to enable scheduled downloading time. The 
page expands:
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6. Select rows, columns, or individual days and times during which downloading is 
allowed. Selections display in yellow.

7. Click Submit.

Note: In the example above a schedule displays because Schedule was enabled. Specify the 
desired schedule and click Submit. 
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CTorrent Tab

CTorrent can be used for downloading and uploading large files among peers 
without the strain on their computers normally experienced with standard Internet 
transfers. The person downloading the file receives pieces of the file from multiple 
people who have downloaded the entire file (seeders) or have only part of the file. 

Note: If you wish to configure your router to forward CTorrent traffic to your WD ShareSpace, the 
CTorrent client uses TCP ports 2106 through 2706.

The CTorrent tab displays three buttons: Tasks, Settings, and Arrangement.

Tasks 

The Tasks button on the CTorrent tab displays information about each torrent and 
enables you to control torrent downloads.

To view a task:

1. Click the Tasks button on the CTorrent tab to display the following page:
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The Tasks page displays the following information about each torrent:

• Torrent name 
• File size 
• Progress of download 
• Download speed (KB per second)
• Upload speed (KB per second)
• Up/Down Ratio (A percentage that represents the amount of data uploaded 

divided by the amount of data downloaded.)
• Time Left
• Health

The following icons describe the status and details for each torrent.

Status: (connecting to tracker to start), (Incomplete & Downloading/Uploading 

(peer)), (Stopped & Complete), (Hash-Checking data), (Unable to Write to 

Disk/Unable to Hash-Check data),  (Connecting to Peers),  (Complete and 
Uploading (seed),  (Stopped & Incomplete) and  (Queued).

Details: The  icon provides detailed information about the selected torrent. Click  

to display three tabs with a summary of the torrent details, a list of files in the 
torrent, and the peers used to download/upload the torrent. 

To view a detailed summary:

1. On the Tasks page, click the  icon at the end of the torrent’s row.

2. Click the Summary tab to view a summary of details: 

It includes the following information about the torrent:

• File name

• Save location

• Total file size

• Progress of the download

• How much still needs to be downloaded
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• Progress of the download as a percentage

• Download rate (KB/s)

• Upload rate (KB/s)

• The amount of data downloaded so far

• The amount of data uploaded so far

To view information about the individual files in the torrent:

1. On the Tasks page, click the  icon at the end of the torrent’s row.

2. Click the Files tab to view information about the individual files in the torrent. The 
details include the percentage of the specified file downloaded and the size of 
each file.

To view information about the peers sharing torrent files with you:

1. On the Tasks page, click the  icon at the end of the torrent’s row.

2. Click the Peers tab to view information about the peers who are sharing torrent 
files with you and the percentage of the torrent they possess.
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To create a task:

Before adding a torrent, first locate it on the Internet and save the *.torrent file to your 
computer.

1. On the Tasks tab, click the  icon. The following page displays:

2. Browse your computer to locate the torrent file you saved from a torrent tracker 
on the Internet.

3. Click Submit. The task displays at the bottom of the task list.

To delete a task:

You can delete a download task, but the system does not delete it from the WD 
ShareSpace data volume where it is stored.

1. Select the task on the Tasks tab. 

2. Click the  icon.

To start and stop a task:

When you first add a task, you must start the download. You can stop and resume the 
download at any time.

1. To start a download, select it and click the  icon.

2. To stop a download, select it and click the   icon.
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Settings 

The Settings button on the CTorrent tab enables you to customize the amount of 
bandwidth used by a torrent download.

To customize CTorrent settings:

1. Click the Settings button on the CTorrent tab to display the following:

2. To set the speed of the download or upload, in the General Settings group:
(a) In Max DL Rate, enter the maximum rate at which the CTorrent should be downloaded 

(KB/sec). 

(b) In Max UL Rate, enter the maximum rate at which the CTorrent should be uploaded 
(KB/sec).

3. To automatically stop the download under specified conditions, in the Auto Stop 
CT Torrent Task group:
(a) To enable automatic stopping of the download under specified conditions, click the Enable 

check box.

(b) In Stop Criterion, select whether the download should automatically stop when one of the 
conditions is met or only when all conditions are met. 

(c) In Share Ratio, enter the ratio (percentage) of the download completed to the upload 
completed that will trigger an automatic stop. 

(d) In Seed Number, enter the number of peers who have downloaded the entire file that will 
trigger an automatic stop.

(e) In Seeding Time, enter how much longer after you have the entire file the download should 
stop.

4. Click Submit. 
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Arrangement  

The Arrangement button on the CTorrent tab enables you to prioritize your 
downloads. The position of a torrent in the list determines its priority.

1. Click Arrangement on the CTorrent tab to display the following: 

2. To change priority for a torrent, click the radio button next to it.

3. Click Move Up or Move Down to change its position in the list.

4. Repeat for any other torrents, as desired. 

5. Click Submit to apply the changes.
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Replacing a Drive
WD ShareSpace is a limited user-serviceable product which allows replacement of 
any or all internal hard drives in the enclosure. 

Important: The WD ShareSpace enclosure is designed to support only 
WD Caviar® Green™ hard drive assemblies. Visit support.wdc.com and 
search the knowledge base article 2569 for detailed instructions on 
obtaining a replacement drive for this product. Use only WD hard drive 
assemblies of the same size or your warranty will be voided.

An amber LED on the front of the drive denotes a faulty drive. For more information on 
LEDs, see page 9. For more information on drive status, do the following:

1. Open WD Discovery and select the unit.

2. Click Configure and log in.

3. Click the Advanced view and then click the Storage tab.

4. Click the Disk Management button. The “Unassigned” drive is the defective 
one. Note the drive number for reference if you need to replace a drive.

In the event a fault occurs and you would like to service the device yourself, visit 
WD Technical Support at support.wdc.com and search the knowledge base 
article 2569 for detailed instructions on obtaining a replacement drive. When 
contacting Technical Support, have the following items ready: serial number of 
the device, date of purchase, and the serial number of the internal hard drive(s) 
which require replacement. Once you have received the replacement drive(s), 
follow the steps below to service the WD ShareSpace.

Before getting started, power off the unit and disconnect all of its cables. 

ESD precautions

Electrostatic discharge (ESD) can damage the processor, disk drives, mainboard, 
memory modules, and other notebook components. Always observe the following 
precautions before you install a hard drive.

• Do not remove a component from its protective packaging until you are ready to 
install it.

• Do not touch the component pins, leads, or circuitry.
• Wear a wrist grounding strap and attach it to a metal part of the computer before 

handling components. If a wrist strap is not available, maintain contact with the 
computer throughout any procedure requiring ESD protection.

• Keep the work area free of nonconductive materials, such as ordinary plastic 
assembly aids and foam packing.

To replace an internal drive:

1. Turn off the system.

2. Unplug all cables from the power outlets.
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REPLACING A DRIVE - 177

http://support.wdc.com
http://support.wdc.com


WD SHARESPACE
USER MANUAL
3. Place the enclosure on a flat, stable surface. 

4. Observe ESD precautions when handling a system component.

5. Remove the system cover. 
(a) Loosen the two captive screws on the rear of the system cover.

(b) Slide the cover towards the back of the system until the tabs on the cover disengage from the 
slots on the unit.

(c) Lift the cover to remove it, and then set it aside. 

Note: The drive number is stamped to the left of the drive.

6. Remove the failed drive from the drive bay.

WARNING! When pulling out the hard drive (as was listed) using the 
mounting rails handle, use your hand to support it from underneath so it 
does not fall. 

(a) Pull on the center of the mounting rails handle and move the assembly from side to side to 
disengage the side latches. Carefully slide the drive out 1 inch from its bay. 
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(b) While pulling out the drive assembly with one hand, use your other hand to support the drive 
while sliding it out of the enclosure. 

7. Remove the drive carrier.
(a) Flex the back pin of the side rail from the hard drive and gently pull the side-rail away from the 

hard drive. 

(b) Remove the drive from the drive carrier. 

8. Remove the new hard drive from its packaging. 

9. Install the new drive into the drive carrier.
(a) Insert the new drive into the drive carrier. 

(b) Flex the left and right-side rail and insert the pins into the drive’s mounting holes. 
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10.Slide the drive carrier all the way into the drive bay, and then push directly on 
the drive (not on the mounting rails) until the assembly latches securely into 
place and you hear a click. 

11.Replace the system cover. 
(a) Carefully place the system cover on the unit so that the tabs on the cover align with the slots 

on the unit. 

(b) Slide the cover toward the front of the unit until it is fully closed. 

(c) Tighten the captive screws on the rear of the unit. 

12.Reconnect the cables and power on the unit. 

13.The drive starts the rebuild process automatically. The RAID rebuild may take up 
to 34 hours depending on RAID mode and drive capacity and activity. See the 

graphic in “Volumes and RAID Management” on page 133.

Note: For RAID modes other than RAID 1, RAID 5, and RAID 10, data cannot be accessed until the 
rebuild is complete.

14.Once the rebuild is complete, the power LED will change from flashing green to 
steady green.

15.Connect the interface cable and set up the new drive for RAID configuration (for 
related instructions, refer to “Manage RAID” on page 136).
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16. If the faulty drive is within the warranty period, contact WD Technical Support for 
instructions on returning the drive.

Important: Do not disassemble the internal drive. Return the entire internal 
drive intact to WD.
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Troubleshooting
For any issue, first ensure that you are using the latest firmware for WD ShareSpace. 
The latest firmware includes the latest network and SATA disk drivers. See “Update 
(Firmware)” on page 114 for instructions.

First Steps Checklist
• AC power available at the wall outlet?
• Is the power supply plugged in?
• Check the DC cable(s) on the back of the chassis and the AC source.
• Check the cable from the wall to the power supply and the cable from the power 

supply to the chassis.
• Are all cables correctly connected and secured?
• Are all peripheral devices installed correctly?
• Are all device drivers properly installed?
• Did you press the power button on the front panel to turn the device on (power 

indicator should be lit)?
• Is the power cord properly connected to the device and plugged into an outlet for 

100-127 V or 200-240 V?

Resetting the WD ShareSpace 

To reset the system using the reset button:

If you have forgotten your password, or if the network is misconfigured, pressing the 
reset button while the device is powered up resets the admin user name and 
password and IP settings to the default values without erasing shared folders or 
volumes. Follow the instructions below to reset the device using the recovery button.

WARNING! Do not move the unit while it is turned on.

1. Carefully turn the device around so that you have access to the back of the unit.

2. Ensure that the device is powered on and that the LAN connection at the back of 
the device is active (designated by a green light).

3. Locate a single, small opening in the back of the device just above the power 
connector. The reset button is inside this opening. 

4. Insert the end of an unfolded paperclip into the opening, and then press and hold 
the reset button with the paperclip end. (Do not release the button.)
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5. Continue holding the reset button for about seven seconds until the HDD LEDs 
on the front panel light up. After 14 seconds, the HDD LEDs turn amber.

6. Release the reset button by removing the paperclip. The device will automatically 
reboot.

The reset operation is complete when the device has rebooted and the LAN 
connection lights and HDD LEDs are on. A successful reset results in restoring 
the device name, IP address, admin user name, and admin password to factory 
default (WDShareSpace, DHCP client, admin and admin). 

Note: The default user name and password is admin.

To reset the system to factory default settings:

Performing a factory default reset using the WD ShareSpace’s Network Storage 
Manager erases all settings, shares, and data files in the WD ShareSpace. All 
information and data is lost. For detailed instructions, see “To restore the device 
to factory defaults:” on page 119.

Hardware Diagnostic Testing

This section provides a detailed approach to identifying a hardware problem and 
locating its source.

CAUTION! Before disconnecting any peripheral cables from the system, turn off the WD 
ShareSpace and any external peripheral devices. Failure to do so can cause permanent damage to 
the WD ShareSpace and/or the peripheral device.

1. Turn off the WD ShareSpace and all external peripheral devices. 

2. Make sure the power cord is plugged into a properly grounded AC outlet.

3. Turn on the device. If the power indicator on the front panel does not light, see 
“Power indicator does not light.” on page 184.
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Specific Problems and Corrective Actions

The following contains specific problems that may arise during the use of your server. 
Possible solutions are listed for each problem. 

Power indicator does not light.

Do the following:

• Make sure the power button on the control panel is turned on. 
• Make sure the power cord is connected correctly. 
• Make sure that the wall outlet has power. Test it by plugging another device. 
• Press the power button. (See “Power Button” on page 8.)

HDD activity indicator does not light.

If the drives are pre-installed, contact WD Technical Support (support.wdc.com). 
Make sure that WD hard drives are installed in the WD ShareSpace.

System cannot connect to a network and network status indicator does not light.

• Make sure the network cable is securely attached to the correct connector on the 
rear panel of the device.

• Try a different network cable.
• Make sure the network switch or router has power. 

Do the following:

• Check the cabling and network equipment to make sure that all cables are 
properly connected.

• Try another port on the switch.

Can I use USB auto backup to back up a USB drive with multiple partitions to the device?

Yes, but only data stored on the first partition of a USB drive connected to the front 
port is backed up to the WD ShareSpace.

WD ShareSpace’s Network Storage Manager does not appear when I click Configure in WD 
Discovery.

Make sure JavaScript is enabled in your browser. See your browser’s Help menu for 
instructions.
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I received a banner warning message, email alert, or pop-up screen indicating a failed volume.

Do the following:

1. Verify hard drive status in the Disk Manager submenu. See “Disk Manager” on 
page 132. If the status of any drive is “Failed,” visit WD Technical Support at 
support.wdc.com and search the knowledge base article 2569 for detailed 
instructions on obtaining a replacement drive.

2. If Disk Manager does not indicate that a hard drive has failed, power cycle the 
device.

3. If the volume that failed is a new volume, try rebuilding the RAID array. See 
“Manage RAID” on page 136 for details. If this does not resolve the problem, visit 
WD Technical Support at support.wdc.com and search the knowledge base 
article 2569 for detailed instructions on obtaining a replacement drive.

My router has failed or is not available. How do I access my data in the device?

Do the following:

1. Connect the device directly to the computer's Ethernet port. 

2. Launch WD Discovery Tool and see “Mapping a Network Drive” on page 79 for 
instructions on how to access data in the device.

I received the message “iTunes server cannot find the path to Shared Music.”

The iTunes server requires the presence of the /Public/Shared Music share folder. 
Do not rename or delete Shared Music if you want to use the iTunes server. You must 
recreate or rename the /Public/Shared Music share if it has been deleted or the name 
has been changed.
TROUBLESHOOTING - 185

http://support.wdc.com
http://support.wdc.com


WD SHARESPACE
USER MANUAL
 How do you map the drive letter without WD Discovery Tool?

Do the following:

1. Double-click My Computer.

2. Click My Network Places.

3. On the Tools menu, point to Map Network Drive.

4. In the Folder drop-down list, select \\device name\public. 

5. Click the Finish button.You will be prompted to log in to the share.

6. Go back to the opening window of My Computer to view the public folder of 
your device under Network Drives.

I cannot start WD Discovery to access the configure feature.

Do the following:

1. Click Start>Run.

2. Type \\WDShareSpace, and then click OK (if the device name was changed, type 
\\yournewdevicename).

3. The WD ShareSpace directory appears (Public, Configuration, and Download 
folders). Double-click the Configuration folder.

4. Double-click index.htmf The configuration login page appears.

I want to install Windows drivers on my Windows Vista/Windows 7 computer without access to 
Windows update:

1. Insert the WD ShareSpace CD.

2. Click Start>Computer and right-click the WD ShareSpace CD icon.

3. Click Open>WD_Windows_Tools>WD_Rally_Drivers>PnpxNas-4NC. 
Right-click PnPxNas-4NC.inf and click Install.
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I am unable to play music, videos, or view pictures through my digital media adapter.

The media adapter requires the presence of the /Public/Shared Music /Public/
Shared Pictures and /Public/Shared Videos share folder. Do not rename or delete 
the shared folders if you want to use the media adapter. You must recreate or rename 
the share if it has been deleted or named something else.

Because there are many kinds of file formats for pictures, videos and music, your 
particular digital media adapter may not support a format to play or display it. 
Depending on the digital media adapter device (for example, Xbox, PlayStation 3, 
Windows, and Media Center) that you have, you may need to update your device 
with the proper CODECs to support the media format that you want to play. Please 
refer to your digital media adapter’s user manual for further information of how to 
locate and update CODECs.

System Events

The following table describes the event types that are recorded in the system log. 

Event type and 
Event ID

Event 
state

Event 
value

Critical Warning

System events

Startup [none]

Abnormal Shutdown [none]

Shutdown [none]

Reboot [none]

Software Update Succeeded Version

Software Update Failed

Factory Default Succeeded

Configuration Restore Succeeded

Configuration Restore Failed

iTunes Directory Not Exist

Fan thermal events

Fan 1 Normal RPM

Fan 1 Failed*

Thermal 1 Normal Degrees

Thermal 1 Exceeded the threshold (Overheated) Degrees

HDD SMART events

HDD [1,2,3,4] HDD SMART OK

HDD [1,2,3,4] HDD SMART fail

Volume events

Volume [1,2]

Volume [1,2] RAID volume in normal mode
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Volume [1,2] RAID volume in degraded mode

Volume [1,2] RAID(0,1,5) volume resyncing Progress

Volume [1,2] Sent if volume could not be recovered

Volume [1,2] Volume doesn't exist

Volume [1,2] Volume created

Volume [1,2] Volume deleted

Volume [1,2] Volume modified

Volume usage events

Volume [1,2]

Volume [1,2] Volume has 25~100% free capacity

Volume [1,2] Volume has more than 10% free 
capacity

Volume [1,2] Volume has more than 5% free 
capacity

Volume [1,2] Volume has reached 80% capacity

Volume [1,2] Volume has reached 95% capacity

Volume [1,2] Volume has reached full capacity

Volume [1,2] Volume had NOT been mounted

Network events

LAN 1 Link Ok Speed 
(Mbps: 
1000/
100/10)

LAN 1 Link down

LAN 1 Use dynamic IP address got from 
DHCP

IP 
address

LAN 1 Can not get IP address from DHCP, 
use default

IP 
address

LAN 1 Use static IP address IP 
address

USB events

USB [1] One-touch backup to external drive 
did not finish because external drive is 
full

USB [1,2,3] USB drive insertion

USB [1,2,3] USB drive safely removed

USB [1,2,3] USB drive unsafely removed

USB [1,2,3] USB drive format OK

Event type and 
Event ID

Event 
state

Event 
value

Critical Warning
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* A fan failed event is issued when the device temperature is greater or equal to 40°C (104°F).

USB [1,2,3] USB drive format fail

User events

[User ID] User quota is normal

[User ID] User quota reached 90%

[User ID] User quota is full

[User ID] User created

[User ID] User deleted

[User ID] User modified

Group events

[Group ID] Group created

[Group ID] Group deleted

[Group ID] Group modified

Other events

Volume [1,2] Volume extend failed

Volume [1,2] Volume resync failed

Event type and 
Event ID

Event 
state

Event 
value

Critical Warning
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Glossary
CIFS: Common Internet File System. The recommended file sharing protocol for 
Windows platform allows users to access shares through My Network Places. Mac 
OS X or later also supports the CIFS protocol. See also Protocol.

CTorrent: A computer program for downloading and uploading large files among 
peers without the strain on their computers normally experienced with standard 
Internet transfers. The person downloading the file receives pieces of the file from 
multiple people who have downloaded the entire file (seeders) or have only part of 
the file.

DHCP: Dynamic Host Configuration Protocol. A protocol for assigning IP addresses 
to devices on a network. With dynamic addressing, a device can have a different IP 
address each time it connects to the network. In some systems, the device's IP 
address even changes while it is still connected. DHCP also supports a mix of static 
and dynamic IP addresses. See also Protocol.

DLNA: Digital Living Network Alliance. The group of consumer electronics, 
computing industry, and mobile device companies that sets standards for product 
compatibility, thus enabling users to share content in their home.

DMA: Digital Media Adapter. A device that gives home entertainment devices the 
ability to transfer media such as music, photos, videos to and from other devices over 
the network.

DNS: Domain Name Service. A system that allows a network name server to 
translate text host names into numeric IP addresses used to uniquely identify any 
device connected to the Internet.

ESD: Electrostatic discharge.

Ethernet: A standard method of connecting computers to a Local Area Network 
(LAN) using coaxial cable.

Extended Partition: A partition on a disk where non-system files (other than DOS 
or operating system files) can be stored. Multiple partitions can be created on a hard 
disk: one primary partition and one or more extended partition(s). Operating system 
files must reside on the primary partition; logical drives can be created on an 
extended partition.

FAT: File Allocation Table. A data table stored at the beginning of each partition on a 
disk and used by the operating system to determine which sectors are allocated to 
each file and in which sequence.

FAT32: A file allocation table system with a maximum file transfer of 4 GB and a 
maximum partition size of 32 GB.

File Transfer Protocol (FTP): A network protocol used to transfer data from one 
computer to another through a network. FTP is a popular choice for exchanging files 
independent of the operating systems involved.
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GreenPower™ Technology: Engineering technology developed by WD to bring 
more energy-efficient hard drive options to our customers. WD hard drives with 
GreenPower technology yield average power savings of 4-5 watts over competitors' 
drives while maintaining solid performance. 

Host: The computer to which other computers and peripherals connect. 

Host Adapter: A plug-in board that acts as an interface between a computer 
system bus and a hard drive.

Host Interface: The point at which a host and a drive are connected to each other.

Host Transfer Rate: The speed at which a host computer can transfer data across 
an interface.

HTTP: Hypertext Transfer Protocol. Protocol used by the World Wide Web to 
transfer information between servers and browsers. See also Protocol.

HTTPS: Hypertext Transfer Protocol over Secure Socket Layer. A protocol that 
provides a more secure means of configuring your device than HTTP, but may affect 
the responsiveness of the user interface. All traffic between the managing computer 
and the WD ShareSpace is encrypted. See also Protocol.

Hub: In a network, a device joining communication lines at a central location, 
providing a common connection to all devices on the network.

Identity LED: Indicates which WD ShareSpace in the network is currently being 
accessed via WD Discovery. 

Interface: A hardware or software protocol to manage the exchange of data 
between a device and a computer; the most common ones are EIDE (also known as 
PATA), SATA, and SCSI. See also Protocol.

IP: Internet Protocol. A system that controls how data messages are separated into 
packets, routed from the sender, and reassembled at the destination. See also 
Protocol.

IP address: A 32-bit, binary number that uniquely identifies a computer connected 
to the Internet.

LAN: Local Area Network. A system in which computer users in the same company 
or organization are linked to each other and often to centrally-stored collections of 
data in LAN servers.

LED: Light-emitting Diode. An electronic device that lights up when electricity is 
passed through it.

Media Server: Device that stores and shares media files (digital audio, digital video, 
and digital photos).

Media Storage: Device that stores media files (digital audio, digital video, and 
digital photos).

Memory: A device or system capable of storing and retrieving data.
GLOSSARY - 191



WD SHARESPACE
USER MANUAL
MioNet: WD remote computer access service. Adding MioNet to your home or work 
computer allows you secure and instant access from any PC in the world back to 
your computer. You can use your applications and access and share files on your 
computer or storage device from anywhere. 

Mirroring: The process of generating an exact copy of saved data from one drive to 
another drive within a RAID 1 system. Each drive can be accessed and read 
separately. A mirrored drive can be removed from a system while the other drive(s) 
are still active. See also RAID 1.

MP3: MPEG-audio layer 3. A digital audio coding scheme for distributing music over 
the Internet.

Multi-user: A system in information technology that enables more than one user to 
access data at the same time.

NAS: Network Attached Storage. Hard disk storage that is set up with its own 
network address rather than being attached to the computer that is serving network 
workstation users.

NAT: Network Address Translation. Used in gateway devices that form the boundary 
between the public Internet and the private LAN. As IP packets from the private LAN 
traverse the gateway, NAT translates a private IP address and port number to a public 
IP address and port number, tracking those translations to keep individual sessions 
intact. 

Network Computer: A computer that communicates with a central data storage 
facility such as a server or RAID system.

NFS: Network File System. A network file system protocol that allows a user on a 
client computer to access files over a network as easily as if the network devices 
were attached to its local disks. Normally associated with UNIX systems. See also 
Protocol.

NTFS: NT File System. A file system, designed for Windows® NT, that supports long 
filenames, security access control, recovery, and other features.

NTP: Network Time Protocol. A protocol for synchronizing the clocks of computers 
and equipment over a network. See also Protocol.

Operating System: Software that allows users and programs installed on your 
system to communicate with computer hardware such as a hard drive.

Partition: A logical division on a hard drive that the operating system treats as a 
separate hard drive. Each partition is assigned a unique drive letter.

Port (Hardware): A specialized outlet on a device for connecting to other devices 
using a cable or a plug. Ethernet ports, power ports, and USB ports are examples.

Protocol: A convention of data transmission that defines timing, control format, and 
data representation.

RAID: Redundant Array of Independent Disks. A grouping of hard drives in a single 
system to provide greater performance and data integrity.
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RAID 0: RAID protocol in which data is striped across multiple hard drives, enabling 
the accelerated reading and recording of data by combining the work of two or more 
drives to increase performance. See also Striping.

RAID 1: RAID protocol in which two copies of the data are instantaneously 
recorded: each on separate hard drives. RAID 1 ensures the protection of users' data 
because in the event that one of the hard drives fails, the other hard drive(s) will 
continue to read and write data until the faulty hard drive is replaced and rebuilt to 
once again safely mirror the data. See also Mirroring.

RAID 5: For systems with three or more drives, RAID 5 offers fast performance by 
striping data across all drives. It protects data by dedicating a quarter of each drive to 
fault tolerance, leaving three quarters of the system capacity available for data 
storage.

RAID 10: RAID protocol that requires a minimum of four drives to implement. Adds 
redundancy and fault tolerance, providing data striping on top of disk mirroring. 

RAM: Random Access Memory. Memory that allows any storage location to be 
accessed randomly, as opposed to sequential access devices such as tape drives.

ROM: Read-Only Memory. An integrated circuit memory chip containing programs 
and data that the computer or host can read but cannot modify. A computer can read 
instructions from ROM but cannot store data in ROM.

Share: A folder that can be used to organize and store files on your WD 
ShareSpace. Shares can be shared with everyone (public) or with selected users on 
your network (private).

SMB: Server Message Block. File-sharing protocol for Windows platform that allows 
users to access shares through My Network Places. Mac OS X or later also supports 
the CIFS protocol. See also Protocol.

SMTP: Simple Mail Transfer Protocol. Standard for transferring email across the 
Internet. See also Protocol.

Spanned: Combines drives in a linear fashion to create one large logical volume. A 
spanned drive is like a single, bigger drive, in that files written to the volume earlier go 
to the “beginning” of the volume, on the first physical drive. If one of the drives fails, all 
data is lost. 

SSH: Secure Shell. A network protocol that uses encryption and authentication keys 
to enable two devices on the network to exchange data securely. See also Protocol.

SSL: Secure Socket Layer. A protocol that provides authentication and encryption 
services between a web server and a web browser. See also Protocol.

Streaming Media: Media such as audio, video, and photos that are constantly 
received while being delivered by a streaming provider.

Striping: The spread of data over multiple hard drives to improve performance. See 
also RAID 0.
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TCP/IP: Transmission Control Protocol/Internet Protocol. A set of protocols for 
communication over interconnected networks. The standard for data transmission 
over networks. See also Protocol.

TLS: Transport Layer Security. Successor to SSL. See also SSL.

Two Mirror Mode: Two Mirror mode is available when four drives are installed in a 
device. In this mode, two independent RAID 1 volumes are created.

Twonky Media Server:  A server application that searches for all the media (for 
example, videos, photos, and music) stored on the WD ShareSpace connected to 
your home network. 

UPnP: Universal Plug n Play. A set of computer network protocols that simplify the 
implementation of networks in the home by allowing devices to connect seamlessly. 
See also Protocol.

UPnP NAT Traversal: Combines UPnP and NAT features. 

UPS:  Uninterruptable Power Supply. A standalone device that provides secondary 
power to connected equipment in the event of a power failure.

USB:  Universal Serial Bus. A serial bus for connecting peripherals to a 
microcomputer. It connects external drives, printers, modems, mice, keyboards, etc., 
through a single, general-purpose port. It can automatically add and configure new 
devices without having to shut down and restart the system.

USB 2.0: For most PCs, the standard interface is USB. Hi-Speed USB (USB 2.0) 
supports data transfer rates up to 480Mb/s. USB 2.0 is backward-compatible with 
USB 1.1.: If you connect to a USB 1.1 device, data is transferred at USB 1.1 speed 
(up to 
1.1 Mb/s).

WAN: Wide Area Network. A computer network that crosses metropolitan, regional, 
or national boundaries.

WD Anywhere Backup: WD backup software that allows the user to set up 
continuous backup of all or selected files for up to five computers in a network. This 
feature backs up your data to the WD ShareSpace so you can restore your data in 
the event that a computer’s hard drive crashes. 

WD Discovery: WD software application that allows the host computer to find one 
or more WD network storage systems in the same network segment.
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Appendix

Regulatory Compliance

FCC Class B Information
This device has been tested and found to comply with the limits of a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This unit generates, uses,
and can radiate radio frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio or television reception. However, there
is no guarantee that interference will not occur in a particular installation. Any changes or
modifications not expressly approved by WD could void the user's authority to operate this
equipment.

The following booklet, prepared by the Federal Communications Commission, may be
helpful: How to Identify and Resolve Radio/TV Interference Problems. This booklet is Stock
No. 004-000-00345-4 available from the US Government Printing Office, Washington,
DC 20402.

The provided Ethernet cable must be used between the unit and network connection to
comply with FCC Part 15 Class B and EN-55022 Class B.

ICES/NMB-003 Compliance
Cet appareil de la classe B est conforme à la norme NMB-003 du Canada.

This device complies with Canadian ICES-003 Class B.

Safety Compliance
Approved for US and Canada. CAN/CSA-C22.2 No. 60950-1, UL 60950-1: Safety of
Information Technology Equipment.

Approuvé pour les Etats-Unis et le Canada. CAN/CSA-C22.2 No. 60950-1 : Sûreté
d'équipement de technologie de l'information.

This product is intended to be supplied by a listed limited power source, double insulated, or
direct plug-in power unit marked “Class 2.”

CE Compliance for Europe
Verified to comply with EN55022 for RF emission;  EN-55024 for Generic Immunity, as
applicable; and EN-60950 for Safety.
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Environmental Compliance (China)

Warranty Information

Obtaining Service
WD values your business and always attempts to provide you the very best of service. If this
Product requires maintenance, either contact the dealer from whom you originally purchased
the Product or visit our product support website at support.wdc.com for information on how
to obtain service or a Return Material Authorization (RMA). If it is determined that the Product
may be defective, you will be given an RMA number and instructions for Product return. An
unauthorized return (i.e., one for which an RMA number has not been issued) will be returned
to you at your expense. Authorized returns must be shipped in an approved shipping
container, prepaid and insured, to the address provided on your return paperwork. Your
original box and packaging materials should be kept for storing or shipping your WD product.
To conclusively establish the period of warranty, check the warranty expiration (serial number
required) via support.wdc.com. WD shall have no liability for lost data regardless of the
cause, recovery of lost data, or data contained in any Product placed in its possession.

Limited Warranty
WD warrants that the Product, in the course of its normal use, will be free from defects in
material and workmanship for a period of three (3) years, unless otherwise required by law,
and will conform to WD’s specification therefor. This limited warranty period shall commence
on the purchase date appearing on your purchase receipt. WD shall have no liability for any
Product returned if WD determines that the Product was stolen from WD or that the
asserted defect a) is not present, b) cannot reasonably be rectified because of damage
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occurring before WD receives the Product, or c) is attributable to misuse, improper
installation, alteration (including removing or obliterating labels and opening or removing
external enclosures, including the mounting frame, unless the product is on the list of limited
user-serviceable products and the specific alteration is within the scope of the applicable
instructions, as found at support.wdc.com, accident or mishandling while in the possession
of someone other than WD. Subject to the limitations specified above, your sole and
exclusive warranty shall be, during the period of warranty specified above and at WD’s
option, the repair or replacement of the Product. The foregoing warranty of WD shall extend
to repaired or replaced Products for the balance of the applicable period of the original
warranty or ninety (90) days from the date of shipment of a repaired or replaced Product,
whichever is longer.

The foregoing limited warranty is WD’s sole warranty and is applicable only to products sold
as new. The remedies provided herein are in lieu of a) any and all other remedies and
warranties, whether expressed, implied or statutory, including but not limited to, any implied
warranty of merchantability or fitness for a particular purpose, and b) any and all obligations
and liabilities of WD for damages including, but not limited to accidental, consequential, or
special damages, or any financial loss, lost profits or expenses, or lost data arising out of or in
connection with the purchase, use, or performance of the Product, even if WD has been
advised of the possibility of such damages. In the United States, some states do not allow
exclusion or limitations of incidental or consequential damages, so the limitations above may
not apply to you. This warranty gives you specific legal rights, and you may also have other
rights which vary from state to state.

GNU General Public License (“GPL”)
Firmware incorporated into WD ShareSpace includes third party copyrighted software
licensed under the GPL (“GPL Software”). In accordance with the GPL: 1) the source code
for the GPL Software may be obtained at support.wdc.com/download/gpl; 2) you may re-
use, re-distribute and modify the GPL Software; 3) with respect solely to the GPL Software,
it is provided “as is” without warranty of any kind, either expressed or implied, including, but
not limited to, the implied warranties of merchantability and fitness for a particular purpose, to
the extent permitted by applicable law; and 4) a copy of the GPL is included on the enclosed
CD, may be obtained at www.gnu.org, and may also be found at support.wdc.com/
download/gpl.

When contacting WD for support, have your WD product serial number, system hardware,
and system software versions available.
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Index
A
active directory service    128
admin login password, change    114
ADS    128
audio streaming in iTunes    151
auto backup    76

B
backup

automatic and complete    29
logs    44

backup button    10
backup data

system to USB hard drive    78
USB hard drive to system    77

backup plan
customize    32
edit    42
icons    42
remove    44
restore    40

C
CE compliance    195
change password

admin login    114
Downloader    148

China RoHS    196
compliance, regulatory    195
configuration menu    118
contacts    1
Copy Manager    176
CTorrent client    171
customized backup plan    32

D
data backup    76
DataVolume    147
date & time    98
deleting a backup plan    44
destination share setup    144
device name    97
digital media adapter    73
digital picture frames    72
disk manager    132
DLNA media device    73
DNS    124
domain membership    108
Domain Name Service    124
domain setup    99
download queue, change order of    168
download task, create    166
Downloader

access    164
command icons    166
configure settings    168
destination share    148
features    165
password change    148
torrents    171
UI overview    165

drive format    3
drive replacement    177

E
e-mail notifications, setup    112
environmental compliance, China    196
ESD precautions    177
Europe, CE compliance    195
extend disk mode    121

F
FCC    195
file sharing protocols    141
file storage    4
firmware update    114
folder shares    139
format and configuration overview    3
FTP access    127

G
general system setup    109
getting started    5
glossary    190
GNU general public license    197
GPL software    197
group account

assign access rights    156
create    155

H
hardware connections    11
HDD standby    122

I
ICES/NMB-003 compliance    195
icons, C-Torrent    172
indicator lights (LEDs)    9
installation    7
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iTunes server service    150
enable    151
streaming audio    74,    151

K
kit contents    6

L
LAN submenu    124
laptop backup    23
LEDs    9
limited warranty    196
logs

settings    163
system    161

M
Macintosh

access WD ShareSpace    26
install WD Anywhere Backup    28

Macintosh Leopard    18
manage RAID

configure    138
options    139

manage volumes    133
Media    150
media

devices    67
iTunes    150
storage    66
types supported    65

media player, WD TV Live HD    67
media server    150
MioNet

access files    59
remote access setup    55
share files    59
share photos    59
transfer files    62

MioNet Web    58

N
network

LAN    124
services    125
shares    23

network drive mapping    79
network mode    99
network music player    73
network service, enable    127
network settings    124
network shares    82
Network Storage Manager    87

access    92
access on the Mac    93
access on Windows    93
advanced mode    108
basic mode    96
features    94
media settings    149
network setup    124
status settings    160
storage setup    131
system setup    109
toolbar    96
UI overview    95
use    87
users settings    152

O
obtaining service    196
one-click backup    28

P
password

administrator    114
Downloader    148

permissions
folder share    156
USB shares    157

pop-up message alert, setup    113
ports    10
power button    8
pre-installation requirements    7
product registration    2

Q
quota configuration    146

R
RAID

levels    137
management    133
options    139

reboot    107
recovery button    182
registration

MioNet    56
product    2
WD Anywhere Backup    30

regulatory compliance    195
remote access with MioNet    55
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replacing a drive    177
reset button    10
restore    118

backup plan    40
save configuration settings    119
system to factory defaults    119

RoHS    196

S
safety compliance    195
safety instructions    2
security slot    10
shares

access data    82
browse    82
create    103,    140
delete    104

shortcut creation    83
shutdown/reboot    107
software, GPL    197
source share    145
specifications    5
SSH    120
SSL    121
status logs    162,    163
storage

disk manager    132
downloads    148
folder shares    139
quota    145,    147
USB shares    145
volumes    133,    136

system
admin password    114
advanced    120
alerts setup    111
configure    118
general system setup    109
remote access    130
restart    123
restore    118
restore configuration settings    119
save configuration settings    118
update firmware    114
UPS    122

system events specification    187
system logs    161
system logs records

event types    162
system requirements    6
system status    104
system tour
LED indicators    11

system view    8

T
troubleshooting

checklist    182
hardware diagnostic testing    183
problems

cannot connect to a network    184
cannot start configuration    186
digital media adapter not working    187
failed volume    185
HDD LED no light    184
iTunes not finding path    185
LAN LED no light    184
Network Storage Manager not appearing    184
no video    184
power indicator no light    184
router failed    185

reset the system    182
Twonky Media server    150

U
UL    195
Underwriters Laboratories Inc.    195
uninterruptable power supply    122
UPnP NAT Traversal    127
UPS service    122
USB hard drive

disconnect    143
format    143
USB sharing    76

USB shares    142
user account

assign privilege    156
create    101,    153
delete    154
modify    154

users
folder share permissions    156
folder shares    156
groups    155
USB shares    157

Using    58

V
volumes

delete    135
manage    135
modify    134
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W
warranty    196
WD    184
WD Anywhere Backup configuration    28
WD Discovery buttons

Browse Network Shares    82
Configure    88
Create Desktop Shortcut    83
Map Network Drives    79
Turn On/OFF Identify LED    84

WD service    196
WD ShareSpace configuration    87
WD TV Live HD Media Player    67
Windows

configure MioNet    55
install WD Anywhere Backup    23

Windows Media Player    67
workgroups    128
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	WD ShareSpace Basic Setup
	Step 1: Connect WD ShareSpace to the Network
	1. Connect one end of the Ethernet cable into the Ethernet port located on the back of the device. Connect the other end of the Ethernet cable directly into a router or network switch port.
	2. Connect the end of the adapter into the DC power supply socket located on the back of the device.
	3. Plug the AC adapter into a power outlet. After approximately 30 seconds, the unit powers up automatically as indicated by a steady green LED illuminated on the power button.

	Step 2: Access WD ShareSpace on the Network
	Using WD Discovery (Windows only)
	1. Turn on your computer and wait for the operating system to load.
	2. Insert the software-installing CD into the CD or DVD ROM drive.
	3. Windows Vista/Windows 7: Click Run setup.exe, and then click Allow.
	4. Click Accept in the Terms of Agreement screen.
	5. If you have connected the WD ShareSpace properly as shown in the Connect screen on page 13, click Next.
	6. The Application Installer screen opens, displaying a list of options. Click WD Discovery Tool. Once the WD Discovery Tool installation is complete, it automatically launches and the WD Discovery icon displays on your desktop.
	7. The WD Discovery screen appears. Click WDShareSpace in the Network Drives Found list and click Configure.
	8. The login screen appears. Continue device setup by following the instructions for “Setting Up the Device for the First Time” on page 89.

	Using Windows Network and Sharing Center
	1. For Windows Vista/Windows 7, click Start>Computer>Network.
	2. Right-click WDShareSpace in the Network and Sharing center and select Install from the drop-down menu.
	3. Click Locate and install driver software (recommended).
	4. Click Yes, always search online (recommended).
	5. When installation is complete, a confirmation message displays. Click Close.
	To open the WD ShareSpace shares:
	1. Right-click WDShareSpace and select Open from the drop-down menu.
	2. To view the contents, enter your username and password (“admin” is the default for both) and click OK. The Public, Configuration, and Download shares (default shares) display.

	To create a desktop shortcut to the WD:
	To view the WD ShareSpace web page:
	To view the properties of the WD ShareSpace:
	1. Right-click WDShareSpace and select Properties from the drop-down menu.
	2. Click OK to close the screen.


	Mac OS X Leopard/Snow Leopard
	1. Turn on your computer and wait for the operating system to load.
	2. In Finder, double-click WDShareSpace in the Shared list (if necessary, click All then double-click WDShareSpace).
	3. On the login page, type “admin” in both the Name and Password fields and make sure the Remember this password in my keychain check box is selected. Click Connect.
	4. Double-click the Public icon to display the subfolders: Shared Music, Shared Pictures, and Shared Videos.
	5. If you want to make the shared drive icon permanent on your desktop, create an alias. Following are two ways to do that:

	Mac OS X Tiger
	1. Turn on your computer and wait for the operating system to load.
	2. Open Finder. Click Network and then double-click the WDShareSpace icon.
	3. Type “admin” in both the Name and Password fields, and make sure the Remember this password in my keychain check box is selected. Click Connect.
	4. Make sure that Public is highlighted in the Select the volumes to mount list, and then click OK.
	5. Double-click the Public icon that is now on your desktop to display three shared subfolders. You can now drag and drop files into the shared folders using Finder.
	6. If you want to make the shared drive icon permanent on the desktop, create an alias. Following are two ways to create to do that:



	Backing Up Computers on a Network
	WD Anywhere Backup Overview
	Important Installation Notes
	Windows
	1. Turn on your computer and wait for the operating system to load.
	2. Insert the software CD into the CD-ROM drive.
	3. Windows Vista/Windows 7: Click Run setup.exe and then click Allow.
	4. Click Accept in the Terms of Agreement screen.
	5. If you have connected the device properly as shown in the Connect screen on page 13, click Next.
	6. Click WD Anywhere Backup.
	7. Select your preferred language from the list and click OK.
	8. Close all other open applications, and then click Next to continue.
	9. If you accept the terms of the agreement, click I Agree to continue.
	10. Continue with “One-Click Backup” on page 28 or “Creating a Customized Backup Plan” on page 32.

	Mac OS X
	1. Turn on your computer and wait for the operating system to load.
	2. Double-click the WD ShareSpace icon on the desktop.
	3. Double-click WD_Anywhere_Backup.dmg.
	4. On the WD Anywhere Backup screen, click the WD Anywhere Backup icon.
	5. On the verification dialog box, click Continue.
	6. On the Welcome screen of the Install WD Anywhere Backup wizard, click Continue.
	7. On the Software License Agreement screen, click Continue.
	8. To accept the software license agreement, click Agree.
	9. Click Install.
	10. Enter your Mac user name and password.
	11. When a screen verifying successful installation appears, click Close.
	12. Now you can begin backing up your data.


	Configuring WD Anywhere Backup
	One-Click Backup
	To start an automatic and complete backup of your computer’s hard drive:
	1. Click Back Up All of My Files.
	2. A message explains that initial backup will use moderate resources on your computer. To pause the backup, click Pause until System Idle. To keep the backup running in the background, click Continue.
	3. A registration screen appears. If desired, enter the optional registration information. Click Continue. The WD Anywhere Backup screen displays the progress of the backup and percentage of CPU used (bottom right of screen).

	To customize a backup plan:
	1. Click the Customize My Backup link at the bottom right of the WD Anywhere Backup Configuration screen. The Welcome to the WD Anywhere Backup Wizard screen appears.
	2. Continue with step 3 in “Creating a Customized Backup Plan” on page 32.


	Creating a Customized Backup Plan
	1. If WD Anywhere Backup is not already running, click the WD Anywhere Backup icon on the desktop.
	2. Click Create. (If the screen shows no backup plans, none has been created.)
	3. The welcome screen for customizing your backup appears. Click Next.
	4. Click Network Places and locate your WD ShareSpace on your local area network. Click Next.
	Selecting all items from SmartPicks
	1. Click the All Items from SmartPicks button. The SmartPicks screen displays, listing common file types that you can back up.
	2. Select each file type you want to back up. You can also click Select None to clear all selections, or click Select All to select all of the items.
	3. To add more items, click the Add Backup Items button. The Local Folders tab displays. Select additional folders and click Select.
	4. To exclude more items from your plan:
	(a) Click the Show Advanced Options button.

	5. On the Items Selected for Backup screen, click Next.
	6. Continue with “Completing the Backup Plan” on page 37.

	Selecting your own backup items
	1. Click the My Own Backup Items button. The SmartPicks screen appears, listing default file locations you can back up.
	2. You have two options:
	(a) On the SmartPicks tab, select each item you want to back up. You can also click Select None to clear all selections, or click Select All to select all of the items. When finished, click Next.

	3. On the Items Selected for Backup screen, you can add more items or use advanced items as described in “Selecting all items from SmartPicks” on page 34.
	4. On the Items Selected for Backup screen, click Next.
	5. Continue with Completing the Backup Plan below.
	1. Name your backup plan and click Next. You can create additional backup plans by repeating the steps above.
	2. A confirmation screen appears. Click Done.
	3. A message explains that initial backup will use moderate resources on your computer. To pause the backup, click the Pause until System Idle link.
	4. To keep the backup running in the background, click Continue.


	Restoring a Backup Plan
	1. Click View and Restore.
	2. Click a backup plan in the Select a Plan list, or to search for a backup plan, enter the name in the Search by File Name field and click Search.
	3. Click the box next to the folders or files you want to restore.
	4. From the Restore Files to list, select a location for your restored files and click the Restore button.

	Reactivating a Backup Plan
	1. On the menu bar, click Actions>Reactivate Backup Plan.
	2. The Reactivate wizard appears. Click Next.
	3. Browse to select the location of the backup folder and click Next.
	4. If you have more than one backup plan, select the one you want to reactivate and click OK.
	5. Select the No, just reactivate the backup plan and start backing up option and click the Next button. Your backup plan will be reactivated, and your computer will back up files onto your selected backup destination.

	Editing a Backup Plan
	1. On the WD Anywhere Backup screen, click the Change Selected Files icon. (See “Icons” on page 42.) The WD Anywhere Backup Configuration screen appears.
	2. Do one of the following:
	3. When you finish selecting items to add or remove, click the Select (or OK, depending on the screen) button.
	4. When returned to the WD Anywhere Backup Configuration screen, click the Done button.
	1. Click the Change Selected Settings icon. (See “Icons” on page 42.) Select the Keep up to check box and enter the maximum number of earlier versions of your files to back up.
	2. Click OK.
	1. Click the Remove Backup Plan icon. (See “Icons” on page 42.)
	2. In response to the confirmation message, click OK.
	1. Select the backup plan, and click the Show Backup Log icon. (See “Icons” on page 42.) The Backup Log appears.
	2. To view the error log, click the Error Log tab.
	3. To see an explanation of an error in the list displayed in the lower part of the screen, click the error.
	4. To clear selected errors, select their check boxes and click the Clear Selected Errors button.
	5. To clear all errors, click the Clear All Errors button.
	6. To prevent the Error Log from displaying transient errors, click the Do not notify me about transient errors check box. This selection affects all backup plans.
	7. To see which files have been backed up, click the click here to launch the WD Anywhere Restore application link. (For information on restoring, see “Restoring a Backup Plan” on page 40.)



	Using Time Machine™
	Setting up Time Machine
	1. Use one of the following methods to open Time Machine.
	2. If this is your first time creating a backup, the following screen displays:
	3. Click the Choose Backup Disk button and select the WD ShareSpace drive where you want the backups stored.
	4. Click the Use for Backup button. A screen prompts you for your user name and password. Enter wd_backup as the user name and backup as the password (not case-sensitive).
	5. Click the Connect button. The Preferences screen returns.
	6. To start automatic backups, move the slider to ON.
	7. To add a Time Machine drop-down menu to the menu bar at the top of the screen, select the Show the Time Machine status in the menu bar check box. This menu enables you to start a backup, enter Time Machine to restore files, or open the Time Machin...

	Starting a Backup
	Restoring Backed-up Items
	1. Open the window on your computer where you want the item restored. For example, if you are restoring a document, open the Documents folder. (If you are restoring an item on your desktop, you do not need to open a window.)
	2. Click the Time Machine icon in the Dock or select Enter Time Machine from the drop-down menu.
	3. Click the arrows or the time line on the right of the screen to browse through all the backups Time Machine has created.
	4. Select the item you want to restore, and click the Restore button to display the following options:
	5. Click the button for the desired option:

	Deleting the Entire Backup
	1. In Finder, select the WD ShareSpace drive and click the Connect As button.
	2. Enter wd_backup as the user name and backup as the password (not case- sensitive) and click Connect.
	3. Select the backup folder and then drag the *.sparsebundle file to the Trash icon.

	Changing Your Password
	1. Log in to the WD ShareSpace web user interface. (See “Accessing WD ShareSpace’s Network Storage Manager” on page 92.)
	2. Enter your username and password and click Login (default username and password are “admin”).
	3. Click the Users button in Basic mode.
	4. Click the icon to the right of the user name (WD_Backup).
	5. When the Users page appears, enter your new password in the New and Confirm password fields and click Submit.
	6. A confirmation message displays.


	MioNet Remote Access
	MioNet Overview
	Remote Access Setup
	Windows
	1. Turn on your computer and wait for the operating system to load.
	2. Insert the WD ShareSpace software CD into the CD-ROM drive.
	3. Windows Vista/Windows 7: Click Run setup.exe and then Allow.
	4. Click Accept in the Terms of Agreement screen.
	5. If you have connected the device properly as shown in the Connect screen on page 13, click Next.
	6. Click the MioNet New Account button if you are a new MioNet user; click MioNet - Existing Account if you are an existing user. The MioNet registration screen appears.
	7. Complete the registration form and click Submit to create an account.
	8. When MioNet finds the WD ShareSpace you are registering, enter a name for the device and click OK.
	9. A confirmation message appears. Click OK.


	Using MioNet Web (after registration)
	1. From any browser, go to www.mionet.com/web and enter your username and password. The Quick Start tab appears, displaying icons representing activities you can perform.
	Accessing WD ShareSpace Folders and Files Remotely
	1. Click the My Resources tab to display your WD ShareSpace folders.
	2. Select a folder to see a list of all the sub-folders and files. You can now use your browser to access your entire collection of music, photos, movies, and documents.
	3. Double-click any file to open it locally. You may be able to drag and drop files from your WD ShareSpace to the remote computer and vice versa.

	Sharing Files with Others
	1. Click the Share Photos icon.
	2. Choose any folder or the plus sign to choose a sub folder to share with someone else and click the Next button.
	3. To share photos with MioNet users you have shared with in the past:
	(a) Select the user(s) and click the Next button.

	4. To add a new user to share with:
	(a) Click the Invite new person button.

	5. To find another MioNet user you have never shared with before:
	(a) Click the Find MioNet user button.

	6. From the list of users, select the user(s) you want to share with and click the Next button.
	1. Click the Transfer Files to Others icon to open a dialog window showing your WD ShareSpace folders.
	2. Click the + to navigate through your directory to highlight the folder you wish to transfer files from and click Next.
	3. To transfer files back and forth with MioNet users you have shared with in the past:
	(a) Select the user(s) and click the Next button.

	4. To add a new user to transfer files to and from:
	(a) Click the Invite new person button.

	5. To find a MioNet user you have never shared with before:
	(a) Click the Find MioNet user button.

	6. From the list of users, select the user(s) you want to transfer files to and from. Click the Next button.
	7. Select the permission level and click the Next button. If you want users to only transfer the files to themselves, give them the read permission. If you want to enable them to transfer files to you (or modify or delete your files), give them the r...



	How to Play/Stream Video, Music & Photos
	Media Servers Overview
	Media Types Supported
	Media Storage
	How and Where to Add Media Content to the Shared Folders
	1. Open the Internet Explorer.
	2. Copy your music files to the Shared Music folder, which is under the Public folder on WD ShareSpace.
	3. Follow the same process to place your videos and pictures into their respective Shared Pictures and Shared Video folders.


	Media Devices
	WD TV Live HD Media Player
	1. Connect a WD ShareSpace to your LAN and power on the device.
	2. Make sure the WD TV Live is connected to your TV and powered on.
	3. Connect the WD TV Live to the LAN.
	4. Navigate to Settings>Network setting>Network setup to choose the connection type.
	5. Use the navigation buttons to select Wired and press Enter.
	6. Select Automatic as the setup configuration option for DHCP or Manual for a static IP.
	7. A confirmation screen displays your WD TV Live’s network information if connection to the LAN is successful. Press Enter.
	8. Navigate to the Home screen, and select the icon for media content you wish to access. It can be Music , Video , or Photo .
	9. Press / to select Network Shares or Media servers and press Enter.
	10. Press / to select the WD ShareSpace and press Enter.
	11. Supported content for the selected media type displays.
	12. Select the content you wish to access, and then press Enter to start media playback.

	Windows Media Player 11/12 (Windows Vista/Windows 7)
	To stream media using Windows Media Player 11 or 12 Library:
	1. Click Control Panel>Network and Sharing Center.
	2. Click Customize.
	3. Click Private, and then click Next.
	4. Launch Windows Media Player (Start>All Programs>Windows Media Player).
	5. Click Library>Media Sharing.
	6. Click Find media that others are sharing, and then click OK.
	7. Select a media type (Music, Pictures, or Video) and click PVConnect on WDShareSpace.
	8. Double-click the media file you want to play.


	Xbox 360
	1. Ensure that your Xbox 360 and WD ShareSpace are powered on and connected to your local area network.
	2. From the main Xbox user interface, scroll to the My Xbox screen
	3. Use the Xbox 360 controller and scroll to the right until you see Video, Music and Picture Library options.
	4. Select any one of these three options by pressing the A button on your controller. The Select Source screen displays.
	5. Select the WD ShareSpace option based on the device name you created previously and press the A button. You see the media content stored on your WD ShareSpace unit.

	PlayStation 3
	1. Ensure that your PlayStation 3 and WD ShareSpace are powered on and connected to your local area network. You will see the main user interface with a series of options displayed horizontally across your TV screen.
	2. Using the directional buttons (left and right) on the PlayStation controller, navigate to Music, Photo or Video depending on which type of media you want to play, and press the X button.
	3. Using the directional buttons (up and down), scroll and select WDShareSpace (or the new device name that you created previously) by pressing the X button. You will now see a list of folders (Music, Photo and Video) to the right of the WDShareSpace...
	4. Make sure that you select the folder that corresponds to the option you selected back in Step 2. For example, if you select Photo from the main user interface screen, open the corresponding Photo folder to the right of the WDShareSpace icon, other...

	Digital Picture Frames
	1. Ensure that your WD ShareSpace is connected to your home’s local network and is powered on.
	2. Follow the user instructions provided with your wireless digital photo frame to proceed through any initial setup or installation of drivers.
	3. Using the navigation feature on your wireless digital photo frame, scan and detect the WD ShareSpace on your network.
	4. Depending on the brand of photo frame you have, you may need to access Settings/Network Setup screen in the user interface to establish connection so that your photo frame can link to your WD ShareSpace. Please refer to the user guide for your Dig...
	5. Once you have a connection between your wireless photo frame and the WD ShareSpace, access the Media screen on your photo frame that will provide you the option to view your pictures.

	Network Music Player
	1. Connect WD ShareSpace to your local area network and power on the device.
	2. Connect and configure your network music player on your home’s wired or wireless network switch or router.
	3. Turn on your network music player.
	4. If connected properly, you will find the device name of your WD ShareSpace.
	5. Navigate through the network music player’s user interface to locate and play music stored on your WD ShareSpace.

	Digital Media Adapters
	1. Connect WD ShareSpace to your local area network and power on the device.
	2. Make sure that your DMA device is connected to your TV and powered on. The main screen of your DMA device appears.
	3. Depending on the DMA device, you may need to access the Settings/Network Setup screen in the user interface to establish a connection between your DMA and WD ShareSpace. Please refer to your DMA’s user guide for specific instructions.
	4. Once you have a connection established between your DMA and WD ShareSpace, access the Media screen on your DMA to view your pictures or stream music and video content from the WD ShareSpace.

	DLNA® Devices

	iTunes with WD ShareSpace
	iTunes Media Server Overview
	Media Types Supported
	Storing Content
	Streaming Audio in iTunes
	1. Launch iTunes on your computer.
	2. Click WDShareSpace under the Shared section of the left pane. If you have copied music to the /Public/Shared Music folder and it is in a format supported by iTunes, it should be listed in the right pane.
	3. Double-click an audio file to play.



	External USB Drive Sharing & Backup
	Sharing Data on a USB Drive
	To share data on a USB drive:
	1. Connect a USB drive to any of the three USB ports. The front port is USB1 and the two rear ports are USB2 and USB3 from top to bottom.
	2. Open the WDShareSpace folder to access data on the USB drive. Double-click the USB share. The USB share name will appear as usb1-1share1, usb2-1share1, or usb3-1share1, depending on the actual USB port that the USB drive is connected to.


	USB Auto Backup Feature
	To back up FROM a USB drive:
	1. Connect a USB drive to the USB port (Port 1) located on the front panel, and wait for a few seconds for the USB backup LED on the front of the unit to light steadily (this could take up to 30 seconds).
	2. Press and hold the USB backup button only until the USB backup LED turns off (about 2 seconds). While the backup is in progress, the USB LED will flash once per second. When the backup is complete, the LED will remain on steadily.

	To back up t o a USB drive:
	1. Prior to performing the backup operation, make sure to choose a source and destination in the WD ShareSpace’s Network Storage Manager utility. See “To set a source share name for WD ShareSpace to USB drive backup:” on page 145 for more infor...
	2. Connect a USB drive to the USB port (Port 1) located on the front panel of the WD ShareSpace, and wait for the USB backup LED to turn on (about 30 seconds).
	3. Press and hold the USB backup button until the USB backup LED on the front of the unit begins to flash (about 3 seconds). The USB LED will flash twice per second while the backup is in progress and will light steadily when the backup is complete.



	Using WD Discovery (Windows Only)
	WD Discovery Overview
	Mapping a Network Drive
	To map a network drive:
	1. Turn on your computer and wait for the operating system to load.
	2. If WD Discovery is not running:
	3. Click the device you want to map in the Network Drives Found list and click Map Network Drive in the Things to Do list.
	4. In the authentication screen, enter your User Name and Password. The default for both is “admin.”
	1. After completing step 4 on the previous page, click Yes. All share folders available on the device will be mapped as network drives automatically. Available drive letters are assigned backwards from Z. When mapping completes, the share folders app...
	2. Click Back to return to the main screen.
	1. After completing step 4 on the previous page, click No. All share folders on the device are listed on the screen. Select a folder name, and then select a drive letter.
	2. Click Yes to complete drive letter assignment.
	3. Click My Computer (Computer on Windows Vista/Windows 7). The network drives display. You can now drag and drop files into the network drive folders using My Computer or Windows Explorer.


	Browse Network Shares
	To access data on a share using WD Discovery:
	1. Ensure that the device is powered on and connected to the network.
	2. Launch WD Discovery from the Start menu or the desktop.
	3. Click WDShareSpace in the Network Drives Found list and click Browse Network Shares in the Things To Do list.
	4. After successful login, the share folders on the device are listed. Click a share to view and access share files in Windows Explorer.
	5. Copy your music files into the Shared Music folder, your video files into the Shared Videos folder, and your photos and pictures into the Shared Pictures folder.


	Desktop Shortcut Creation
	1. Ensure that the device is powered on and connected to the network.
	2. Launch WD Discovery from the Start menu or the desktop.
	3. Click WDShareSpace in the Network Drives Found list, and then click Create Desktop Shortcut in the Things To Do list.
	4. A dialog appears informing you that the desktop shortcut has been created successfully. Click OK.

	Turning Identify LED On or Off
	To turn on the Identify LED on a networked WD ShareSpace:
	1. Ensure that the device is powered on and connected to the network.
	2. For Windows 2000/XP, click Start>All Programs>WD Discovery Software>WD Discovery, or double-click the WD Discovery icon on your desktop.
	3. Click WDShareSpace in the Network Drives Found list and click Turn On Identify LED in the Things To Do list.
	4. The Identify LED on the target device is turned on. The LED icon appears to the left of the device name in WD Discovery.

	To turn off the Identify LED on a remote networked WD ShareSpace device:
	1. Ensure that the device is powered on and connected to the network.
	2. Click Start>Programs>WD Discovery.
	3. Click WDShareSpace in the Network Drives Found list and click Turn Off Identify LED in the Things To Do list.


	Automatically Updating WD Discovery
	To download the update:
	1. On the WD Discovery Auto Update Progress screen, click Yes.
	2. To launch WD Discovery, click Yes.



	Network Storage Manager: Basics
	Configuring WD ShareSpace
	Windows
	To configure your WD ShareSpace for Windows:
	1. Turn on your computer and wait for the operating system to load.
	2. Insert the WD ShareSpace software CD into the CD-ROM drive.
	3. Windows Vista/Windows 7: Click Run setup.exe, and then click Allow.
	4. Click Accept in the Terms of Agreement screen.
	5. If you have connected the device properly as shown in the Connect screen on page 13, click Next.
	6. The Application Installer screen opens, displaying a list of options. Click WD Discovery Tool.
	7. The WD Discovery screen appears. Click WDShareSpace in the Network Drives Found list and click Configure.
	8. The login screen appears. Continue device setup by following the instructions for “Setting Up the Device for the First Time” on page 89.


	Mac OS X
	To configure the WD ShareSpace for Mac OS X:
	1. Turn on your computer and wait for the operating system to load.
	2. Open the Safari web browser.
	3. Click the Bookmarks linkin the upper left corner of the screen.
	4. Click Bonjour, and then double-click WDShareSpace.
	5. The login screen appears.
	6. Continue device setup by following the instructions for “Setting Up the Device for the First Time” on page 89.


	Setting Up the Device for the First Time
	1. Enter “admin” in both the Administrator Name and Password fields.
	2. Select a language from the Language list and click Login.
	3. Click Next.
	4. Read the license agreement, and then click I Agree.
	5. In the Initial Setup screen, do the following:
	(a) Enter a name in the Device Name field (up to 15 characters, including alphanumeric and dash ‘-’).

	6. Enter a new admin password in the New Admin Password field. The maximum length of the password is 16, including alphabetic, numeric, underscore, space, and most special characters except double-quote ("). The first and last characters cannot be a ...
	7. Retype the new password in the Confirm Password field. Click Next.
	8. Accept the default DHCP (Dynamic Host Configuration Protocol) client settings. If you are not using DHCP, click Static and manually assign the IP address. Click Next.
	9. The Summary screen appears. Click Finish.

	Accessing WD ShareSpace’s Network Storage Manager
	Windows
	1. Ensure that the device is powered on and connected to the network.
	2. If WD Discovery is not running, launch it from the Start menu or the desktop.
	3. Click WDShareSpace in the Network Drives Found list and point to and click Configure in the Things To Do list.
	4. The login page appears. Type in the administrator name and password (the default password is “admin” unless it has already been changed by the administrator). In the Tool list, click WD ShareSpace’s Network Storage Manager. In the Language l...

	Mac OS X
	1. Turn on your computer and wait for the operating system to load.
	2. Open the Safari web browser.
	3. Click the Bookmarks linkin the upper left corner of the screen.
	4. Click Bonjour, and then double-click WDShareSpace.
	5. The login page appears. Type in the administrator name and password. In the Tool list, click WD ShareSpace’s Network Storage Manager. In the Language list, click the language for your region. Click Login.


	WD ShareSpace’s Network Storage Manager Features
	User Interface Overview
	Toolbar

	Basic Mode
	Device Name
	1. Click the Device Name button in Basic Mode home page.
	2. Enter or change the text in the Device Name and/or Device Description fields.
	3. Click Submit.

	Date & Time
	1. Click the Date & Time button on the Basic Mode home page.
	2. Deselect Enable to set the time manually.
	3. To synchronize the date and time automatically, click Enable.
	4. Click Submit.

	Network
	To configure the network settings:
	1. Click the Network button on the Basic Mode home page.
	2. In the Network Mode drop-down menu, select a network mode. Selecting DHCP Client as a network mode causes the device to obtain an IP address automatically from the local DHCP server. Selecting Static IP as a network mode requires you to enter IP i...
	3. Click Submit.


	Users
	To create a new user account:
	1. Click the Users button on the Basic Mode home page.
	2. Click the Add icon .
	3. Enter the user name in the User Name field.
	4. Enter the user’s full name in the Full Name field.
	5. Enter the password in the Password field.
	6. Re-enter the password in the Confirm Password field.
	7. Create a private user share at the same time by clicking Yes next to Create User Private Share. The new user is granted full access to the private share. The private share name is the same as the user name.
	8. Click Submit.

	To change a user password:
	1. Click the Users button on the Basic Mode home page.
	2. Click the Change Password icon next to the appropriate user account.
	3. Make the necessary changes, and then click Submit.

	To delete an existing user account:
	1. Click the Users button on the Basic Mode home page.
	2. Select the user account you want to delete, and then click the Delete icon .
	3. Click OK.


	Folder Shares
	To create a share:
	1. Click Folder Shares on the Basic mode home page.
	2. Click the Add icon .
	3. Enter a share name in the Share field. The share name can contain up to 32 characters, including alphabetic, numeric, or underscore characters.
	4. Enter a brief description in the Description field.
	5. Click Submit.

	To delete existing shares:
	1. Select the share to delete.
	2. Click the Delete icon .
	3. Click OK.


	System Status
	Remote Access
	To register with MioNet:
	1. Click the Create MioNet account link in the note at the bottom of the page. The MioNet web registration page displays.
	2. Enter the registration information required and click Submit.

	To log in to an existing MioNet account:
	1. Click the MioNet login link at the bottom of the page.
	2. Enter your MioNet username and password and click Go.


	Shutdown/Reboot
	To shut down the WD ShareSpace:
	1. Click Shutdown/Reboot on the Basic mode home page.
	2. On the Shutdown/Reboot page, click Shutdown.
	3. Click OK.

	To reboot the WD ShareSpace:
	1. Click the Shutdown/Reboot button on the Basic Mode home page.
	2. On the Shutdown/Reboot page, click Reboot.
	3. Click OK.




	Network Storage Manager: Advanced Mode
	System Tab
	General Setup
	To configure system general setup settings:
	1. Assign a device name for this storage device in the Device Name field. The device name can contain up to 15 characters, including alphabetic, numeric, and hyphens only.
	2. Enter a brief description for this storage device in the Device Description field. The maximum length of the description must not be more than 256 alphanumeric characters.
	3. For Web Access Protocol, select either of the following web access protocols:
	4. To set the date and time manually, deselect Enable next to NTP Service.
	5. Select a time zone from the Time Zone list.
	6. Adjust the date and time manually in the Date & Time lists.
	7. Click Submit.


	Alerts Setup
	To set up automatic email notifications:
	1. On the Alerts Setup page on the System tab, click Enable next to Email Notification. The page displays additional fields.
	2. In the SMTP Server field, enter the name or IP address of the SMTP server used for email. (Check with your Internet Service Provider (ISP) for the SMTP server settings, which may include the SMTP port, and ask whether to enable TLS/SSL or SMTP aut...
	3. In the Email Return Path field, enter a valid return email address recognized by your ISP. For example, if your SMTP server is "smtp.myisp.net", then you should enter a valid return email path address of the form "myname@myisp.net".
	4. In the Email Recipients field, enter the email address where you want to send an email message when an event occurs. Up to five email addresses can be used at a time.
	5. Click Send Test Mail to send a test alert and confirm your settings are correct. A test message will be sent to each entered email address.
	6. Click Submit.

	To configure alerts to send pop-up messages when an event occurs:
	1. On the Alerts Setup page on the System tab home page, click Enable next to Pop-Up Notification.
	2. Enter the name of the computer in the Notified Devices field. When an event occurs, a pop-up message will appear on the computer. Up to five computer names can be added to the alert list.
	3. Click Send Test Pop-up to send a test alert and confirm that the settings are correct.
	4. Click Submit.


	Admin Password
	To change the administrator's password:
	1. Click the Admin Password button on the System tab home page.
	2. In the Old Password field, enter the old password.
	3. In the New Password field, enter the new password. The maximum length of the password is 16, including alphabetic, numeric, underscore, space, and most special characters except double-quote ("). The first and last characters cannot be a space. Th...
	4. In the Confirm Password field, re-enter the new password.
	5. Click Submit.


	Update (Firmware)
	1. Click the Update button on the System tab home page.
	2. Click Check For New Firmware.
	3. Click Download if new firmware is available.
	4. Click Upgrade. Wait for the update process to complete.
	1. Before attempting a manual update, check support.wdc.com for firmware availability.
	2. If a new firmware file is available, obtain it from WD Technical Support at support.wdc.com.
	3. Save the file to a Desktop location on your computer.
	4. Click the Manual tab on the Update page.
	5. Under Firmware Update, click the Browse button and locate the firmware file you saved.
	6. Click Submit.
	7. After your firmware has been updated, the device will reboot. The web user interface redirects to the System Status page after the update is completed.

	Configuration
	To back up the current system configuration settings:
	1. On the Configuration page, click Save Current Configuration.
	2. Click Save.
	3. Specify a file name and location for saving the file.
	4. Click Save.

	To restore saved configuration settings:
	1. On the Configuration page, click Browse.
	2. Select the previously saved system configuration file.
	3. Click Open.
	4. Click General Restore or Full Restore.
	5. Click OK.

	To restore the device to factory defaults:
	1. On the Configuration page, click Restore Factory Default.
	2. Click OK.


	Advanced
	To open the Advanced page:
	1. Click the Advanced button on the System tab home page.

	To enable SSH access:
	1. On the Advanced page, select the Enable check box under Root Access.
	2. Click Submit.

	To turn on the system identification LED:
	1. Click ON to enable the system identification LED.

	To generate an SSL certificate and key pair automatically:
	1. On the Advanced page on the System tab home page, click the highlighted word “HERE” in the Auto Generate field of the SSL certificate/key. The SSL Certificate/Key Generation screen appears.
	2. Enter the identification information you want to include in the certificate/key pair.
	3. Click Submit.

	To generate an SSL certificate and key pair manually:
	1. Using your preferred method, generate an RSA private key and paste it in the appropriate fields of the Advanced page.
	2. Click Submit.

	To select extend disk mode:
	1. On the Advanced page, select Auto Extend or Manual (Extend Disk) Mode:
	2. Click Submit.

	To disable HDD standby (enabled by default):
	1. On the Advanced page, clear the Enable check box next to HDD Standby.
	2. Click Submit.


	UPS
	To enable the UPS service:
	1. Click the UPS Setup button on the System tab home page.
	2. On the UPS page, click the UPS Setup tab.
	3. Select the Enable check box for UPS Service.
	4. Enter the timeout value.
	5. Click Submit.
	1. Click the UPS Setup button on the System tab home page.
	2. On the UPS page, click the UPS Status tab to view information about the connected UPS device, including model, battery level and runtime, timeout, and status.


	Shutdown/Reboot
	To shut down the WD ShareSpace:
	1. Click the Shutdown/Reboot button on the System tab home page.
	2. On the Shutdown/Reboot page, click Shutdown.
	3. Click OK.

	To reboot the WD ShareSpace:
	1. Click the Shutdown/Reboot button on the System tab home page.
	2. On the Shutdown/Reboot page, click Reboot.
	3. Click OK.



	Network Tab
	LAN
	To configure the network settings:
	1. In the Network Mode drop-down menu, select a network mode. Selecting DHCP Client as a network mode will cause this storage device to obtain an IP address automatically from the local DHCP server. Selecting Static IP as a network mode requires you ...
	2. If your network link speed is 1000 Mbps, the MTU field will be available. Enter the MTU (Maximum Transmission Unit) value for the jumbo frame. The default MTU setting is 1500 bytes. Any value larger than this is considered a jumbo frame. The netwo...
	3. Click Submit.


	Services
	To enable UPnP NAT Traversal for Web Access & FTP:
	1. Click Enable in UPnP for Web Access & FTP.
	2. Click Submit.

	To enable other network services:
	1. Click Enable beside the desired network service.
	2. If you selected FTP as your network service, click Yes to enable or click No to disable anonymous login, and then click Submit.
	3. If you selected NFSas your network service, the IP allowed field appears. You will be prompted to enter the IP filters that are allowed for NFS service. Click Add to add a new IP filter, and then click Submit.
	4. You can specify particular port numbers for HTTP, HTTPS, and FTP services respectively. Instead of selecting the Default radio button, you can specify the port number between 8000 and 10000 for each service.

	To access data via FTP:
	1. Open an FTP client software program.
	2. Enter ftp://username@IP address as the host name (e.g., ftp://admin@172.25.102.67) or just the device’s IP address depending on the FTP client software program you are using.
	3. Enter the WD ShareSpace user name and corresponding password.
	4. Click Connect or OK.


	Workgroup
	To set up a workgroup name:
	1. Click the Workgroup button on the Network tab home page.
	1. Click Workgroup as the Mode option.
	2. Enter a name for your workgroup in the Workgroup Name field.
	3. Click Submit.

	To join a domain (Windows Server 2003 or Windows Server 2008):
	1. Click Domain Member.
	2. Enter the fully qualified domain name in the Domain Name field.
	3. Enter the domain controller IP address in Domain Controller IP Address field.
	4. Enter the domain administrator name in the Administrator field.
	5. Enter the domain administrator password in the Administrator Password field.
	6. Click Submit.


	Remote Access
	To register a new Web account with MioNet:
	1. Click the Create MioNet account link in the note at the bottom of the page. The MioNet registration page displays.
	2. Enter the registration information required and click Submit.

	To log in to an existing MioNet account:
	1. Click the MioNet login link at the bottom of the page.
	2. Enter your MioNet username and password and click Go.



	Storage Tab
	Disk Manager
	To clean up a disk:
	To safely remove a disk:

	Volumes and RAID Management
	To modify the volume:
	1. Click the Manage Volume tab.
	2. Click the Modify icon next to the volume you want to modify. The Volume & Raid Management page appears.
	3. Select a RAID level.
	4. Click Submit.

	To delete a volume:
	1. Click the Delete icon.
	2. Click OK.

	Manage Volume Options
	To configure the Manage RAID tab:
	1. Click the Manage RAID tab on the Volumes & Raid Management page.
	2. Select a RAID configuration
	3. Click Submit.

	Manage RAID Options

	Folder Shares
	To create a share:
	1. Click the Add icon to display the following:
	2. Enter a share name in the Share field. The share name can contain up to 32 characters, including alphabetic, numeric, or underscore.
	3. Enter a brief description in the Description field.
	4. Click a file sharing protocol next to Services. The WD ShareSpace supports the following file sharing services (protocols):
	5. Select a logical volume you want to share from the Volume list.
	6. (Optional) Click Setup access control after creating this share to set access control for the new share. For more information, see “To edit the access rights of users or groups:” on page 156.
	7. Click Submit.

	To modify properties of the share:
	1. On the Folder Shares list, select the share you want to modify, and then click the Modify icon .
	2. Edit the share name if desired. The share name can contain up to 32 characters, including alphabetic, numeric, or underscore characters.
	3. Enter a brief description, if desired.
	4. Select a file sharing protocol.
	5. Click Submit.

	To delete existing shares:
	1. On the Folder Shares list, select the share to delete.
	2. Click the Delete icon .
	3. Click OK.


	USB Shares
	To format a USB drive:
	1. Connect a USB drive to the device.
	2. On the USB Disk page, click the Format icon to the right of the USB. A dialog box warns that all data will be erased.
	3. Click OK. The USB LED blinks while the drive is being formatted.
	4. Once the LED stops blinking, remove the USB drive from the WD ShareSpace.

	To safely remove a USB drive:
	1. On the USB Disks page, click the Safely Remove Disk icon to the right of the USB device name.
	2. Click OK.

	To set a destination share name for the USB drive to WD ShareSpace backup:
	1. On the USB Shares page, click the USB to WD ShareSpace Backup tab.
	2. Select a share to be used as a destination share from the Destination Share list.
	3. Click Submit.

	To set a source share name for WD ShareSpace to USB drive backup:
	1. On the USB Shares page, click the WD ShareSpace to USB Backup tab.
	2. Select a share to be used as source share from the Source Share list.
	3. Click Submit.


	Quota
	To configure disk quota:
	1. Select the volume you want to modify, and then click the Modify icon .
	2. Click Enable next to Quota Service to enable disk quota service.
	3. Specify the grace period after which no additional drive space is provided.
	4. Click Submit.

	To modify the user quota setting:
	1. Select the volume you want to modify, and then click the Modify icon.
	2. Click Enable next to Quota Service to enable disk quota service.
	3. Specify the quota size for the user.
	4. Click Submit.


	Downloads
	To set the destination share name for the Downloader:
	1. On the Downloads page, click the Setup Destination Share tab.
	2. Select the folder to share with others from the Destination Share list.
	3. Click Submit.

	To change the Downloader’s password:
	1. On the Downloads page, click the Change Password tab.
	2. Enter a password in the Change Password field. The maximum length of the password is 16, including alphabetic, numeric, underscore, space, and most special characters except double-quote (“). The first and last characters cannot be a space. The ...
	3. Re-enter the password in the Confirm Password field.
	4. Click Submit.



	Media Tab
	Media Server
	iTunes
	To enable or disable the iTunes Media Server:
	1. On the iTunes Server, click Enable next to iTunes Service. Or, deselect the option to disable it.
	2. Specify how often iTunes will scan the device for new music files.
	3. Click Submit.

	To customize media library update frequency:
	1. Select an option in the Check for new music every list.
	2. Click Submit.

	To stream audio in iTunes:
	1. Make sure that the iTunes Server is enabled in the WD ShareSpace’s Network Storage Manager.
	2. Click WDShareSpace under the Shared section of the left pane. If you have copied music to the /Public/Shared Music folder and it is in a format supported by iTunes, it should be listed in the right pane.
	3. Double-click an audio file.



	Users Tab
	Users
	To create a new user account:
	1. On the Users page on the Users tab, click the Add icon .
	2. Click Grant Administration Rights to provide the user with administrative rights. Administration rights allow the user to configure the device.
	3. Enter the user name in the User Name field.
	4. Enter the user’s full name in the Full Name field.
	5. Enter the password in the Password field.
	6. Re-enter the password in the Confirm Password field.
	7. If desired, select a previously created Group for the user to join from the Group List.
	8. Click the >> button to add the selected user to the group.
	9. You may create a private user share at the same time by clicking Yes next to Create User Private Share. The new user is granted Full Access to the private share. The private share name is the same as the user name. Nobody else has access to this p...
	10. Select a volume that you want the user to access.
	11. Select one or more file sharing protocols to access private shares.
	12. Click Submit.

	To modify a user account:
	1. On the Users page on the Users tab, select the user account to modify, and then click the Modify icon .
	2. Make the desired changes, and then click Submit.

	To delete an existing user account:
	1. On the Users page on the Users tab, click the Delete icon next to the user account you want to delete.
	2. Click OK.


	Groups
	To create a group:
	1. On the Groups page on the Users tab, click the Add icon .
	2. Assign a new group name.
	3. Enter a description of the new group.
	4. Select users from the User List field to add to the User Joined field.
	5. Click the >> button.
	6. Click Submit.

	To modify a group:
	1. On the Groups page on the Users tab, select the group you want to modify, and then click the Modify icon .
	2. Make the desired changes, and then click Submit.

	To delete a group:
	1. On the Groups page on the Users tab, select the group you want to delete, and then click the Delete icon .
	2. Click OK.


	Folder Share Permissions
	To edit the access rights of users or groups:
	1. Select a user or group on the Folder Shares Permissions page, and then click the Edit icon .
	2. Click Enable next to Public Access to allow everyone to access to the share.
	3. Select an access option.
	4. In the Unassigned Users list, select the users to whom you want to grant full access, read only permission, or no access to the share.
	5. Click the >> button.
	6. In the Unassigned Groups list, select the local groups to which you want to grant full access, read only permission, or no access to the share.
	7. Click the >> button.
	8. Click Submit.


	USB Share Permissions
	To edit the access rights of users or groups:
	1. Select the share you want to modify by clicking the Edit icon next to that share.
	2. Click Enable next to Public Access to allow everyone to access the share.
	3. Select an access option.
	4. In the Not Assigned Users list, select the users to whom you want to grant full access, read only permission, or no access to the share.
	5. Click the >> button.
	6. In the Not Assigned Groups list, select the local groups to which you want to grant full access, read only permission, or no access to the share.
	7. Click the >> button.
	8. Click Submit.



	Status Tab
	System Status
	System Logs
	To configure the log settings:
	1. On the Settings tab, click Show log entries in reverse order to display the most recent entries at the top.
	2. Enter the number of entries you want to appear on the System, CIFS, and FTP logs.




	Download Manager: Downloader
	Accessing Downloader
	1. In the Tool list, click Downloader.
	2. Enter “downloader” in both the Administrator Name and Password fields and click Login.
	3. Select a language. (“English” is the default.)
	4. Click Login.

	Downloader Features
	User Interface Overview
	HTTP/FTP Tab
	Tasks
	To create a download task:
	1. On the Tasks page, click the Add icon.
	2. Enter the full web address from which you want to download the file in the URL field.
	3. If a user name and password are required to download the file, click User name and password are required, and then enter the user name and password.
	4. If you want to enter a new name for the file, enter a new name in the Save As field.
	5. Click Automatically to start downloading immediately after the request.
	6. Click Submit. The task displays at the bottom of the list.

	To stop and resume a download task:
	1. Select a task in the Tasks table.
	2. Click the Stop icon to stop the download task.
	3. Click the Start icon to resume the download task.

	To delete a download task:
	1. Select a task in the Tasks table.
	2. Click the Delete icon to delete the download task.
	3. Click OK, and then click OK again.
	4. Click Submit.

	To change the order of the download queue:
	1. Use the arrow buttons to change the order of download tasks or to make a task conditional on a previous task.
	2. Select a task in the Tasks table, and then click Move Up or Move Down .
	3. Click Submit.


	Settings
	To customize the Downloader settings:
	1. On the HTTP/FTP tab, click the Settings button to display the following page
	2. Select a number to specify the maximum number of simultaneously running downloads in the Max. Running No. field.
	3. Specify the integer value to limit the downloaded speed if you do not want to consume the entire available bandwidth in the Download Speed field.
	4. Set up the proxy in the Proxy field to download files if your network environment does not allow making direct connections to an external network.
	5. Click Enable next to Schedule to enable scheduled downloading time. The page expands:
	6. Select rows, columns, or individual days and times during which downloading is allowed. Selections display in yellow.
	7. Click Submit.



	CTorrent Tab
	Tasks
	To view a task:
	1. Click the Tasks button on the CTorrent tab to display the following page:

	To view a detailed summary:
	1. On the Tasks page, click the icon at the end of the torrent’s row.
	2. Click the Summary tab to view a summary of details:

	To view information about the individual files in the torrent:
	1. On the Tasks page, click the icon at the end of the torrent’s row.
	2. Click the Files tab to view information about the individual files in the torrent. The details include the percentage of the specified file downloaded and the size of each file.

	To view information about the peers sharing torrent files with you:
	1. On the Tasks page, click the icon at the end of the torrent’s row.
	2. Click the Peers tab to view information about the peers who are sharing torrent files with you and the percentage of the torrent they possess.

	To create a task:
	1. On the Tasks tab, click the icon. The following page displays:
	2. Browse your computer to locate the torrent file you saved from a torrent tracker on the Internet.
	3. Click Submit. The task displays at the bottom of the task list.

	To delete a task:
	1. Select the task on the Tasks tab.
	2. Click the icon.
	1. To start a download, select it and click the icon.
	2. To stop a download, select it and click the icon.


	Settings
	To customize CTorrent settings:
	1. Click the Settings button on the CTorrent tab to display the following:
	2. To set the speed of the download or upload, in the General Settings group:
	(a) In Max DL Rate, enter the maximum rate at which the CTorrent should be downloaded (KB/sec).

	3. To automatically stop the download under specified conditions, in the Auto Stop CT Torrent Task group:
	(a) To enable automatic stopping of the download under specified conditions, click the Enable check box.

	4. Click Submit.


	Arrangement
	1. Click Arrangement on the CTorrent tab to display the following:
	2. To change priority for a torrent, click the radio button next to it.
	3. Click Move Up or Move Down to change its position in the list.
	4. Repeat for any other torrents, as desired.
	5. Click Submit to apply the changes.



	Replacing a Drive
	1. Open WD Discovery and select the unit.
	2. Click Configure and log in.
	3. Click the Advanced view and then click the Storage tab.
	4. Click the Disk Management button. The “Unassigned” drive is the defective one. Note the drive number for reference if you need to replace a drive.
	ESD precautions
	To replace an internal drive:
	1. Turn off the system.
	2. Unplug all cables from the power outlets.
	3. Place the enclosure on a flat, stable surface.
	4. Observe ESD precautions when handling a system component.
	5. Remove the system cover.
	(a) Loosen the two captive screws on the rear of the system cover.

	6. Remove the failed drive from the drive bay.
	(a) Pull on the center of the mounting rails handle and move the assembly from side to side to disengage the side latches. Carefully slide the drive out 1 inch from its bay.

	7. Remove the drive carrier.
	(a) Flex the back pin of the side rail from the hard drive and gently pull the side-rail away from the hard drive.

	8. Remove the new hard drive from its packaging.
	9. Install the new drive into the drive carrier.
	(a) Insert the new drive into the drive carrier.

	10. Slide the drive carrier all the way into the drive bay, and then push directly on the drive (not on the mounting rails) until the assembly latches securely into place and you hear a click.
	11. Replace the system cover.
	(a) Carefully place the system cover on the unit so that the tabs on the cover align with the slots on the unit.

	12. Reconnect the cables and power on the unit.
	13. The drive starts the rebuild process automatically. The RAID rebuild may take up to 34 hours depending on RAID mode and drive capacity and activity. See the graphic in “Volumes and RAID Management” on page 133.
	14. Once the rebuild is complete, the power LED will change from flashing green to steady green.
	15. Connect the interface cable and set up the new drive for RAID configuration (for related instructions, refer to “Manage RAID” on page 136).
	16. If the faulty drive is within the warranty period, contact WD Technical Support for instructions on returning the drive.



	Troubleshooting
	First Steps Checklist
	Resetting the WD ShareSpace
	To reset the system using the reset button:
	1. Carefully turn the device around so that you have access to the back of the unit.
	2. Ensure that the device is powered on and that the LAN connection at the back of the device is active (designated by a green light).
	3. Locate a single, small opening in the back of the device just above the power connector. The reset button is inside this opening.
	4. Insert the end of an unfolded paperclip into the opening, and then press and hold the reset button with the paperclip end. (Do not release the button.)
	5. Continue holding the reset button for about seven seconds until the HDD LEDs on the front panel light up. After 14 seconds, the HDD LEDs turn amber.
	6. Release the reset button by removing the paperclip. The device will automatically reboot.

	To reset the system to factory default settings:

	Hardware Diagnostic Testing
	1. Turn off the WD ShareSpace and all external peripheral devices.
	2. Make sure the power cord is plugged into a properly grounded AC outlet.
	3. Turn on the device. If the power indicator on the front panel does not light, see “Power indicator does not light.” on page 184.

	Specific Problems and Corrective Actions
	Power indicator does not light.
	HDD activity indicator does not light.
	System cannot connect to a network and network status indicator does not light.
	Can I use USB auto backup to back up a USB drive with multiple partitions to the device?
	WD ShareSpace’s Network Storage Manager does not appear when I click Configure in WD Discovery.
	I received a banner warning message, email alert, or pop-up screen indicating a failed volume.
	1. Verify hard drive status in the Disk Manager submenu. See “Disk Manager” on page 132. If the status of any drive is “Failed,” visit WD Technical Support at support.wdc.com and search the knowledge base article 2569 for detailed instruction...
	2. If Disk Manager does not indicate that a hard drive has failed, power cycle the device.
	3. If the volume that failed is a new volume, try rebuilding the RAID array. See “Manage RAID” on page 136 for details. If this does not resolve the problem, visit WD Technical Support at support.wdc.com and search the knowledge base article 2569...

	My router has failed or is not available. How do I access my data in the device?
	1. Connect the device directly to the computer's Ethernet port.
	2. Launch WD Discovery Tool and see “Mapping a Network Drive” on page 79 for instructions on how to access data in the device.

	I received the message “iTunes server cannot find the path to Shared Music.”
	How do you map the drive letter without WD Discovery Tool?
	1. Double-click My Computer.
	2. Click My Network Places.
	3. On the Tools menu, point to Map Network Drive.
	4. In the Folder drop-down list, select \\device name\public.
	5. Click the Finish button.You will be prompted to log in to the share.
	6. Go back to the opening window of My Computer to view the public folder of your device under Network Drives.

	I cannot start WD Discovery to access the configure feature.
	1. Click Start>Run.
	2. Type \\WDShareSpace, and then click OK (if the device name was changed, type \\yournewdevicename).
	3. The WD ShareSpace directory appears (Public, Configuration, and Download folders). Double-click the Configuration folder.
	4. Double-click index.htmf The configuration login page appears.
	1. Insert the WD ShareSpace CD.
	2. Click Start>Computer and right-click the WD ShareSpace CD icon.
	3. Click Open>WD_Windows_Tools>WD_Rally_Drivers>PnpxNas-4NC. Right-click PnPxNas-4NC.inf and click Install.

	I am unable to play music, videos, or view pictures through my digital media adapter.

	System Events
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